NOTE

The information in this manual only applies to CIC Pro center software versions 5.1.x or later. It does not apply to earlier software versions. Due to continuing product innovation, specifications in this manual are subject to change without notice.

NOTE

For technical documentation purposes, the abbreviation GE is used for the legal entity name, GE Medical Systems Information Technologies, Inc.

NOTE

The product names CIC Pro, CIC Pro center, CARESCAPE CIC Pro Clinical Information Center, CARESCAPE CIC Pro, CARESCAPE CIC Central Station, CARESCAPE Clinical Information Center Pro, and CARESCAPE Clinical Information Center all refer to the CIC Pro Clinical Information Center product.

Listed below are GE Medical Systems Information Technologies, Inc. trademarks used in this document. All other trademarks contained herein are the property of their respective owners.

APEX, Aware, SOLAR, and MUSE are trademarks of GE Medical Systems Information Technologies, Inc., registered in the United States Patent and Trademark Office.

APEXPRO, CARESCAPE, CD TELEMETRY-LAN, CENTRALSCOPE, CIC PRO, and UNITY NETWORK are trademarks of GE Medical Systems Information Technologies, Inc.
## Contents

1  Introduction ................................................. 1-1

   Equipment information .................................. 1-2
      License agreement .................................... 1-2
      Intended use of the equipment ..................... 1-4
      Safety information ................................ 1-4
      Equipment symbols .................................. 1-10
      Service requirements ............................... 1-12
      Manufacturer responsibility ...................... 1-13
      Equipment identification .......................... 1-13

   Manual information ..................................... 1-14
      Manual purpose ...................................... 1-14
      Intended audience .................................. 1-14
      Related manuals .................................... 1-14
      Conventions used .................................... 1-14
      Ordering manuals .................................... 1-15
      Revision history .................................... 1-15

2  Equipment overview ....................................... 2-1

   Standard components .................................... 2-2
      Display ............................................... 2-3
      Processor box ....................................... 2-3
      Controls ............................................ 2-6
      Power indicator .................................... 2-7

   Optional components .................................... 2-7
      Secondary display ................................... 2-8
      Touchscreen displays .............................. 2-9
      Laser printer ....................................... 2-9
      PRN 50-M digital writer ............................ 2-10
      Un-interruptible power supply (UPS) ............. 2-11

   Theory of operation ..................................... 2-11
      Functional description ............................. 2-11
      Block diagram ...................................... 2-12
      Physiological data ................................ 2-12
      File and data management ......................... 2-13
      Licensing ........................................... 2-14
      Full disclosure ..................................... 2-14

   Networking .................................................. 2-20
      Patient monitoring network ....................... 2-21
      Web access server network ....................... 2-21

   Patient data interface ................................. 2-22
Multi-patient viewer ................................................................. 2-22
Single patient viewer ......................................................... 2-24

Patient data ................................................................. 2-24
Real-time patient data ..................................................... 2-25
Stored patient data ........................................................... 2-25

Service interfaces .......................................................... 2-26

3 Licensing ................................................................. 3-1

CIC Pro center configurations ........................................... 3-2
License requirements ..................................................... 3-2

Available licenses ......................................................... 3-4
Description of licenses .................................................. 3-4
License packages .......................................................... 3-6
Patient Data Server information ....................................... 3-7

License activation methods ............................................. 3-7

4 Service interfaces ....................................................... 4-1

Introduction ................................................................. 4-2

Access methods ........................................................... 4-2
Direct access method ...................................................... 4-2
Network access method .................................................. 4-2

Operating modes .......................................................... 4-3
Overview ................................................................. 4-3
Administrator mode access ............................................. 4-3

Service interface access ................................................ 4-4
Overview ................................................................. 4-4
Setup CIC with service access ......................................... 4-5
Command-line interface access (for advanced users) ............ 4-5
Windows utilities access .................................................. 4-6
Screen-sharing interface access ........................................ 4-6
Webmin interface access ................................................ 4-7

Webmin overview .......................................................... 4-9
Information tab ............................................................ 4-9
Configuration tab .......................................................... 4-10
Diagnostics tab ............................................................ 4-12

5 Installation ............................................................... 5-1

Requirements ............................................................... 5-2
Complete product training .............................................. 5-2
Complete site survey .................................................... 5-2
Service PC .................................................. 5-2

Pre-installation checklist ................................. 5-2
  Format a USB memory stick ............................. 5-3
  Procure necessary licenses ............................. 5-3
  Gather required tools ..................................... 5-4
  Inspect equipment ........................................... 5-4
  Evaluate equipment .......................................... 5-4

Installation process ........................................ 5-8
  Precautions .................................................. 5-8
  Installation process checklist ......................... 5-10
  Mount the equipment ....................................... 5-11
  Connect the cables and peripheral devices ............. 5-12
  Remote view (view only) .................................... 5-15
  Install optional accessories ............................ 5-16
  Plug in the power cable to the CIC Pro center .......... 5-18
  Turn on the power .......................................... 5-19

6 Configuration .............................................. 6-1

Configuration process ...................................... 6-2
  Pre-configuration process ................................. 6-2
    Pre-configuration requirements ....................... 6-2
    Pre-configuration instructions ....................... 6-2

Configuration process checklist .......................... 6-7
  Disconnect CARESCAPE Network IX and MC networks ... 6-7
  Install licenses ............................................. 6-7
  Configure Webmin-related settings ..................... 6-7
  Configure desktop-related settings ..................... 6-8
  Configure clinical application settings ............... 6-8

Reconnect the CIC Pro center with the network ........... 6-9

Perform MultiKM (Multimouse) setup ..................... 6-9

Disconnect from the CARESCAPE Network IX and MC networks ... 6-9

Configure Webmin-related settings ....................... 6-10
  Activate software licenses .............................. 6-10
  Set the network IP address ............................. 6-12
  Configure clinician review workstation ................. 6-14
  Configure network laser printers ....................... 6-14
  Configure the server for remote connectivity ......... 6-16
  Set up a Citrix client ..................................... 6-19
  Configure browser favorites ............................ 6-21
  Configure set flags settings ............................. 6-23
  Configure the CIC Pro center language ................ 6-28

Configure desktop-related settings ..................... 6-29
  Configure USB laser printers ............................ 6-29
  Set the laser printer default paper size ............... 6-30
  Configure a secondary display ........................... 6-31
Calibrate a touchscreen display .................................................. 6-33
Set the time zone ..................................................................... 6-35
Restart CIC Pro center ............................................................... 6-37

Configure clinical application settings ................................. 6-37
  Configure the printer settings .................................................. 6-37
  Configure clinical application, telemetry, and care unit settings 6-37
  Set the Telemetry Unit Defaults .............................................. 6-44
  Set the Telemetry Alarm Control Defaults ............................. 6-46
  Full disclosure license management setup .............................. 6-47
  Set the Display Configuration (non-mirror CIC Pro centers) ... 6-49
  Set the Current Telemetry Listings ......................................... 6-51
  Set up locked beds ............................................................... 6-54
  (Chinese only) Set the pressures unit-of-measure ................. 6-54
  Screen calibration ............................................................... 6-56
  Browser configuration ........................................................... 6-58

Configure customized groupings ......................................... 6-62
  Set up custom groupings for graphic trends ......................... 6-62
  Set up custom groupings for vital signs .............................. 6-65

Configure shortcuts to favorite CIC Pro center views .......... 6-66

Configure the print location settings for stored patient data ... 6-68
  Overview ........................................................................... 6-68
  Configure the print location settings for the patient data categories 6-68

Set the time-of-day or the date .............................................. 6-69

Back up and restore the CIC Pro center configuration ............ 6-72
  Back up care unit default configuration settings .................. 6-72
  Planning your care unit defaults restore strategy ................. 6-73
  Backing up and restoring local custom default configuration settings 6-76

Reconnect the CIC Pro center with the network .................... 6-78

Perform MultiKM (Multimouse) setup ................................. 6-78
  Pre-configure the CIC Pro centers ....................................... 6-79
  Configure the keyboard and mouse group ......................... 6-81
  Change a keyboard and mouse group ............................... 6-84

Complete configuration checkout procedures ...................... 6-89

Check the unit defaults ............................................................. 7-3
  Check status of installed printers ....................................... 7-3
  View system information ..................................................... 7-3

7  Checkout procedures ............................................................ 7-1
Check operation of the secondary display ........................................ 7-4
Check mirror configuration .......................................................... 7-4
Check the status of installed licenses .............................................. 7-4
Verify settings with Check Centrals command ................................. 7-5
Check and configure the speaker volume ..................................... 7-5
Check operation of audible alarm tones ........................................ 7-6
Check access to all other care units ............................................ 7-6
Check the operation of the Citrix application viewed at the CIC Pro center 7-7
Check the hospital intranet browser functionality ............................ 7-7
Check the status of locked beds .................................................. 7-7
Check the language settings .......................................................... 7-7
Check the pressures unit-of-measure .......................................... 7-7
Check the custom groupings for patient data ................................ 7-7
Check the shortcuts to favorite CIC Pro center views ....................... 7-7
Check MultiKM (Multimouse) operation ...................................... 7-8
Check current system settings .................................................... 7-8
Check full disclosure license type for all admitted in-unit beds .......... 7-9
Check full disclosure report printing ........................................... 7-9
Save backup defaults file on the USB memory stick ................. 7-9

FRU checkout procedures ................................................................. 7-10
Check read and write integrity of hard drive and solid state flash drive . 7-10
Check USB devices ........................................................................ 7-11
Check internal hardware temperature and voltage status ................ 7-12
Check COMM ports ....................................................................... 7-13
Check BIOS information ............................................................... 7-13
Check drive operation information (Flash drive and hard drive) ...... 7-14
Check audio component operation .............................................. 7-16
Check speaker status .................................................................... 7-17
Check operation of the Watchdog countdown function ................. 7-18
Check processor fan status ............................................................ 7-19
Check video function and status of video card and drivers .......... 7-19
Check integrity of system files ..................................................... 7-20
Check asset information ............................................................... 7-20

8 Troubleshooting ........................................................... 8-1

Overview .............................................................................. 8-2

Required tools ........................................................................ 8-2

Tips ....................................................................................... 8-2

Error messages ........................................................................ 8-2

Display issues .......................................................................... 8-8
Blank screen ............................................................................. 8-8
Blue screen ............................................................................... 8-8
Red screen ............................................................................... 8-9
Incorrect colors .......................................................................... 8-9

Browser connectivity issues ..................................................... 8-9
Printer issues ...................................................... 8-9
  Laser printer .............................................. 8-9
  Digital display writer ................................. 8-10

MultiKM issues .................................................. 8-10
  License activation failures .......................... 8-10

CIC Pro center setup issues ................................. 8-11
  Unable to communicate with a device ............ 8-11
  List full disclosure beds ......................... 8-12
  Set full disclosure mode .......................... 8-13
  Ping full disclosure server ....................... 8-14
  Display current system settings ................. 8-14
  Enable alarms .......................................... 8-15
  Admit Request Info button ....................... 8-15
  Display waveform indicators ..................... 8-15
  Require age selection for admit ................. 8-16
  Licensing issues ....................................... 8-16
  Time zone, daylight saving time setting, and network time issues .... 8-19
  PDF file access from MUSE ....................... 8-19

Environment Monitor messages ......................... 8-19

Log files .......................................................... 8-20
  Download log files .................................. 8-20
  Access current log files ......................... 8-21
  Application logs ...................................... 8-23
  Operating system event logs .................... 8-24
  Operating system Dr. Watson log ................ 8-25
  Webmin action log ..................................... 8-25

Access additional runtime diagnostic information .... 8-26
  Device driver information ....................... 8-26
  Network information ................................. 8-26
  Operating system runtime statistics ............ 8-27
  Operating system service process information .. 8-28
  Process information .................................. 8-28
  Time zone information .............................. 8-29

SMART drive status ............................................ 8-29

Perform safe restart of the CIC Pro center .......... 8-30

Perform safe shutdown of the CIC Pro center ......... 8-31

Change the logon password for Webmin ............... 8-32

Field replaceable units (FRUs) ......................... 9-1

Exploded views ................................................. 9-2
  Desktop .................................................. 9-2
  Rack-mount ............................................. 9-4
Interconnect diagram .................................................. 9-6
FRUs ............................................................................. 9-6
Disaster recovery software kit and Service Tools CD ................. 9-6
Accessories .................................................................... 9-6
Power cables ................................................................... 9-7
Keyboard kits .................................................................. 9-8
Replacement procedures .................................................. 9-8
  Desktop assembly ......................................................... 9-9
  Rack-mount assembly .................................................. 9-10
  Common replacement procedures ................................. 9-11
  Replacing the CPU PCB (mother board) ......................... 9-14
  Replacing the CPU battery ......................................... 9-15
  Replacing the hard drive ............................................. 9-17
  Replacing the flash drive ............................................ 9-18
  Replacing the SATA drive cables ................................. 9-19
  Replacing the power supply ...................................... 9-20
  Replacing the fan ....................................................... 9-21
  Replacing the dual speakers ...................................... 9-22
  Replacing the fuse ...................................................... 9-22
  Replacing the front bezel .......................................... 9-23
  Re-assemble the cover ............................................... 9-24

10 Preventive maintenance ............................................... 10-1

  Maintenance schedule ................................................ 10-2

  Checklist ..................................................................... 10-2
    Visual inspection ...................................................... 10-3
    Cleaning ..................................................................... 10-3

  Power source tests ..................................................... 10-6
    Power outlet test ...................................................... 10-6
    Power cord and plug test ......................................... 10-6

  Electrical safety tests .................................................. 10-6
    Ground (earth) integrity ........................................... 10-6
    Ground (earth) wire leakage current test ...................... 10-7
    Enclosure leakage current test .................................. 10-8
    Test completion ...................................................... 10-10

  Check the operation of input devices and displays .............. 10-10

  Perform checkout procedures ..................................... 10-10

System resource indicator ............................................... 10-11
  Overview ..................................................................... 10-11
  Resource indicator messages when hovering over icon ....... 10-12
Resource indicator messages when icon is double-clicked ........ 10-12
Resource indicator messages from Environment Monitoring Service .. 10-12
System resource restart procedure ........................................ 10-13

Access log files ............................................................... 10-14

11  Reload software ....................................................... 11-1

Purpose ................................................................. 11-2
Process overview .......................................................... 11-2
Gather required equipment and tools .................................... 11-2
Create a CIC Pro center image restore USB memory stick ........... 11-2
Reload CIC Pro center software ........................................... 11-5

Complete checkout procedures ......................................... 11-7
  Confirm images restored to correct drives .......................... 11-7
  Complete FRU checkout procedures ................................... 11-7
  Check proper operation ................................................. 11-8

Reload process troubleshooting ........................................... 11-8
  Incorrect boot order ................................................... 11-8
  Software image on USB stick does not match hardware ........... 11-8

12  Upgrade software ..................................................... 12-1

Overview ............................................................... 12-2
Establish alternate monitoring methods ............................... 12-3
Gather required equipment and tools ................................... 12-3
Prepare the CIC Pro center ................................................ 12-3
Prepare the service PC ..................................................... 12-4
  Connect the service PC to the CARESCAPE Network IX network .. 12-4
  Start the software transfer utility ..................................... 12-4
  Enter the CARESCAPE Network IX network addresses of CIC Pro centers to be updated ........................................ 12-5

Install the software on the target CIC Pro centers .................. 12-6
Activate the software packages ........................................ 12-8
Complete the checkout procedures .................................... 12-9
A  Electromagnetic compatibility  ......................... A-1
   Electromagnetic compatibility (EMC)  ....................... A-2
   Guidance and manufacturer's declaration  .................. A-2
      Electromagnetic emissions  .......................... A-2
      Electromagnetic immunity  ......................... A-3
   Recommended separation distances  ...................... A-5
   Compliant cables and accessories  ...................... A-6

B  Backup and restore - backed up data modules  .... B-1
   Data module detail  .................................. B-2

C  Device compatibility  ................................. C-1
   CIC Pro center v5.1.x compatibility  .................... C-2
      Central stations  ................................. C-2
      Telemetry devices  ............................... C-2
      Bedside monitors  ............................... C-2
      Other GE systems  ............................... C-3
1 Introduction
Equipment information

License agreement

It is important that you carefully read the terms and conditions of this license agreement before commencing the use of the clinical information center workstation (the “workstation”) and the clinical information center program recorded therein and any accompanying user documentation ("program"). This license represents the entire license agreement concerning the program between you and GE and supersedes all other communications or advertising related to the program except any terms and conditions of sale or warranties or warranty limitations relative to the program and/or the workstation as may be embodied in any documentation supplied with the workstation. By commencing the use of the workstation and the program contained therein, you are accepting and agreeing to be bound by all the terms and conditions of this license agreement. If you are not willing to be bound by the terms and conditions of this license agreement, you should promptly return the workstation to GE and you will receive a refund of the purchase price.

I. Grant

The Program is capable of coupling one to sixteen patient monitoring units to the Workstation. GE hereby grants you a non-exclusive, non-transferable right and license to use the Program for coupling the number of patient monitoring units to the Workstation for which a per-unit royalty has been paid pursuant to Article II hereof.

II. Royalty

You have paid GE a one-time, per-unit royalty equal to GE Medical Systems Information Technologies, Inc.’s current published price for the use of the Program. The per-unit royalty is based on the actual number of patient monitors intended to be coupled by the Program to the Workstation as stated in the Purchase Order for the Workstation and the Program. If you use the Program to couple any patient monitoring units to the Workstation in addition to the number for which a per unit royalty was previously paid, you agree to pay GE an additional per-unit royalty equal to GE Medical Systems Information Technologies, Inc.’s then current published royalty for the Program for each such additional patient monitoring unit so coupled. The additional per-unit royalty shall be paid to GE within 30 days of the use of the Program to couple any such additional patient monitoring units to the Workstation.

III. Limitations

You hereby agree not to: (1) use the Program in any network or system other than to couple patient monitoring units to the Workstation; (2) make any copy of the Program for any reason, or allow or assist others to do so; (3) modify, reverse engineer, decompile or disassemble the Program or merge any part of the Program into any other program; (4) rent, sell, sublease, assign, transfer or otherwise share the Program or any of your rights in the Program under this Agreement with any third party; or, (5) remove or alter any copyright notice, labels or trademarks from the Program or the Workstation.
IV. Title

This License is not a sale. Title and all copyrights to the Program and any copy made by you remains the sole property of GE.

V. Term

This Agreement shall continue in force until terminated. This Agreement shall terminate automatically when you cease using the Workstation and the Program for their intended purpose. GE may terminate this Agreement on 30 days written notice if you make any unauthorized copies of the Program or fail to comply with any of the restrictions on use of the Program as set forth herein.

VI. Limited warranty, disclaimer and limitation of liability

A. Licensor warrants that on the acceptance date the Program shall be free from significant programming errors and shall operate and conform to the published functional specifications applicable thereto, and that the Program shall conform to the standards generally observed in the industry for similar software.

B. This warranty shall be invalidated by your modification of the Program if such modification or the interaction between such modification and the Program as supplied by GE is the cause of the defect, error or non-conformity.

C. Except as stated above, the warranty covering the Program and the Workstation shall be either GE Standard Warranty or Limited Extended Parts Warranty as published by GE and hereby made a part hereof.

D. Except for the express warranties stated herein, GE disclaims all warranties with regard to the program including implied warranties of merchantability or fitness for a particular purpose.

E. GE Medical Systems Information Technologies, Inc.’s entire liability to you arising out of or in connection with this Agreement shall not exceed the per-unit royalty paid to GE for use of the Program. You acknowledge that the amount paid to GE for use of the Program is insufficient for GE to undertake any greater risk. In no event shall GE be liable for any indirect, incidental, consequential, special or exemplary damages (including without limitation, lost profits, business interruption, loss of business information, personal injury or any other pecuniary loss) arising from the use of the program, even if GE has been advised of the possibility of such damages.

VII. Governing law

This Agreement shall be governed by the laws of the State of Wisconsin.

VIII. Partial invalidity

If any provision of this Agreement is held invalid or unenforceable, the remaining portions of the Agreement shall continue in full force and effect.
Introduction

Intended use of the equipment

The CIC Pro Clinical Information Center central station is intended for use under the direct supervision of a licensed healthcare practitioner. The intended use is to provide clinicians with adult, pediatric and neonatal patient data in a centralized location within a hospital or clinical environment.

CIC Pro Clinical Information Center central station is intended to collect information from a network and display this data. This data includes physiological, patient demographic and/or other non-medical information. Physiological parameters and waveforms from monitors and telemetry systems can be displayed and printed from the CIC Pro Clinical Information Center central station. Beat to beat patient information for all parameters and waveforms from the bedside and telemetry systems can be displayed.

The CIC Pro Clinical Information Center central station supports the ability to access information from the CIC Pro Clinical Information Center central stations’ products in a web browser format. Additionally, the CIC Pro Clinical Information Center central station supports the ability to access patient information collected from the unity network and stored on a network server.

Safety information

The terms danger, warning, and caution are used throughout this manual to point out hazards and to designate a degree or level of seriousness. Familiarize yourself with their definitions and significance.

- **Hazard** is defined as a source of potential injury to a person.
- **Danger** indicates an imminent hazard, which, if not avoided, will result in death or serious injury.
- **Warning** indicates a potential hazard or unsafe practice, which, if not avoided, could result in death or serious injury.
- **Caution** indicates a potential hazard or unsafe practice, which, if not avoided, could result in minor personal injury or product/property damage.
- **Note** provides application tips or other useful information to assure that you get the most from your equipment.

Dangers

No danger statements apply to this product.

Warnings

The following warnings apply to this product.
WARNING
ELECTRIC SHOCK— To avoid electric shock, the CIC Pro center and its accessories should not be placed within the patient environment, which is a volume related to an object (bed, chair, table, treadmill, etc.) where a patient is intended to be diagnosed, monitored, or treated.

WARNING
ACCESSORIES (SUPPLIES) — To ensure patient safety, use only parts and accessories recommended by GE.

WARNING
ACCIDENTAL SPILLS — To avoid electric shock or device malfunction, liquids must not be allowed to enter the device. If liquids have entered a device, take it out of service and have it checked by a service technician before it is used again.

WARNING
ACCURACY — If the accuracy of any value displayed on the screen or printed on a graph strip is questionable, first determine the patient's vital signs by alternative means. Then, verify the CIC Pro center and printer are working correctly.

WARNING
ALARMS — Do NOT rely exclusively on the audible alarm system for Bedside Monitoring. Adjustment of CIC Pro center alarm volume to a low level or OFF during Bedside Monitoring may result in inability to hear the alarm and a hazard to the patient. Remember that the most reliable method of Bedside Monitoring combines close personal surveillance with correct operation of monitoring equipment.

After connecting the monitor to the central station and/or nurse-alert, verify the function of the alarm system. Repeat this verification periodically, including a check of all connected speakers.

CIC Pro center audible alarms will not sound for patients with bedside monitoring devices configured to “Operating Room” mode.

The functions of the alarm system for monitoring of the patient must be verified at regular intervals. Check speaker volume periodically to ensure audio alarm functionality.
WARNING
BEFORE USE — Before putting the system into operation, visually inspect all connecting cables for signs of damage. Damaged cables and connectors must be replaced immediately.

Before using the system, the operator must verify that it is in correct working order and operating condition.

Periodically, and whenever the integrity of the product is in doubt, test all functions.

WARNING
DISCONNECTION FROM MAINS — When disconnecting the system from the power line, remove the plug from the wall outlet first. Then you may disconnect the power cord from the device. If you do not observe this sequence, there is a risk of coming into contact with line voltage by inserting metal objects, such as the pins of leadwires, into the sockets of the power cord by mistake.

WARNING
DISPOSAL — Dispose of the packaging material, observing the applicable waste control regulations and keeping it out of children’s reach.

WARNING
EXPLOSION HAZARD — Do not use this equipment in the presence of flammable anesthetics, vapors or liquids.

WARNING
INTERFACING OTHER EQUIPMENT — Devices may only be interconnected with each other or to parts of the system when it has been determined by qualified biomedical engineering personnel that there is no danger to the patient, the operator, or the environment as a result. The devices must comply with relevant IEC and ISO safety standards.

Safe and proper operation should be verified with the applicable manufacturer’s instructions for use.
**WARNING**

NETWORK INTEGRITY — The CIC Pro center should not be installed directly on the Hospital Enterprise network. Ensure that the CARESCAPE Network IX and CARESCAPE Network MC are isolated either physically, or on non-routable VLANs or via router.

If the CIC Pro center is configured to reside on the hospital’s enterprise network, it is possible that inadvertent or malicious network activity could adversely affect patient monitoring. The integrity of the computer network is the responsibility of the hospital.

---

**Cautions**

The following cautions apply to this product.

**CAUTION**

EMC — Magnetic and electrical fields are capable of interfering with the proper performance of the device. For this reason make sure that all external devices operated in the vicinity of the monitor comply with the relevant EMC requirements. X-ray equipment or MRI devices are a possible source of interference as they may emit higher levels of electromagnetic radiation.

---
Introduction

CAUTION

EMC — Magnetic and electrical fields are capable of interfering with the proper performance of the device. For this reason make sure that all external devices operated in the vicinity of the monitor comply with the relevant EMC requirements. X-ray equipment or MRI devices are a possible source of interference as they may emit higher levels of electromagnetic radiation.

Changes or modifications to this device/system not expressly approved by GE may cause EMC issues with this or other equipment. This device/system is designed and tested to comply with applicable standards and regulations regarding EMC and needs to be installed and put into service according to the EMC information stated as follows:

Use of known RF sources, such as cell/portable phones, or other radio frequency (RF) emitting equipment near the system may cause unexpected or adverse operation of this device/system. Consult qualified personnel regarding device/system configuration.

The device/system should not be used adjacent to, or stacked with, other equipment. If adjacent or stacked use is necessary, the device/system should be tested to verify normal operation in the configuration in which it is being used. Consult qualified personnel regarding device/system configuration.

The use of accessories, transducers and cables other than those specified may result in increased emissions or decreased immunity performance of the device/system.

This device/system is suitable for use in all establishments other than domestic and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes. Mains power should be that of a typical commercial or hospital environment.

Refer to the electromagnetic compatibility and guidelines in the service manual for additional compliance and safety information.

CAUTION

NEGLIGENCE — GE does not assume responsibility for damage to the equipment caused by improperly vented cabinets, improper or faulty power, or insufficient wall strength to support equipment mounted on such walls.
CAUTION
POWER REQUIREMENTS — Before connecting the device to the power line, check that the voltage and frequency ratings of the power line are the same as those indicated on the unit’s label. If this is not the case, do not connect the system to the power line until you adjust the unit to match the power source.

In the USA, if the installation of the equipment will use 240V rather than 120V, the source must be a center-tapped, single-phase circuit.

This equipment is suitable for connection to public mains as defined in CISPR11/EN55011.

CAUTION
RESTRICTED SALE — U.S. federal law restricts this device to be sold by or on the order of a physician.

CAUTION
SECURITY — The web browser which runs in conjunction with the CIC Pro center is intended for hospital intranet use only. If confidential patient information is made available from the hospital intranet, the security of the data is the responsibility of the hospital.

CAUTION
SUPERVISED USE — This equipment is intended for use under the direct supervision of a licensed health care practitioner.

CAUTION
During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

Notes

The following notes apply to this product.

NOTE

This device is not intended for home use.

NOTE

Parts and accessories used must meet all local building and safety requirements.
### NOTE

Patient environment is any volume in which intentional or unintentional contact can occur between the patient and parts of the system or between the patient and other persons touching parts of the system (IEC 60601-1-1).

### Equipment symbols

#### NOTE

Some symbols may not appear on all equipment.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>ATTENTION: Consult accompanying documents.</td>
</tr>
</tbody>
</table>
| ![Icon](image2) | TYPE B APPLIED PART: Non-isolated applied part suitable for intentional external and internal application to the patient excluding direct cardiac application.  
[Medical Standard Definition:] Applied part complying with the specified requirements of IEC 60601-1 Medical Standards to provide protection against electric shock, particularly regarding allowable leakage current. |
| ![Icon](image3) | TYPE BF APPLIED PART: Isolated (floating) applied part suitable for intentional external and internal application to the patient excluding direct cardiac application. "Paddles" outside the box indicate the applied part is defibrillator proof.  
[Medical Standard Definition:] F-type applied part (floating/isolated) complying with the specified requirements of IEC 60601-1 Medical Standards to provide a higher degree of protection against electric shock than that provided by type B applied parts.  
NOTE  
The rating of protection against electric shock (indicated by symbol for CF or BF) is achieved only when used with patient applied parts recommended by GE. |
| ![Icon](image4) | TYPE CF APPLIED PART: Isolated (floating) applied part suitable for intentional external and internal application to the patient including direct cardiac application. "Paddles" outside the box indicate the applied part is defibrillator proof.  
[Medical Standard Definition:] F-type applied part (floating/isolated) complying with the specified requirements of IEC 60601-1 Medical Standards to provide a higher degree of protection against electric shock than that provided by type BF applied parts. |
<p>| <img src="image5" alt="Icon" /> | Writer door button. |
| <img src="image6" alt="Icon" /> | Silence Alarm keyboard key. |
| <img src="image7" alt="Icon" /> | CE mark. |</p>
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /></td>
<td>This symbol indicates the date of manufacture of this device. The first four digits identify the year and the last two digits identify the month.</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol" /></td>
<td>Fuse. Replace the fuse with a fuse of the same type and rating.</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /></td>
<td>Power On and Off.</td>
</tr>
<tr>
<td><img src="image4" alt="Symbol" /></td>
<td>Medical Equipment. With Respect to Electric Shock, Fire and Mechanical Hazards Only, In Accordance with UL 60601-1, CAN/CSA C22.2 NO.601.1, and IEC 60601-1.</td>
</tr>
<tr>
<td><img src="image5" alt="Symbol" /></td>
<td>For Russia only: Russian GOST-R certification.</td>
</tr>
<tr>
<td><img src="image6" alt="Symbol" /></td>
<td>USB connector port.</td>
</tr>
<tr>
<td><img src="image7" alt="Symbol" /></td>
<td>Ethernet connector port used to connect to the CARESCAPE Network (MC or IX network) as indicated on the device.</td>
</tr>
<tr>
<td><img src="image8" alt="Symbol" /></td>
<td>Serial connector ports 1 and 2.</td>
</tr>
<tr>
<td><img src="image9" alt="Symbol" /></td>
<td>Digital Visual Interface - Integrated for primary video connection that supports digital and analog displays.</td>
</tr>
<tr>
<td><img src="image10" alt="Symbol" /></td>
<td>Digital Visual Interface - Digital for secondary video connection that supports digital displays only.</td>
</tr>
<tr>
<td><img src="image11" alt="Symbol" /></td>
<td>Speaker out connector port.</td>
</tr>
<tr>
<td><img src="image12" alt="Symbol" /></td>
<td>Power indicator.</td>
</tr>
</tbody>
</table>
## Introduction

Follow the service requirements listed below, and in the Preventive maintenance chapter of this manual.

- Refer equipment servicing to GE authorized service personnel only.
- Any unauthorized attempt to repair equipment under warranty voids that warranty.
- It is the user’s responsibility to report the need for service to GE or to one of their authorized agents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![No Symbol]</td>
<td>This symbol indicates that the waste of electrical and electronic equipment must not be disposed as unsorted municipal waste and must be collected separately. Please contact the manufacturer or other authorized disposal company to decommission your equipment.</td>
</tr>
<tr>
<td>![EC REP]</td>
<td>European authorized representative.</td>
</tr>
<tr>
<td>![Manufacturer Name and Address]</td>
<td>Manufacturer name and address.</td>
</tr>
<tr>
<td>![Equipotential Stud]</td>
<td>Equipotential stud. A ground wire from another device can be tied here to ensure the devices share a common reference point.</td>
</tr>
</tbody>
</table>

### NOTE

The following symbols (required by China law only) are representative of what you may see on your equipment.

The number in the symbol indicates the EFUP period in years, as explained below. Check the symbol on your equipment for its EFUP period.

This symbol indicates the product contains hazardous materials in excess of the limits established by the Chinese standard SJ/T11363-2006 Requirements for Concentration Limits for Certain Hazardous Substances in Electronic Information Products. The number in the symbol is the Environment-friendly User Period (EFUP), which indicates the period during which the toxic or hazardous substances or elements contained in electronic information products will not leak or mutate under normal operating conditions so that the use of such electronic information products will not result in any severe environmental pollution, any bodily injury or damage to any assets. The unit of the period is “Year”.

In order to maintain the declared EFUP, the product shall be operated normally according to the instructions and environmental conditions as defined in the product manual, and periodic maintenance schedules specified in Product Maintenance Procedures shall be followed strictly.

Consumables or certain parts may have their own label with an EFUP value less than the product. Periodic replacement of those consumables or parts to maintain the declared EFUP shall be done in accordance with the Product Maintenance Procedures. This product must not be disposed of as unsorted municipal waste, and must be collected separately and handled properly after decommissioning.

This symbol indicates that this electronic information product does not contain any toxic or hazardous substance or elements above the maximum concentration value established by the Chinese standard SJ/T11363-2006, and can be recycled after being discarded, and should not be casually discarded.

### Service requirements
Failure on the part of the responsible individual, hospital, or institution using this equipment to implement a satisfactory maintenance schedule may cause undue equipment failure and possible health hazards.

Regular maintenance, irrespective of usage, is essential to ensure that the equipment is always functional when required.

Manufacturer responsibility

GE is responsible for the effects of safety, reliability, and performance only if:

- Assembly operations, extensions, readjustments, modifications, or repairs are carried out by persons authorized by GE;
- The electrical installation of the relevant room complies with the requirements of the appropriate regulations.
- The equipment is used in accordance with the instructions for use.

Equipment identification

Every GE device has a unique serial number for identification. A sample of the information found on a serial number label is shown below.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Product code(^1)</td>
<td>2</td>
<td>Year manufactured</td>
<td>3</td>
<td>Fiscal week manufactured</td>
</tr>
<tr>
<td>4</td>
<td>Production sequence number</td>
<td>5</td>
<td>Manufacturing site</td>
<td>6</td>
<td>Miscellaneous characteristic</td>
</tr>
</tbody>
</table>

\(^1\)The product code is:

SDY for the MP100D (desktop model) platform
SDZ for the MP100R (rack-mounted model) platform
Manual information

Manual purpose

This manual supplies technical information for service representatives and technical personnel so they can maintain the equipment to the assembly level. Use it as a guide for maintenance and electrical repairs considered field repairable. Where necessary, the manual identifies additional sources of relevant information and technical assistance.

Intended audience

This manual is intended for use by service representatives and technical personnel who maintain, troubleshoot, or repair the equipment.

Related manuals

- Critical Care Monitoring Clinical Reference and Troubleshooting Guide
- CIC Pro™ Clinical Information Center Operator’s Manual
- CIC Pro™ Clinical Information Center Technical Specifications Supplement
  MP100 Series

Conventions used

Equipment terms

This manual uses the following terms to simplify common equipment names.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC network</td>
<td>Refers to the CARESCAPE Network MC network.</td>
</tr>
<tr>
<td>IX network</td>
<td>Refers to the CARESCAPE Network IX network.</td>
</tr>
<tr>
<td>CIC Pro center</td>
<td>Refers to the CIC Pro Clinical Information Center.</td>
</tr>
<tr>
<td>CIC Pro</td>
<td>Refers to the CIC Pro Clinical Information Center.</td>
</tr>
<tr>
<td>Flash drive</td>
<td>Solid-state drive.</td>
</tr>
<tr>
<td>Telemetry Server</td>
<td>Refers to the ApexPro Telemetry Server/Tower.</td>
</tr>
<tr>
<td>Transmitter/transceiver</td>
<td>Refers to an Apex, ApexPro or ApexPro CH transmitter or ApexPro FH transceiver.</td>
</tr>
<tr>
<td>USB memory stick</td>
<td>A memory data storage device which is used to create an image to restore the CIC Pro center software and to activate CIC Pro center licenses.</td>
</tr>
<tr>
<td>Writer</td>
<td>Refers to the PRN 50-M digital writer.</td>
</tr>
</tbody>
</table>
Text styles

This manual uses the following text styles to identify hardware terms, software terms and the correct way to enter data.

<table>
<thead>
<tr>
<th>Style</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Indicates hardware items, such as keys, labels or connectors.</td>
</tr>
<tr>
<td><strong>Bold and italicized</strong></td>
<td>Indicates software items, such as menus, menu options or screen text.</td>
</tr>
<tr>
<td><em>Italics</em></td>
<td>Emphasizes a word.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Indicates menu options or control settings to select consecutively.</td>
</tr>
<tr>
<td>+</td>
<td>Indicates keyboard keys to select simultaneously.</td>
</tr>
</tbody>
</table>

Illustrations and names

In this manual, all illustrations are provided as examples only. They may not necessarily reflect your monitoring setup or data viewed on your monitoring device.

All names appearing in examples and illustrations are fictitious. The use of any real person’s name is purely coincidental.

Ordering manuals

A paper copy of this manual will be provided upon request. Contact your local GE representative and request the part number on the first page of the manual.

Revision history

Each page of this document has the document part number and revision letter at the bottom of the page. The revision letter changes whenever the document is updated.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Initial release of document.</td>
</tr>
<tr>
<td>B</td>
<td>Updated the procedure to check and configure speaker volume.</td>
</tr>
</tbody>
</table>
2 Equipment overview
Standard components

NOTE

The Unity Network has been renamed to the CARESCAPE Network. Not all references to the Unity Network will be changed immediately; Unity may appear in some places and CARESCAPE in others. It is important to understand that while the CARESCAPE Network replaces the Unity Network name, they refer to the same GE monitoring network.

Standard components include the following items:

- Processor box
- Primary display
- External speakers
- Standard keyboard and mouse

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Processor box</td>
<td>Run the CIC Pro center application.</td>
</tr>
<tr>
<td>2 Primary display</td>
<td>Display real-time and stored patient data, control windows, and various system level operations. Can display 16 patients simultaneously.</td>
</tr>
<tr>
<td>3 Standard mouse and keyboard</td>
<td>Enter data, navigate menus, and choose options.</td>
</tr>
<tr>
<td>4 External speakers</td>
<td>Sound audible patient status and system status alarm tones.</td>
</tr>
</tbody>
</table>
Display

You can configure the CIC Pro center to display real-time parameter waveforms and numeric data for one to 16 patients. See Set the Display Configuration (non-mirror CIC Pro centers) on page 6-49.

You can also view stored parameter waveforms and numeric data, control windows, and various system level operations.

Processor box

The processor box runs the CIC Pro center application. It can be ordered as a desktop server (MP100D) or as a rack-mounted server (MP100R) and has the following connectors, ports, and switches. For information on USB extender limitations, see Restrictions on page 5-11.

Desktop views
Equipment overview

Rack-mount views

Side view

Front view

Back view
## Connectors, ports and switches

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Equipotential stud</td>
<td>Connect a ground wire from another device to ensure the devices share a common reference point.</td>
</tr>
<tr>
<td>2 Ventilation opening</td>
<td>Vent internal processor heat to the outside of the processor box.</td>
</tr>
<tr>
<td>3 RX S/5</td>
<td>Do not use this port or connect to any device. This port is physically disabled by a dummy plug.</td>
</tr>
</tbody>
</table>
| 4 CARESCAPE Network MC network connection | - Interface with other networked GE patient monitoring and telemetry system devices.  
- Display waveform, parameter, and alarm condition data from other networked devices. |
| 5 CARESCAPE Network IX network connection | - Provide ability to display full disclosure data.  
- Access remote serviceability.  
- Connect to an optional network laser printer.  
- Connect to an optional Citrix server.  
- Connect to an optional web browser. |
| 6 RS232 2 connector | Connect to the PRN 50-M digital writer. |
| 7 RS232 1 connector | Connect to the serial touchscreen display. |
| 8 DVI-I 1 video connector | Connect to the primary display. |
| 9 DVI-D 2 video connector | Connect to an optional secondary display. |
| 10 USB ports | There are six USB ports you can use to connect the following devices:  
- Standard mouse.  
- Standard keyboard.  
- Touchscreen display.  
- USB memory stick (used to activate CIC Pro center licenses and other servicing functions).  
- USB printers. |
| 11 External speaker connector | Connect to external speakers to hear patient and system status alarm notification. |
| 12 Power switch | Press to turn on or to turn off. |
| 13 Power connector | Connect the power cable. |
| 14 Power indicator | Illuminates when powered on. |
| 15 Speaker opening | Permits internal speaker to sound externally. |
| 16 IP address labels | Identifies the IP address of this device on the respective networks.  
**NOTE**  
The CIC application does not use the S/5 network, |
| 17 Serial number label | Identifies the serial number of the device. |
| 18 Power clamp | Provided to clamp the power cord and speaker. |
Controls

Mouse

Use a standard mouse to select menu options or patient data.

**Mouse pointer shapes**

Depending on the operation mode of the CIC Pro center, the mouse pointer changes its appearance.

<table>
<thead>
<tr>
<th>Pointer</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Arrow" /></td>
<td>Arrow: Indicates the CIC Pro center is operating in user mode. Use the arrow pointer to select menu options, patient data, and to navigate from window to window.</td>
</tr>
<tr>
<td><img src="image" alt="I-beam" /></td>
<td>I-beam: Indicates the pointer is in a data entry field. Enter text when this pointer is displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Cross" /></td>
<td>Cross: Indicates the CIC Pro center is operating in Service mode.</td>
</tr>
</tbody>
</table>

**WARNING**

QUALIFIED PERSONNEL — The Service mode is intended for use only by qualified personnel with training and experience in its use. The consequences of misuse include loss of alarm configuration, loss of patient data, creation of an unmonitored bed scenario, corruption of the CIC Pro center operating system software, or disruption of the CARESCAPE Network.

**Using the MultiKM application**

If the *MultiKM* license is activated, you may use one keyboard and one mouse across multiple CIC Pro centers that are centralized and configured in the same keyboard and mouse group. When the *MultiKM* icon appears in the lower right corner of the display screen, the *MultiKM* license is activated on this CIC Pro center.

With the *MultiKM* license activated, you can do the following tasks:

- Move the mouse across all CIC Pro centers in the group.
- Access any CIC Pro center’s display screen or enter text into any of the CIC Pro center’s text fields in the group.
- Support right and left mouse clicks and scroll wheel movement.

For more information, see Perform MultiKM (Multimouse) setup on page 6-78.
Keyboard

Use a standard keyboard to type text into a data entry field.

NOTE

When using the MultiKM software application, you may use one keyboard and one mouse across multiple centralized CIC Pro centers.

Typing text into a data entry field

To type text into a data entry field, position the mouse pointer over the data entry field. When the mouse pointer changes to an I-beam, click the left mouse button and begin typing.

Silence Alarms keyboard key

NOTE

If the MultiKM license is activated, you must position the mouse cursor in the patient window of the CIC Pro center where the alarm condition is occurring. Then press the Silence Alarms keyboard key to silence all alarms on this CIC Pro center for one minute.

Press the Silence Alarms key, to silence all alarms for one minute. Alarms that are in queue to sound are also silenced. Any new patient alarm condition cancels the alarm silence, breaking through to sound the new alarm.

Power indicator

The power indicator is located on the front left side of the CIC Pro center processor box. The power indicator illuminates green when the power is turned on.

Optional components

Optional components include the following items:

- Secondary display on page 2-8
- Touchscreen displays on page 2-9
- Laser printer on page 2-9
- PRN 50-M digital writer on page 2-10
- Un-interruptible power supply (UPS) on page 2-11
The secondary display supports patient data review functions and can be configured to display CIC Pro center applications in full screen or half screen formats. Using a secondary display provides more room for real-time patient monitoring in the primary display.

From a secondary display, you can do the following:

- View all of the single patient viewer applications.
- View two single applications at the top and bottom half of the screen.
- View all applications (excluding multi-patient viewer) in this secondary display.
- View web and Citrix (if enabled) applications.
- Navigate between applications via the enhanced software tools provided.
- Access custom views of routine applications using a single mouse click.

The following requirements apply when using a secondary display with your CIC Pro center:

- Secondary displays must be the same type and the same size as the primary display. For a list of displays that are validated for use with the v5.1.x CIC Pro center, refer to Touchscreen display video drivers on page 6-33.
- Secondary displays and primary displays must be set to the same 1280 x 1024 display resolution. No other display resolutions have been validated for use with the v5.1.x CIC Pro center.
- Secondary displays will not function until you have first completed the following tasks:
  - Activated the required licenses.
  - Restarted the CIC Pro center.

To configure the secondary display, see Configure a secondary display on page 6-31.
Touchscreen displays

The touchscreen display allows you to select any selectable screen object by gently tapping the object with your finger.

The following guidelines apply when using a touchscreen display:

- Applying tape or other items to the screen impairs the touchscreen’s functionality.
- Using pencils, pens, or other sharp, pointed objects can damage the touchscreen.
- Displaying right click menus is not supported by the touchscreen.
- Primary and secondary displays can be a combination of touchscreen and non-touchscreen displays.

Laser printer

**WARNING**

SHOCK HAZARD — Laser printers are UL 60950/IEC 60950 certified equipment, which may not meet the leakage current requirements of patient care equipment. This equipment must not be located in the patient environment unless the medical system standard IEC 60601-1-1 is followed.

Do not connect a laser printer to a multiple portable socket outlet (MPSO) supplying patient care equipment. The use of an MPSO for a system will result in an enclosure leakage current equal to the sum of all the individual earth leakage currents of the system if there is an interruption of the MPSO protective earth conductor.

The supported printers include:

- HP LaserJet 2430 (USB and Network)
- HP LaserJet P3005 (USB and Network)
- HP LaserJet P3015 (USB and Network)
- HP LaserJet 4000 (Network only)
- HP LaserJet 4050 (Network only)
- HP LaserJet 4100 (Network only)
- HP LaserJet 4200 (Network only)
- HP LaserJet 4250 (Network only)

A laser printer can be configured to print alarm graphs, control settings, waveforms, parameter numeric data, events, full disclosure, and graphic trend data.

**NOTE**

Consult your sales representative or Technical Support for the latest supported printers.
PRN 50-M digital writer

A PRN 50-M digital writer can be connected to the CIC Pro center to print alarm graphs, control settings, waveforms, events, and trend data. The writer prints reports and graphs on 2-inch wide paper.

The following controls, indicators, and connectors are located on the front and back of the digital writer.

PRN 50-M digital writer: Front and back views

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Writer door button</td>
<td>Press to open the door and replace the writer paper.</td>
</tr>
<tr>
<td>2 Graph stop button</td>
<td>Press to stop printing a graph. Holding the button will generate a self-test print.</td>
</tr>
<tr>
<td>3 Paper out indicator</td>
<td>Illuminates when you need to replace the paper. See Change writer paper on page 5-17.</td>
</tr>
<tr>
<td>4 Power indicator</td>
<td>Illuminates when the writer is connected to a power source.</td>
</tr>
<tr>
<td>5 Power switch</td>
<td>Press to turn on or turn off the writer.</td>
</tr>
<tr>
<td>6 Power connector</td>
<td>Connect the writer’s power cable.</td>
</tr>
<tr>
<td>7 Power cable clamp</td>
<td>Connect to the writer’s power cable. This prevents the cable from being pulled out of the power connector.</td>
</tr>
<tr>
<td>8 M-port connector</td>
<td>Connect to the CIC Pro center.</td>
</tr>
<tr>
<td>9 ASYNC COMM port</td>
<td>Not used. This port may not be present on some models.</td>
</tr>
</tbody>
</table>
Un-interruptible power supply (UPS)

**WARNING**

LOSS OF MONITORING — If power to the CIC Pro center is lost, patient monitoring information will no longer be displayed or stored.

GE recommends using an un-interruptible power supply with the CIC Pro center.

Without a UPS, power line outages may result in:

- Improper shutdown of the CIC Pro center, causing lengthy disk scan procedures on reboot.
- Data loss.
- Failure of the CIC Pro center and other hardware components.

Theory of operation

Functional description

The CIC Pro center application is designed to provide real-time patient data and alarms for central nurse stations in hospitals. It can display real-time waveforms and vital sign data, with visual and audible alarms, for up to 16 patients simultaneously. The CIC Pro center supports both wired and wireless monitors and telemetry data.

The CIC Pro center software allows users to select any bed on the CARESCAPE Network MC network and display an expanded view of that bed’s real-time parameters and waveforms. This expanded view also allows users to view and modify settings within the care unit, and view a patient’s other data (including alarm histories, graphic trends and tabular trends).

The user can configure the number of patients displayed by the system, and the number of displayed waveforms per patient. Waveform colors are also configurable.

All configuration data is stored, and is restored after a system power cycle or software restart.
Physiological data

CIC Pro centers trend two types of physiological data: periodic and episodic.

Periodic data

Periodic data is constantly updated. Data is sampled every two seconds to yield 30 samples per minute. The displayed value is the median of the 30 samples. It is always the median of a one-minute time frame, regardless of the interval selected.

The interval is the time between values, not the time of the value itself. For example, a five-minute interval means one-minute samples spaced five minutes apart, not five-minute samples, and not a median of the five one-minute samples. Odd number values are rounded down to the nearest even number.

If the calibration of the system clock changes (for example, daylight saving time), the time for periodic data slides into the revised time. However, episodic data is time-stamped and retains its original time.

Examples of periodic data include heart rate and invasive blood pressure.

Episodic data

Episodic data is parameter data that is user, or system, generated. An example of episodic data is non-invasive blood pressure.
File and data management

Log files

Log files generated by the CIC Pro center application, other associated applications, and the CIC Pro center operating system are used during system analysis, problem diagnosis, and troubleshooting. See Access log files on page 10-14 for more information.

RWHAT packets

All monitoring devices on the CARESCAPE Network periodically broadcast information about themselves in “RWHAT” packets. Among other things, RWHAT packets contain IP address, port number, name, and offered services information about each device.

All monitoring devices listen for RWHAT packets, and maintain a database of information about other devices on the network. When devices need to communicate, the appropriate IP address information is obtained from the database, CARESCAPE Network-protocol messages are created, and operating system services are used to transmit the message on the network.

For example, when a CIC Pro center computer communicates with a telemetry device, the telemetry device’s IP address is retrieved from the CIC Pro center computer RWHAT database, the CARESCAPE Network messages are created, and the CIC Pro center Windows operating system sends the messages to the telemetry device.

Storage

- The Full Disclosure (FD) Data interface uses the CARESCAPE Network IX network to retrieve data from the database.
- Each bed is stored in a separate directory, containing one index file and many record files.

Printing

- The FD Page printout is a configurable, time-period (license dependent) overview of waveform activity. It is activated by clicking the print button located in the top right corner of the FD Page window.
- The FD Strip printout is a quick snapshot of what is currently on the screen. It is activated by clicking the print button while the FD Page is being viewed.
- There is a separate full disclosure printer selection from the main laser printer selection on the setup page. Specifying a printer here does not advertise this CIC Pro center as a print server on RWHAT (like the main laser selection). It is used exclusively by the local full disclosure system. A printer must be “Added” to the operating system before it will show up in the drop-down list.
Licensing

All features and functions of the CIC Pro center are determined by the licenses activated and running on each CIC Pro center. Licenses are specific to each individual CIC Pro center’s serial number, are node locked, and cannot be used (floated) by another CIC Pro center.

Full disclosure

The CIC Pro center full disclosure system stores all waveform and parametric data from a patient for up to 72 hours. This data can be randomly accessed later in a static display that looks similar to the real-time display window. To accomplish this, every CARESCAPE Network waveform packet (4/sec) and every parameter packet (1 every 2 seconds) is stored on the CIC Pro center. In addition, one RWHAT packet and one admit packet is stored every minute to help recreate the patient’s history.

Unlike an alarm history event stored at the bedside, which only stores a 10 second snap shot surrounding the event, full disclosure allows the user to scroll back in time (prior to the event and leading up to the event).

Behaviors or rules

Installation

- Incompatible with previous full disclosure system (prior to CIC Pro center v3.x).
- Certain Unit Defaults are incompatible with CIC Pro center v3.x systems.

Start-up modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto For All</td>
<td>Automatically detects admitted beds that are not currently storing full disclosure data anywhere and attempts to start full disclosure on one of the CIC Pro centers within the care unit. This works regardless of whether the bed was admitted directly at the bedside or the CIC Pro center. Full disclosure cannot be stopped on a particular bed until the bed is discharged.</td>
</tr>
<tr>
<td>Auto If Listed</td>
<td>Same as Auto For All, but only if the bed in question is entered into the list on the FD Unit Defaults setup screen. All other beds are not storing full disclosure data.</td>
</tr>
<tr>
<td>Manual Mode</td>
<td>Beds are not automatically storing full disclosure data upon admission. Users can manually start and stop full disclosure for a particular bed by using a button located on the FD Strip page in the single viewer window. All full disclosure data is deleted when full disclosure is stopped for a bed. See the CIC Pro Clinical Information Center Operator’s Manual for more information.</td>
</tr>
</tbody>
</table>

Licensing

- Support for up to 16 patients per CIC Pro center.
Stores 72 hours of data per patient regardless of license type. Licensing controls amount of data that is viewable.

Unit Licensing Mode sets which type of license is requested. Supported types: None (default - 1 hour), 24, 48, 72 hours.

Failure to obtain a license results in no patient data is stored for full disclosure.

Licensing information is stored with data, so restrictions follow data regardless of where it is viewed, even if viewed in a different care unit with a different Unit License Mode.

Control

CIC Pro center master and full disclosure

There is one full disclosure master CIC Pro center per care unit. The CIC Pro center with the lowest MC IP address (126.x.x.x is “lower” than 3.x.x.x) within the care unit becomes the full disclosure master.

Full disclosure is a distributed sub-system for CIC Pro centers in the care area. As such, it is advisable that all CIC Pro centers in the care area be at the same revision. It is recommended that the CIC Pro center with the highest software version in the care unit be assigned as the full disclosure master.

The CIC Pro center master performs the following activities in one minute increments:

- Detects admitted (but not full disclosure data collection) beds within the care unit, for Auto modes.
- Assigns beds (for full disclosure acquisition) to CIC Pro centers within the care unit.
- Applies multi-full disclosure, twin-bed rules, and rover rule.
- Identifies CIC Pro centers with full disclosure capability.

NOTE

The CIC Pro center master checks the software versions of the other CIC Pro centers before trying to identify CIC Pro centers with full disclosure capability. Software versions earlier than 2.5 are ignored.

Guarantees that the right CIC Pro center is contacted if retrieving data while a multi-full disclosure condition is occurring and that the multi-full disclosure condition will be corrected.

NOTE

A CIC Pro center will not act as full disclosure master during the first minute after it starts up. Instead, the latest data is first collected from the other CIC Pro centers on the network, and this data determines which CIC Pro center becomes master. Multiple masters on a network might occur, but only briefly (this will self-correct within a couple of minutes).

Minute rule or the Offline Storage setting

For more information, see Set the full disclosure defaults on page 6-47.

The Offline Storage setting determines the length of time the CIC Pro center will maintain full disclosure data for a bed from which it has stopped receiving data (e.g., a NO COMM condition).
If the **NO COMM** condition ends within the **Offline Storage** setting time frame, full disclosure data collection for the bed continues.

If a **NO COMM** condition exceeds the **Offline Storage** setting time frame, all data for the bed is deleted. If (while in **Auto** mode) the bed comes back online (the **NO COMM** condition ends) after this point, the bed is reassigned as a new and different bed and new data collection is started for the bed.

When a CIC Pro center starts up, it determines when full disclosure data was last received from the assigned beds.

If the latest data for a bed:

- Is not older than the **Offline Storage** setting, then full disclosure data collection continues for the bed.
- Is older than the **Offline Storage** setting, existing data associated with the bed is deleted, and new data collection is started for the bed.

### Multi-full disclosure rule

If multiple CIC Pro centers are running in a care unit, the multi-full disclosure rule allows the switching of full disclosure data collection from one CIC Pro center to another, if a CIC Pro center goes offline (e.g., reboot, shutdown, etc.).

The following examples describe how the multi-full disclosure rule works when using two CIC Pro centers (CICA and CICB).

**NOTE**

In the examples, start up mode is Auto, and only one bed (BED1) is used.

**Example 1:**

1. CICA goes offline and stops full disclosure data collection on BED1. This causes CICB to begin full disclosure data collection on BED1.

   **NOTE**

   The master CIC Pro center detects CICA going offline, and switches full disclosure data collection over to CICB, within a minute of the offline event occurring.

2. CICA comes back online within the **Offline Storage** setting time frame, and continues full disclosure data collection on BED1 again. At this point, CICA and CICB are both collecting full disclosure data on BED1.

3. The multi-full disclosure rule does not allow more than one CIC Pro center to collect full disclosure data from the same bed at the same time—only the data that goes the farthest back in time (CICA) is kept. Because of this, CICA continues collecting full disclosure data on BED1, and CICB stops.
Example 2:

1. CICA goes offline and stops collecting full disclosure data on BED1. This causes CICB to begin collecting full disclosure data on BED1.

   **NOTE**
   The master CIC Pro center detects CICA going offline, and switches full disclosure data collection over to CICB, within a minute of the offline event.

2. CICA comes back online after exceeding the **Offline Storage** setting time frame. Because of this, existing BED1 data is deleted from CICA, and the new BED1 data collection begins on CICA. At this point, CICA and CICB are BOTH collecting full disclosure data on BED1.

3. The multi-full disclosure rule does not allow more than one CIC Pro center to collect full disclosure data from the same bed at the same time (only the data that goes the farthest back in time (CICB) is kept). Because of this, CICB continues collecting full disclosure data from BED1, and CICA stops.

   **NOTE**
   At every wake-up cycle (1 minute interval), the CIC Pro center full disclosure master scans all CIC Pro centers within the care unit to determine if more than one CIC Pro center is collecting full disclosure data from the same bed (this can happen as part of normal operation). If the master detects this condition, all CIC Pro centers are instructed to stop collecting full disclosure data from the bed except for the one CIC Pro center with the oldest data for the bed.

**Combo mode (twin-bed rule)**

In Combo mode:

1. Two beds are on the network: one is a hardwired/bedside monitored bed, and the other is telemetry bed. Both beds share the same name (e.g. BED), but ‘*’ is appended to the telemetry bed name (e.g. BED and BED*). Both beds represent the same patient.

   **NOTE**
   If the hardwire or telemetry bed was not functioning in Combo mode, these two beds would be treated as distinct and separate.

2. Only the oldest bed data is kept. Data for the other bed is deleted.

3. No matter which data is kept, full disclosure data collection continues, and the data is stored under the bed name, but without the ‘*’. 
NOTE

Combo mode is stopped (breaking Combo mode) by discharging either bed. If this happens, full disclosure data collection continues on the undischarged bed, and the data is stored under the undischarged bed name.

NOTE

If the hardwired bed is discharged, '*' would again be included in the name.

The following are Combo mode examples:

Combo mode Example 1:

1. A hardwired bed BED is admitted and full disclosure data is collected.
2. A telemetry bed BED* is admitted and full disclosure data is collected. Two separate full disclosure data stores exist, one for each bed (possibly on a different CIC Pro centers).
3. The two beds are put into Combo mode. When this happens, BED data is kept because it is older than BED* data, and BED* data is deleted. Full disclosure data collection continues, and the data is stored under the name BED.
4. Combo mode is broken by discharging BED*. Full disclosure data collection continues, with the data still stored under the name BED.

Combo mode Example 2:

1. A hardwired bed BED is admitted and full disclosure data is collected.
2. A telemetry bed BED* is admitted and full disclosure data is collected. Two separate full disclosure data stores exist, one for each bed (possibly on a different CIC Pro centers).
3. The two beds are put into Combo mode. When this happens, BED data is kept because it is older than BED* data, and BED* data is deleted. Full disclosure data collection continues, and the data is stored under the name BED.
4. Combo mode is broken by discharging BED. Full disclosure data collection continues, and the data is now stored under the name BED*.
Combo mode Example 3:

1. A telemetry bed BED* is admitted and full disclosure data is collected.
2. A hardwire bed BED is admitted and full disclosure data is collected. Two separate full disclosure data stores exist, one for each bed (possibly on a different CIC Pro centers).
3. The two beds are put into Combo mode. When this happens, BED* data is kept because it is older than BED data, and BED data is deleted. Full disclosure data collection continues, and the data is stored under the name BED.
4. Combo mode is broken by discharging BED*. Full disclosure data collection continues, and the data is still stored under the name BED.

Combo mode Example 4:

1. A telemetry bed BED* is admitted and full disclosure data is collected.
2. A hardwired bed BED is admitted and full disclosure data is collected. Two separate full disclosure data stores exist, one for each bed (possibly on a different CIC Pro center).
3. The two beds are put into Combo mode. When this happens, BED* data is kept because it is older than BED data, and BED data is deleted. Full disclosure data collection continues, and the data is stored under the name BED.
4. Combo mode is broken by discharging BED. Full disclosure data collection continues, and the data is now stored under the name BED*.

**Bed name/IP address changes (rover rule)**

The CIC Pro center tracks full disclosure data for individual beds using a combination of the bed name and IP address.

If a bed name changes during full disclosure data collection, information within the data reflects the new name at the point the name change occurred.

If a bed IP address changes during full disclosure data collection, but the name does not, it is interpreted as a new and different bed, and a new full disclosure data store is created and utilized for the new bed.
If a bed goes offline, and another bed with the same name but a different IP address comes online, it is interpreted as a new and different bed and a full disclosure data store is created and utilized for it. However, the following conditions apply:

- If the bed that went offline (with the original IP address) comes back online within the **Offline Storage** setting time frame, the two beds continue to be treated as separate, since the different IP addresses positively identify them as distinct and separate.
- If the bed that went offline (with the original IP address) does not come back online within the **Offline Storage** setting time frame, the bed with the new IP address is interpreted as a replacement for the bed with the original IP address. In this case, the full disclosure data for the bed with the original IP address is deleted, and full disclosure data collection continues, and the data is stored under the bed with the new IP address only.

### Unit Boundary

- Each care unit operates independently with respect to storage of full disclosure data. The only interaction is when displaying data across care units.
- License mode: All beds within a care unit will have access to the same amount of data storage (based on time) unless there is a failure to get a license (1 hour).
  
  **NOTE**
  
  This can be different across different care units (e.g., UnitA-72hours, UnitB-None (1 hour)).

- Start-up mode: The same start-up rules apply to all beds within a care unit.
- Default: The same full disclosure defaults are used on all CIC Pro centers within a care unit.
- Full disclosure master: One per care unit.
- Acquisition/storage: The master CIC Pro center will only assign beds within the care unit to CIC Pro centers within that care unit. At no time will data for a bed be stored on a CIC Pro center in a different care unit.
- Bed unit changes: If a bed changes its care unit name during full disclosure data collection, all data for the bed is deleted. The care unit where the bed moved becomes responsible for the bed.
- CIC Pro center unit changes: If a CIC Pro center changes its care unit name during full disclosure data collection, all data for all beds being having full disclosure data collected by that CIC Pro center is deleted. The care unit with the original name is responsible for the beds.

### Networking

**NOTE**

The Unity Network has been renamed to the CARESCAPE Network. Not all references to the Unity Network will be changed immediately; Unity may appear in some places and CARESCAPE in others. It is important to understand that while the CARESCAPE Network replaces the Unity Network name, they refer to the same GE monitoring network.
Patient monitoring network

The CIC Pro center processes and displays real-time data acquired from up to 16 networked GE monitors or telemetry transmitters/transceivers connected to the CARESCAPE Network.

When patient data is acquired from ApexPro telemetry transmitters/transceivers (telemetry beds), the data is transmitted to a telemetry receiver where it is then transferred to the CARESCAPE Network via a wired connection. The CIC Pro center displays this telemetry bed patient data along with the patient data acquired from other monitors.

Web access server network

**WARNING**

INTERNET EXPLORER FAVORITES — Saving Internet Explorer Favorites (bookmarks) for web pages containing patient data is not recommended. Doing so may result in patient data displayed in Internet Explorer not matching the patient’s medical number.

**CAUTION**

SECURITY — The healthcare institution is responsible for ensuring the privacy of any protected health information that is displayed on this device.

**CAUTION**

SECURITY — The web browser which runs in conjunction with the CIC Pro center is intended for hospital intranet use only. If confidential patient information is made available from the hospital intranet, the security of the data is the responsibility of the hospital.

CITRIX Intranet web portal

The CIC Pro center can provide access to a Citrix client or an intranet browser for viewing other applications (e.g., the hospital information system) or other sources of patient data (e.g., labs, images, or MUSE™ Cardiology Information System data).

Access to a Citrix server or intranet server depends upon how your CIC Pro center is configured and your on-site information technology offerings.

See Set up a Citrix client on page 6-19.
Web browser intranet web portal

WARNING
LOSS OF MONITORING — If the browser function is inappropriately used, loss of monitoring function may result. Use alternate monitoring devices or close patient observation until the monitoring function at the CIC Pro center is restored.

When using the browser, follow these restrictions:
- Do not attempt to access the file systems of the CIC Pro center through the use of the browser.
- Do not attempt to download files of any type. This includes, but is not limited to, audio or video files.

The CIC Pro center can provide a web portal to access and view other in-hospital web applications or other sources of patient data. This web browser option is located in the menu bar of the CIC Pro center display screen. Select this button to start a separate Microsoft Internet Explorer application.

See Browser configuration on page 6-58.

Patient data interface

The CIC Pro center allows you to view patient data using two different viewers, varying in data granularity:
- Multi-patient viewer
- Single patient viewer

Multi-patient viewer

The multi-patient viewer displays a snapshot of real-time waveform data and parameter numeric data for a maximum of 16 patients.

The following picture identifies different areas of the multi-patient viewer.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alarm buttons. Show the care unit name, bed number, and the cause of the alarm.</td>
</tr>
<tr>
<td>2</td>
<td>Colored border alarm indicator. The patient window is outlined in red or yellow to identify a patient alarm condition. The alarm message is also displayed.</td>
</tr>
<tr>
<td>3</td>
<td>Alarm message.</td>
</tr>
<tr>
<td>4</td>
<td>Multi-patient viewer menu bar buttons. See the CIC Pro Clinical Information Center Operator’s Manuals for details.</td>
</tr>
<tr>
<td>5</td>
<td>Additional parameter information.</td>
</tr>
</tbody>
</table>
| 6    | Patient name and Unit Name/Bed Name.  
The source of a patient’s parameter data can be from a monitor, a telemetry transmitter/transceiver, or from both a monitor and a telemetry transmitter/transceiver. To prevent the duplication of bed names and to help you identify the parameter data source, the CIC Pro center appends the following symbols to the bed name:  
- no symbol identifies a monitor (e.g., Unit Name/Bed Name).  
- * identifies telemetry bed (e.g., Unit Name/Bed Name*).  
- + identifies a Unity Network ID connected to the CARESCAPE Network (e.g., Unit Name/Bed Name+). |
| 7    | Real-time trend window. |
Equipment overview

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Empty patient window displaying an <em>Admit</em> window.</td>
</tr>
<tr>
<td>9</td>
<td>System status tray. Displays the following icons.</td>
</tr>
<tr>
<td></td>
<td>- MultiKM icon. See Using the MultiKM application on page 2-6.</td>
</tr>
<tr>
<td></td>
<td>- See System resource indicator on page 10-11.</td>
</tr>
<tr>
<td></td>
<td>- Print server queue icon.</td>
</tr>
</tbody>
</table>

**Single patient viewer**

The single patient viewer allows you to view detailed real-time or stored parameter data for one patient.

The following picture identifies different areas of a single patient viewer window.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Single patient viewer menu buttons.</td>
</tr>
<tr>
<td>2</td>
<td>Expanded waveform data.</td>
</tr>
<tr>
<td>3</td>
<td>Single patient viewer control buttons.</td>
</tr>
<tr>
<td>4</td>
<td>Close the single patient viewer.</td>
</tr>
<tr>
<td>5</td>
<td>Single patient viewer control buttons.</td>
</tr>
</tbody>
</table>

**Patient data**

You can view real-time patient data or retrieve and view patient data that has been collected and stored at the CIC Pro center.
Real-time patient data

Monitored parameters

The CIC Pro center can retrieve and display many different types of parameter data from patient monitors connected to the CARESCAPE Network. It can also retrieve and display many different types of parameter data from secondary devices connected through a Unity Network Interface Device.

NOTE

A more complete list of supported parameters is included in the CIC Pro Clinical Information Center Operator’s Manual.

For detailed parameter monitoring instructions, see the appropriate monitor or telemetry system operator’s manual.

For detailed clinical and troubleshooting information, see the Critical Care Monitoring Clinical Reference and Troubleshooting Guide.

Real-time trend window

The multi-patient viewer can be configured to display a real-time trend window. This trend window displays the recent trends for a maximum of two parameters. Each trend contains one hour of data displayed at one minute intervals. When you see a trend variation, you can review this trend more closely from the Graphic Trends tool.

For more information, see the CIC Pro Clinical Information Center Operator’s Manual.

Stored patient data

You retrieve in-unit parameter data from patient monitors connected to the CARESCAPE Network and retrieve parameter data from secondary devices connected through a device (Unity Network ID). In addition, can use the following CIC Pro center patient data review tools to examine the data more closely:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events</td>
<td>Review any crisis, warning, or advisory level arrhythmia event or ST event that is saved in the Events directory. You can also view saved ST references and sample ECG waveforms.</td>
</tr>
<tr>
<td>Event strip</td>
<td>Review 10-second snapshot of event data. The strip displays 5-seconds of data before the event occurred and 5-seconds of data during the event.</td>
</tr>
<tr>
<td>FD strip</td>
<td>Review a 10-second snapshot of available full disclosure parameter waveforms and values. You can scroll through the displayed data to change the data’s time focus.</td>
</tr>
<tr>
<td>FD page</td>
<td>Review a maximum of 72 hours of the most current full disclosure waveform and parameter numeric data. The amount of full disclosure data collected for a patient is determined by the type of licenses installed on the CIC Pro center.</td>
</tr>
</tbody>
</table>
Service interfaces

The CIC Pro center provides local, on-site remote, and off-site remote service interfaces for configuring, troubleshooting, and completing some of the checkout procedures.

See Service interfaces on page 4-1.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic trends</td>
<td>Review parameter numeric data over a specified period of time in bar graph format.</td>
</tr>
<tr>
<td>Vital signs</td>
<td>Review parameter numeric data values for monitored parameters over a selected period of time.</td>
</tr>
<tr>
<td>Calipers</td>
<td>Record measurements on the ECG waveforms.</td>
</tr>
</tbody>
</table>
3 Licensing
## CIC Pro center configurations

### License requirements

The license requirements for various types of CIC Pro center configurations are listed in the following table.

<table>
<thead>
<tr>
<th>Configuration type</th>
<th>Licenses required</th>
<th>Diagram</th>
</tr>
</thead>
</table>
| Standard CIC Pro center configuration                  | - Patient management package  
- Review package with or without FDPR and TDRT, as needed  
See License packages on page 3-6. | ![Diagram](image) |
| Clinician review workstation                           | Review package without FDPR and TDRT  
See License packages on page 3-6.  
See Configure clinician review workstation on page 6-14. | ![Diagram](image) |
| Secondary display utilizing a dual display configuration| - View license set  
- Patient management package with dual display license  
- Review package as needed  
See License packages on page 3-6. | ![Diagram](image) |
<table>
<thead>
<tr>
<th>Configuration type</th>
<th>Licenses required</th>
<th>Diagram</th>
</tr>
</thead>
</table>
| Mirror CIC Pro center configuration      | - Mirror license set  
- Optionally review package  
See License packages on page 3-6. | ![Diagram](image1.png) |
| MultiKM configuration                    | - View license set on CIC Pro centers in the group  
- MultiKM license on each CIC Pro center (up to 8)  
- Patient management package and optionally review package on the required CIC Pro centers  
See License packages on page 3-6. | ![Diagram](image2.png) |
| CIC Pro center with enterprise solutions: Aware Gateway connectivity | - ADT picklist license must exist on Aware Gateway. See Admit Request Info button on page 8-15.  
- Patient management package with ADT picklist option and optionally review package  
See License packages on page 3-6. | ![Diagram](image3.png) |
For more information on display configurations, refer to the following:

- Black Box CAT-5 VGA video splitter on page 5-15

**Available licenses**

**Description of licenses**

The following table identifies the licenses available for the CIC Pro center:

<table>
<thead>
<tr>
<th>Configuration type</th>
<th>Licenses required</th>
<th>Diagram</th>
</tr>
</thead>
</table>
| CIC Pro center with enterprise solutions: PDS connectivity | - PDS licenses on CIC Pro center (EVPD and TDPD)  
- Patient management package and optionally review package on the primary CIC Pro center | ![Diagram](image) |
| CIC Pro center with enterprise solutions: Citrix server  | - Citrix license connectivity  
- Patient management package and optionally review package on the primary CIC Pro center | ![Diagram](image) |

See License packages on page 3-6.

<table>
<thead>
<tr>
<th>Name</th>
<th>Option Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| **ADT - Basic Functionality** | ADTF        | - Fast and accurate way to admit patients.  
- Search by patient last name, room, bed and medical record number or patient ID.  
- View a list of possible patient matches with their demographics.  
- Select a patient from the list instead of needing to enter characters with the keyboard.  
- Interface with Hospital Information Systems via the Aware Gateway to select a patient from a list. |
### Licensing

<table>
<thead>
<tr>
<th>Name</th>
<th>Option Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Secondary Display**          | DDIS        | - View all of the single patient viewer applications in this secondary display.  
                                 |             | - Use the secondary display as a review display.                             
                                 |             | - View two applications at the top and bottom half of the screen.            
                                 |             | - View all applications (excluding multi-patient viewer) in this secondary display. 
                                 |             | - Navigate between applications via enhanced software tools.                
                                 |             | - Access custom views of routine applications using a single mouse click.   |
| **Events - Directory**         | EVDR        | Sort and count parameter events:                                             |
| **Events - Patient Data Server**| EVPD        | - Sort parameter events by time and type.                                   
                                 |             | - View the total count of each event type in the patient’s event directory. |
                                 |             | - Scan for Events without scrolling down a long list of individual events.  |
| **Events - Review**            | EVRW        |                                                                             |
| **Full Disclosure - 24 Hours Storage** | FD24      | Store 24 hours of full disclosure data. This data is viewable from the FD Strip and FD Page data review tools. |
| **Full Disclosure - 48 Hours Storage** | FD48      | Store 48 hours of full disclosure data. This data is viewable from the FD Strip and FD Page data review tools. |
| **Full Disclosure - 72 Hours Storage** | FD72      | Store 72 hours of full disclosure data. This data is viewable from the FD Strip and FD Page data review tools. |
| **Full Disclosure - Calipers**  | FDCL        | Calculate a waveform interval or amplitude:                                 |
| **Full Disclosure - Page Review** | FDPR      | Display multiple waveforms of full disclosure data in a page view:          |
| **Full Disclosure - Strip Review** | FDST      | - View up to 72 hours of full disclosure data as a half page or a full page view. |
| **Live View - Alarm Silence**  | LVAS        | Silence alarms.                                                             |
| **Live View - Basic View**     | LVBV        | Display a patient bed in a single patient viewer. This license will be included as a standard offering with all packages. |
| **Live View - Enterprise**     | LVEN        | View patient beds outside of the care unit.                                |
| **Live View - Graph All**      | LVGA        | Print the parameter limits or the waveform data for all patients in the care unit. This license will be included as a standard offering with all packages. |
| **Live View - MultiViewer**    | LMVM        | Display a maximum of 16 patient beds (slots) in the multi-patient viewer.   |
| **Live View - View Slot**      | LVSL        | Display a patient bed (slot) in the multi-patient viewer. One license is required for each displayed bed. A maximum of 16 LiveView - View Slot licenses can be activated. |
| **Live View - Mirror View Slot** | LVSM      | Provide a mirror image view of a primary CIC Pro center.                    |
### License packages

For current information regarding the following packages, please contact your local GE representative. The following packages are offered in different combinations within the package and across packages.

<table>
<thead>
<tr>
<th>Package</th>
<th>Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Management package</td>
<td>ADTF, LVAS, MNSU, ADTP, DDIS</td>
</tr>
<tr>
<td>Review package</td>
<td>EVDR, EVRW, EVPD, TDGR, TDPD, TDVS, FDST, FDCL, FDPR, TDRT</td>
</tr>
<tr>
<td>View license set</td>
<td>LVSL, LVMV, LVEN</td>
</tr>
<tr>
<td>Mirror license set</td>
<td>LVSM, LVMV, LVEN</td>
</tr>
</tbody>
</table>
Patient Data Server information

When the *Events - Patient Data Server* or *Trends - Patient Data Server* licenses are installed, you can select the *Events Data Source* icon, which can be one of the following icons on the *Events Directory* screen:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bedside monitor icon" /></td>
<td>Bedside monitor. This can be either a telemetry or a hard-wired bedside. The amount of historical data is limited to the specific data source. For most hard-wired bedsides, there is a limit of around 32 history events and 24 hours of trend data.</td>
</tr>
<tr>
<td><img src="image" alt="Unity Network Patient Data Server (PDS) icon" /></td>
<td>Unity Network Patient Data Server (PDS). This server gathers and stores historical events from hard-wired bedsides and telemetry transmitters. Up to 500 events can be stored for a single patient. For more information, refer to the Unity Network Patient Data Server (PDS) Operator’s Manual.</td>
</tr>
</tbody>
</table>

License activation methods

There are multiple methods for activating software licenses on a CIC Pro center.

- If you are installing a new CIC Pro center, see Activate licenses (automatically) using a USB memory stick with the CIC Pro center on page 6-10.
- If you are activating licenses at a later date, perform one of the following procedures:
  - Activate licenses (automatically) via a service PC on page 8-16.
  - Activate licenses (manually) via the Activation Code Summary Sheet on page 8-18.
4 Service interfaces
Introduction

Service interfaces provide several advanced and specialized functions for configuring, troubleshooting, and performing checkout procedures on the CIC Pro center.

Access methods

The CIC Pro center provides both direct and network access methods to access the service interfaces.

Direct access method

The direct access method uses locally connected displays, keyboards, and mice to access multiple CIC Pro center functionality. The direct access method supports the following operating modes and service interfaces:

- Administrator mode. See Administrator mode access on page 4-3.
- Clinical application mode. See Setup CIC with service access on page 4-5 and Command-line interface access (for advanced users) on page 4-5.

The administrator mode supports multiple service access interfaces:

- Windows utilities interface. See Windows utilities access on page 4-6.
- Command-line interface. See Access command-line interface from the administrator mode on page 4-6.
- Webmin interface (web-based tool for configuration and diagnostics). See Webmin interface access on page 4-7.

The clinical application mode supports multiple service access interfaces:

- Setup CIC tool with service login interface. See Setup CIC with service access on page 4-5.
- Command-line interface. See Command-line interface access (for advanced users) on page 4-5.
- Webmin interface. See Webmin interface access on page 4-7.

Network access method

The network access method uses a PC connected with a network route to the CIC Pro center. The network access method supports the following service interfaces:

- Screen sharing interface (VNC Read only). See Screen-sharing interface access on page 4-6.
- Webmin interface. See Webmin interface access on page 4-7.
Operating modes

Overview

Normally, the CIC Pro center starts up in the clinical application mode. To switch to administrator mode, refer to Administrator mode access on page 4-3.

CAUTION
During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

Administrator mode access

Log on to the CIC Pro center as Administrator

1. From the multi-patient viewer, click Setup CIC.
2. Click the Service Password tab.
3. Type mms_com as the password and press Enter.
4. At the Windows command line prompt, type stop and press Enter.
5. From the Windows taskbar, click Start > Shutdown.
6. Choose Log off as CIC and while holding down the Shift key, press OK until the logon screen displays.
7. Enter the Administrator username and password.
   a. In the Username field, type administrator.
   b. In the Password field, type admin1,3,5,7 and press Enter.

Log off as Administrator

To log off as Administrator and return to the run-time CIC Pro center clinical application mode:

1. From the Windows taskbar, click Start > Shutdown.
2. Choose Log off as Administrator and press Enter. The CIC Pro center automatically reboots and begins running the CIC Pro center clinical application.
## Service interface access

### Overview

**WARNING**

CIC Pro center service interfaces are intended for use only by properly trained, qualified personnel. Do not “experiment” with the service utilities, or use them in any way other than shown in this manual. Consequences of misuse include loss of patient data, corruption of CIC Pro center or operating system software, or disruption of the CARESCAPE Network MC network.

The following table lists the usernames and passwords associated with CIC Pro center service interfaces.

<table>
<thead>
<tr>
<th>Service interface and function</th>
<th>Access type</th>
<th>Mode type</th>
<th>Username</th>
<th>Password</th>
<th>Logon procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup CIC with service access, used to configure settings for the CIC Pro center clinical application, such as telemetry and care unit settings.</td>
<td>Direct</td>
<td>Clinical application</td>
<td>Not applicable</td>
<td>mms_cic</td>
<td>See Setup CIC with service access on page 4-5.</td>
</tr>
<tr>
<td>Command-line interface, used to stop the CIC Pro center application and launch other system applications. This interface is intended for use by advanced users.</td>
<td>Direct</td>
<td>Clinical application</td>
<td>Not applicable</td>
<td>mms_com</td>
<td>See Command-line interface access (for advanced users) on page 4-5.</td>
</tr>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>Administrator</td>
<td>admin1,3,5,7</td>
<td></td>
<td>See Administrator mode access on page 4-3.</td>
</tr>
<tr>
<td>Windows utilities:</td>
<td>Direct</td>
<td>Administrator</td>
<td>Administrator</td>
<td>admin1,3,5,7</td>
<td>See Administrator mode access on page 4-3.</td>
</tr>
<tr>
<td>– 3M Touchware and ELO touch screen calibration applications</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– On-screen keyboard application, useful for non-English keyboards</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Acrobat Reader</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Internet Explorer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Windows desktop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen-sharing interface, view only function used for troubleshooting. Limit to one simultaneous connection only.</td>
<td>Network</td>
<td>Not mode-dependent</td>
<td>Not applicable</td>
<td>prism1,3,5,7</td>
<td>See Screen-sharing interface access on page 4-6.</td>
</tr>
<tr>
<td>Webmin interface, used to perform the following:</td>
<td>Direct and network</td>
<td>Not mode-dependent</td>
<td>biomed</td>
<td>Change Me₁</td>
<td>See Webmin interface access on page 4-7.</td>
</tr>
<tr>
<td>– Display device information for the CIC Pro center and other peripheral devices.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Configure system and network settings for the CIC Pro center.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Diagnose device and system problems.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Setup CIC with service access

**WARNING**

QUALIFIED PERSONNEL — The Service mode is intended for use only by qualified personnel with training and experience in its use. The consequences of misuse include loss of alarm configuration, loss of patient data, creation of an unmonitored bed scenario, corruption of the CIC Pro center operating system software, or disruption of the CARESCAPE Network.

Log on to Setup CIC with service access

1. From the multi-patient viewer, click *Setup CIC*.
2. Click the *Service Password* tab.
3. In the *Password* field, type *mms_cic* and press *Enter*.

Log off Setup CIC with service access

1. Click the close button (X).
2. When you are prompted if you want to exit out of Service Mode, click *Yes*.

Command-line interface access (for advanced users)

Log on to command-line interface from the clinical application mode

1. From the multi-patient viewer, click *Setup CIC*.
2. Click the *Service Password* tab.
3. In the *Password* field, type *mms_com* and press *Enter*.

\[1\text{The password for the Webmin logon can be changed from the default at the first logon. However, the password can only be reset by GE personnel who are physically at the site, or remotely if the device is Insite ExC (Remote) connected. See Change the logon password for Webmin on page 8-32.}\]
Service interfaces

Access command-line interface from the administrator mode

1. From the Windows taskbar, click Start > Run.
2. At the command prompt, type cmd and click OK.

Log off command-line mode

To exit command-line mode, click the close button (X).

Windows utilities access

Once you Log on to the CIC Pro center as Administrator on page 4-3, there is no additional login required to access the Windows utilities.

Screen-sharing interface access

Log on to the screen-sharing interface

1. Install the Ultra VNC client, distributed via the CIC v5.1.x Distribution software DVD, onto the service PC.
2. Navigate to the location where you installed UltraVNC Viewer and select Run UltraVNC Viewer (Listen Mode). The typical installation path on Windows XP is: All Programs > UltraVNC > UltraVNC Viewer > Run UltraVNC Viewer (Listen Mode).
3. Enter the IX network IP Address of the CIC Pro center in the VNC Server field and click Connect.

NOTE

Do not type http or https before the IP address.
4. Do not change any of the default settings.

**NOTE**

A CIC Pro center v5.1.x screen can be remotely viewed only and you cannot take control of the CIC Pro center you have connected.

Log off the screen-sharing interface

To log off VNC screen-sharing mode, click the close button (X).

**Webmin interface access**

---

**CAUTION**

Users must log off of Webmin to prevent unauthorized access. Closing Webmin is not equivalent to logging off. You must click *Logout*.

---

You can access the Webmin service interface locally from the CIC Pro center, or remotely from a service PC connected to the CARESCAPE Network IX network.

**Log on to the Webmin service interface**

**Log on to the direct access (local) Webmin service interface**

Complete the following procedure to log on to the Webmin service interface using the CIC Pro center’s *Browser* function.

1. From the multi-patient viewer, click *Browser*.
2. Depending upon browser configuration, click on either the *Favorites* menu or the *Favorites* button.
3. Click *LocalWebmin*.
4. In the *Username* field, type `biomed`.
5. In the *Password* field, type `[password]` and press Enter.

**NOTE**

- The password is *Change Me* unless it has been changed.
- See Change the logon password for Webmin on page 8-32.

**Log on to the Webmin service interface remotely via the CARESCAPE network IX network**

1. Set up the service PC’s network properties. Refer to the table on page 4-8.
### Windows 2000

1. From the Windows taskbar, select **Start > Settings > Control Panel > Network and Dial-up Connections.**

2. On the *Network and Dial-up Connections* window, right-click on the network port connected to the CARESCAPE Network IX network, and select **Properties.**

3. On the *Local Area Connection Properties* window, under *Components checked are used by this connection,* scroll down and highlight **Internet Protocol (TCP/IP)** and select **Properties.**

4. Select **Use the following IP address.**

5. Type IP address and subnet mask and default gateway values matching the CARESCAPE Network IX network domain for the CIC Pro center. For example:

   - IP Address: 192.168.2.1
   - Netmask: 255.255.0.0

   *Match the first two octets of the CIC Pro center’s IX IP address: < >< >.2.1.

6. Select **OK** to save this configuration and close the **Internet Protocol (TCP/IP) window.**

7. Select **OK** to close the **Local Area Connection Properties** window.

### Windows XP

1. From the Windows taskbar, select **Start > Control Panel > Network Connections.**

2. Right-click **Local Area Connection.**

3. Select **Properties.**

4. Select **Internet Protocol (TCP/IP).**

5. Select **Properties.**

6. Select **Use the following IP address** and complete the following steps:
   a. In the **IP address** field, type an IP address that is in the same domain as the CIC Pro center and is not used at this site.
   b. In the **Subnet mask** field, type the Subnet mask address. The address must match the Subnet mask address configured at the CIC Pro center you want to connect to.

7. Select **OK.**

8. Select **OK.**

9. For Windows XP, instead of restarting the service PC, you can select **Start > Control Panel > Network Connections,** right-click on **Local Area Connection,** select **Disable** and then right-click again and select **Enable.**

2. If necessary, change the Internet Explorer LAN settings on the service PC.
   a. Start the Microsoft Internet Explorer application.
   b. From the Internet Explorer application, click **Tools > Internet Options.**
   c. Click the **Connections** tab.
   d. Click **LAN Settings.**
   e. Disable the **Automatic Configuration** and **Proxy Server** selections, as required.
   f. Click **OK.**

3. Connect to Webmin.
   a. Connect the service PC to a CARESCAPE Network IX network switch, or connect the service PC directly to the CIC Pro center CARESCAPE Network IX network connection port using a crossover cable.
   b. Start the Microsoft Internet Explorer application.
c. In the Address field, type https://[CIC Pro center server IX IP address]:10000 and press Enter.

**NOTE**
- [CIC Pro center server IP address] is the CARESCAPE Network IX network IP address for the CIC Pro center server.
- Make sure you type https and not http.

d. In the Username field, type biomed.

e. In the Password field, type [password] and press Enter.

**NOTE**
The password is Change Me unless it has been changed.

### Webmin overview

**NOTE**
All Webmin modules are static in nature. Since the Webmin service interface session times out after 15 minutes, you must always refresh the browser to load the latest page.

Webmin is an internet-based web application used to configure, troubleshoot, and perform checkout procedures. For logon instructions, see Webmin interface access on page 4-7.

Webmin functionality is divided across the following tabs:
- Information tab on page 4-9
- Configuration tab on page 4-10
- Diagnostics tab on page 4-12

### Information tab

The Information tab displays information for the CIC Pro center, the network environment, and the other peripheral devices connected to the network.

![System Information](image)

The following links are found on the Information tab.
The following links are found on the Configuration tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS Hotfix Information</td>
<td>View a list of installed service packs.</td>
</tr>
<tr>
<td>Printer Information</td>
<td>View information about the installed digital writers and laser printers.</td>
</tr>
<tr>
<td></td>
<td>See Check status of installed printers on page 7-3.</td>
</tr>
<tr>
<td>System Information</td>
<td>View the serial number, model ID, and software version corresponding to</td>
</tr>
<tr>
<td></td>
<td>the CIC Pro center. See View system information on page 7-3.</td>
</tr>
<tr>
<td>Logout</td>
<td>Log off the Webmin service interface and display the login window.</td>
</tr>
<tr>
<td>Option</td>
<td>Function</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Asset Settings** | - Set the Device Asset Number to identify this device on the CARESCAPE Network.  
- View the Device Serial Number.  
See Check asset information on page 7-20. |
| **Backup/Restore** | - Back up and restore certain tools, data files, and list files.  
See Back up and restore the CIC Pro center configuration on page 6-72.  
- Back up and restore the following custom configuration settings from a remote location:  
  - FD Page: Displayed waveforms and waveform display enhancements (e.g., Zoom Window).  
  - Graphic Trends: Customized trend groups.  
  - Vital Signs: Customized sort modes.  
  - Menubar: Customized **Save As Favorites** for single or secondary display configurations. |
| **Browser**     | Configure the CIC Pro center to connect to an intranet browser and add or delete browser favorites. See Define browser favorites on page 6-21. |
| **Citrix**      | Set up a Citrix client on the CIC Pro center. See Set up a Citrix client on page 6-19.                                                                                                                    |
| **Language**    | Set the language of the CIC Pro center application. See Configure the CIC Pro center language on page 6-28.                                                                                                     |
| **Licensing**   | Activate or remove licenses from the CIC Pro center. See Activate licenses (automatically) via a service PC on page 8-16.                                                                                         |
| **MultiKM**     | Configure a group of centralized and configured CIC Pro centers to use one mouse and one keyboard in the group. See Perform MultiKM (Multimouse) setup on page 6-78.                                             |
| **Network**     | Set the CIC Pro center IP addresses. See Set the network IP address on page 6-12.                                                                                                                          |
| **Passwords**   | Change the logon password for the Webmin service interface. See Change the logon password for Webmin on page 8-32.                                                                                             |
| **Printers**    | - Install or delete network laser printers. See Install a network laser printer on page 6-15 and Delete a network laser printer on page 6-16.                                                                  |
|                 | - Designate where specific clinical data (e.g., alarm control, Event strip) will print. See Configure the print location settings for stored patient data on page 6-68.                                              |
| **Remote Service** | Configure the CIC Pro center for remote service access. See Configure the server for remote connectivity on page 6-16.                                                                                     |
Diagnostics tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Flags</strong></td>
<td>Configure the following settings:</td>
</tr>
<tr>
<td></td>
<td>- <strong>No Comm.</strong> See Configure the NO COMM alarm setting, if applicable on page 6-23.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Force Age</strong>. See Configure force age setting, if applicable on page 6-24.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Multiviewer Alarm Audio</strong>. See Configure multiviewer alarm audio setting, if applicable on page 6-25.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ADU Alarm Audio</strong>. See Configure ADU alarm audio setting, if applicable on page 6-26.</td>
</tr>
<tr>
<td><strong>Software Management</strong></td>
<td>Upgrade the software and perform software maintenance. See Upgrade software on page 12-1.</td>
</tr>
<tr>
<td><strong>Time Date</strong></td>
<td>Set the time and date of the CIC Pro center. See Set the time-of-day or the date on page 6-69.</td>
</tr>
<tr>
<td><strong>Logout</strong></td>
<td>Log off the Webmin service interface and display the logon window.</td>
</tr>
</tbody>
</table>

The following links are found on the **Diagnostics** tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All CICs</strong></td>
<td>Check for time zone, daylight saving time, and CARESCAPE Network IP address errors for all CIC Pro centers on the network. See Pre-configuration instructions on page 8-2.</td>
</tr>
<tr>
<td><strong>Full Disclosure</strong></td>
<td>Set the Full disclosure mode and display a list of full disclosure beds. See Set full disclosure mode on page 8-13 and List full disclosure beds on page 8-12.</td>
</tr>
<tr>
<td><strong>Logfiles</strong></td>
<td>Download or view the CIC Pro center log files. See Log files on page 8-20.</td>
</tr>
</tbody>
</table>
## Service interfaces

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ping</strong></td>
<td>Test the CIC Pro center's connectivity with other network devices. See Unable to communicate with a device on page 8-11.</td>
</tr>
<tr>
<td><strong>Preventative Maintenance</strong></td>
<td>Access a wide variety of system tests.</td>
</tr>
<tr>
<td><strong>Runtime Diagnostics</strong></td>
<td>Access a wide variety of system status information.</td>
</tr>
<tr>
<td><strong>SMART Drive Status</strong></td>
<td>View the read and write integrity of the storage media devices. See SMART drive status on page 8-29.</td>
</tr>
<tr>
<td><strong>Waveform Indicators</strong></td>
<td>Change the waveform indicator value. See Display waveform indicators on page 8-15.</td>
</tr>
<tr>
<td><strong>Logout</strong></td>
<td>Log off the Webmin service interface and display the logon window.</td>
</tr>
</tbody>
</table>
Service interfaces
5 Installation
Requirements

The CIC Pro center is to be installed by properly trained, qualified personnel. The installer must complete the following before physically installing the CIC Pro center:

- Complete product training on page 5-2.
- Complete site survey on page 5-2.

Complete product training

Product training is required prior to installing, configuring, and calibrating the CIC Pro center.

Complete site survey

**CAUTION**

Failure to complete a site survey may lead to improper installation and improper performance of the CIC Pro center.

A site survey with all network design, installation, and testing must be completed and documented prior to equipment installation. The site survey is completed by authorized GE personnel.

Service PC

A PC is required for licensing. This can be a desktop or a laptop computer.

Pre-installation checklist

- Set up the service PC’s network properties on page 4-8.
- Format a USB memory stick on page 5-3.
- Procure necessary licenses on page 5-3.
- Gather required tools on page 5-4.
- Inspect equipment on page 5-4.
- Evaluate site on page 5-4.

- Environmental limits on page 5-5.
- Electromagnetic fields and electrical noise on page 5-5.
- Clearance and airflow on page 5-5.
- Electrical grounding on page 5-6.
- Un-interruptible power supply (UPS) on page 5-7.
- Physical specifications. Refer to the CIC Pro Clinical Information System Technical Specifications Supplement for physical requirements.
Format a USB memory stick

To activate licenses with a USB memory stick, you need an NTFS formatted USB memory stick containing the `<Serial Number of CIC Pro center>.txt` license file, matching the serial number of your CIC Pro center.

1. Insert the blank USB memory stick into one of the service PC’s USB ports.
2. From Windows Explorer, right-click on the Removable Disk drive containing the USB memory stick and click Properties.
3. On the General tab, note the value of the File system. If it is not NTFS:
   - For Windows XP, continue to step 4.
   - If your operating system is not XP, skip to step 5.
4. (Windows XP only) Optimize the USB memory stick for performance:
   a. Click Hardware.
   b. Select the USB drive and click Properties.
   c. Click Policies and select the Optimize for Performance option.
   d. Click OK twice to close the windows.
5. From Windows Explorer, right-click on the Removable Disk drive containing the USB memory stick and click Format.
6. On the Format window, select NTFS from the File system drop-down list and click Start.
7. Verify that this is the USB drive you want to format and click OK.
8. Remove the USB memory stick.
   a. In the Windows system status tray, click the Safely Remove Hardware icon to safely stop running the USB memory stick.
   b. On the Safe Eject window, choose the drive running the USB memory stick. Typically, this is drive H: on the CIC Pro center.
   c. Remove the USB memory stick from the USB port.

Procure necessary licenses

Procure the applicable licenses for your installation.

NOTE

The `<Serial Number of CIC Pro center>.txt` license file (e.g., SCY07150960G4.txt) and Activation Code Summary Sheet may have been shipped electronically. For another copy of the Activation Code Summary sheet, `<Serial Number of CIC Pro center>.txt` license file, or a blank USB memory stick, contact Technical Support (Refer to the How to reach us page). For the part number of the USB memory stick, see Accessories on page 9-6.

1. Insert the blank NTFS formatted USB memory stick into one of the service PC’s USB ports. See Format a USB memory stick on page 5-3.
2. Navigate to where you stored the `<Serial Number of CIC Pro center>.txt` file.

3. Open the `<Serial Number of CIC Pro center>.txt` file and confirm the `<Serial Number of CIC Pro center>.txt` file displays the CIC Pro center serial number.

4. Save the `<Serial Number of CIC Pro center>.txt` file to the blank USB memory stick.

5. Confirm the serial number on the memory stick matches the serial number of the CIC Pro center you are activating licenses on. You can find the serial number in the following locations:
   - The upper right corner of the CIC Pro center application window.
   - The equipment label located on the lower left chassis case.
   - Webmin (`Configuration > Remote Service > Configuration`).

Gather required tools

A standard set of hand tools is required for equipment installation.

- Standard screwdriver
- Number 2 Phillips screwdriver
- Wire cutter (small)
- Standard nut driver set

Inspect equipment

Unpack the equipment and inspect for shipping damage:

1. Remove all equipment, including all peripheral devices, from the shipping cartons. Inspect for damage. If any damage is found, contact GE Technical Support.

2. Identify all required cables and prepare them for installation.

3. Complete the Visual inspection on page 10-3 to inspect for shipping damage.

Evaluate site

**WARNING**

BEFORE INSTALLATION — Compatibility is critical to safe and effective use of this device. Please contact your local sales or service representative prior to installation to verify equipment compatibility. See Device compatibility on page C-1.

When installing a CIC Pro center into a care unit, you need to verify that the CIC Pro center’s platform and software are compatible with all devices on the MC and IX network. Notify the biomedical staff if any non-GE equipment is installed on the MC and IX network. See Pre-configuration instructions on page 6-2. Also, See Device compatibility on page C-1.
Environmental limits

The CIC Pro center operates reliably within normal office environmental limits. Select a site which meets the following criteria:

- Clean and reasonably free of excess dust. Dust accelerates system wear.
- Well-ventilated and away from sources of heat.
- Away from sources of vibration or physical shock.

Electromagnetic fields and electrical noise

The CIC Pro center should be isolated from strong electromagnetic fields and electrical noise produced by electrical devices such as:

- Elevators
- Copy machines
- Air conditioners, large fans
- Large electric motors
- Radio and TV transmitters
- High frequency security devices
- High-load medical devices (e.g., imaging, defibrillators, etc.)

Clearance and airflow

---

**CAUTION**
The CIC Pro center uses an internal forced-air cooling system, but most displays do not. The user must determine the heat dissipation requirements of the selected display and provide for any required cooling ventilation.

---

**CAUTION**
NEGLIGENCE — GE does not assume responsibility for damage to the equipment caused by improperly vented cabinets, improper or faulty power, or insufficient wall strength to support equipment mounted on such walls.

---

Keep the CIC Pro center ventilation openings free of obstructions. The CIC Pro center physical location should provide at least the following minimal ventilation clearances:

- Front: 20.5 centimeters (8 inches)
- Back: 20.5 centimeters (8 inches)
- Bottom: 1 centimeter (3/8 inch) (required for MP100 desktop only)

The vent holes in the bottom of the unit must not be obstructed. A minimum airspace of 1 centimeter (3/8 inch) must be provided between the vent holes and the supporting surface. When installed with the bottom vent holes down, the unit must be on a hard, flat surface with the bottom feet intact.
Do not remove the bottom feet or operate with the bottom of the unit on a carpeted surface.

If installed with the vent holes in the bottom surface to the side (standing on a side, or vertical installation), a minimum of 1 centimeter (3/8 inch) clearance must be provided between the vent holes and the adjacent surface.

**Electrical grounding**

**Duplex power outlet**

A properly grounded duplex power outlet is required for each CIC Pro center.

**NOTE**

It is the customer’s responsibility to ensure that this requirement is met.

Additional outlets may be required to accommodate connected peripheral equipment. The power outlet must be installed in an approved junction box. Use only a three-prong, polarized, hospital-grade power outlet to accept the three-prong polarized CIC Pro center power plug.

**Grounding system**

**WARNING**

SHOCK HAZARD — The CIC Pro center and all peripheral equipment must be adequately grounded or a shock hazard may exist. Do not use plug adapters that defeat the grounding capability of the three-prong power plug. An ungrounded electrical device presents a potentially severe and dangerous shock hazard.

The grounding pin of all power outlets and all exposed metal parts (beds, radiators, water pipes, etc.) in any patient area should be electrically connected together. This common ground point should be connected to the nearest equipotential ground through a bonded grounding system, or with a 10 AWG stranded copper grounding cable.

The equipotential ground point should be as close to earth ground potential as possible. If a bonded grounding system is not available, the ground pin of each power outlet must be individually connected to a central grounding point. Do not jumper from ground pin-to-ground pin of the outlets.

The grounding system must not carry current, such as a grounded neutral, since the current flow will produce potential differences along the ground path. These potential differences are a shock hazard source for equipment users and patients.

Do not use conduit as a ground conductor. Plastic (PVC) piping or fittings used in the conduit runs can break the electrical connection to ground, resulting in potential shock hazards.

The electrical grounding system should be connected to an earth ground. If this is not possible, then a good ground reference, such as a metal water pipe, or an electrically-conductive building component, should be used. It is more important that all grounded objects in the patient area are at the same ground potential rather than at earth ground potential.
Un-interruptible power supply (UPS)

**WARNING**
Connect the UPS to the CIC Pro center(s) and display monitor(s) only. Do not connect printers or other devices to a UPS, as such devices may shorten estimated run-times. If AC line power is not restored before UPS run-time is exceeded, the CIC Pro center improperly shuts down and patients will not be monitored.

**WARNING**
Without a UPS, power line outages may result in:
- Improper shutdown of the CIC Pro center, causing lengthy disk scan procedures on reboot.
- Data loss.

If power to the CIC Pro center is lost, patient monitoring information will no longer be displayed or stored.

GE recommends using a UPS with the CIC Pro center. See Accessories on page 9-6 for a listing of UPS units available for the CIC Pro center. Follow the manufacturer’s recommendations for installing the UPS.

**NOTE**
The CIC Pro center draws approximately 40 watts of power. The displays each draw approximately 50 watts of power. See the table on page 5-7.

The following table identifies the estimated wattage for CIC Pro center MP100 systems and 19-inch medical displays:

<table>
<thead>
<tr>
<th>Number of CIC Pro center MP100 systems</th>
<th>Number of CIC Pro center 19-inch medical displays</th>
<th>Total load with CIC Pro center MP100 system(s) and CIC Pro center 19-inch medical display(s) (estimated watts)</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>One display (primary)</td>
<td>75 W</td>
</tr>
<tr>
<td>One</td>
<td>Two displays (dual/secondary)</td>
<td>115 W</td>
</tr>
<tr>
<td>Two</td>
<td>Four displays (Two primary, Two secondary)</td>
<td>230 W</td>
</tr>
</tbody>
</table>

The actual UPS run-times are variable, and are affected by the following conditions:
- Battery age
- Ambient temperature
- Site-specific UPS usage patterns
- Load characteristics
Installation process

Precautions

**WARNING**
ELECTRIC SHOCK—To avoid electric shock, the CIC Pro center and its accessories should not be placed within the patient environment, which is a volume related to an object (bed, chair, table, treadmill, etc.) where a patient is intended to be diagnosed, monitored, or treated.

**WARNING**
LOSS OF ALARMS—CIC Pro center V5.1 x is in-unit compatible with CIC Pro center V4.0.7 or later. It is not in-unit compatible with versions of CIC Pro center V3.1 or earlier and is not in-unit compatible with any versions of Centralscope. Sharing of the same care unit name across central stations having incompatible software versions can result in lost or corrupted telemetry alarm defaults data and loss of audible alarms. See Device compatibility on page C-1.

**WARNING**
LOST OR INTERMITTENT COMMUNICATION—Do not exceed a maximum of 15 CIC Pro centers in a single logical care unit.

Attempting simultaneous displays of a patient monitor (bedside or telemetry) at too many CIC Pro centers may cause lost or intermittent communication between CIC Pro centers and the patient monitor. This is evidenced by **NO COMM** or intermittent communication conditions for the beds.

The maximum CIC Pro centers viewing a patient bedside monitor can vary depending on bedside monitor capabilities and network design.

Both hard-wired and telemetry beds are limited in the number of remote view connections that can be supported.

There are limitations for the device quantity supported by the CARESCAPE Network. Please contact GE for guidance on CARESCAPE Network construction.
WARNING
Only external devices specifically designed to be connected to the CIC Pro center, or approved by GE for use with the CIC Pro center, should be connected, as specified in this manual or as otherwise specified by the manufacturer.

A shock hazard may exist if external devices are connected differently from described in this manual, or as directed by the manufacturer.

External equipment must be connected to the CIC Pro center only by qualified biomedical engineering personnel.

CIC Pro center v5.1.x does not support the use of a KV/KVM switch. Do not use a KVM switch with mixed versions of CIC Pro center (CIC Pro center v5.1.x and 4.1.1 or 4.0.x).

WARNING
SITE REQUIREMENTS — Do not route cables in a way that they may present a stumbling hazard. For devices installed above the user, adequate precautions must be taken to prevent them from dropping on the user.

WARNING
ACCIDENTAL SPILLS — To avoid electric shock or device malfunction, liquids must not be allowed to enter the device. If liquids have entered a device, take it out of service and have it checked by a service technician before it is used again.

WARNING
BEFORE USE — Before putting the system into operation, visually inspect all connecting cables for signs of damage. Damaged cables and connectors must be replaced immediately.

Before using the system, the operator must verify that it is in correct working order and operating condition.

Periodically, and whenever the integrity of the product is in doubt, test all functions.
CAUTION
POWER REQUIREMENTS — Before connecting the device to the power line, check that the voltage and frequency ratings of the power line are the same as those indicated on the unit’s label. If this is not the case, do not connect the system to the power line until you adjust the unit to match the power source.

In the USA, if the installation of the equipment will use 240V rather than 120V, the source must be a center-tapped, single-phase circuit.

This equipment is suitable for connection to public mains as defined in CISPR 11.

CAUTION
All external cabling used with the CIC Pro center must be routed so it does not interfere with access to, or operation of, the CIC Pro center. Install cabling to guard against tripping and accidental cable disconnection.

CAUTION
Do not apply power until all equipment is installed and ready for use.

CAUTION
This assembly is static sensitive and should be handled using precautions to prevent electrostatic discharge damage.

Installation process checklist

Complete the following tasks in the order presented:

- [ ] Mount the equipment on page 5-11.
- [ ] Connect the cables and peripheral devices on page 5-12:
  - [ ] Connect the keyboard and mouse on page 5-12.
  - [ ] Connect the external speakers on page 5-12.
  - [ ] Connect the display(s) on page 5-13.
- [ ] Install optional accessories on page 5-16:
  - [ ] Install laser printers on page 5-16.
  - [ ] Connect the digital writer on page 5-17.
- [ ] Plug in the power cable to the CIC Pro center on page 5-18.
- [ ] Turn on the power on page 5-19.
Mount the equipment

Desktop (MP100D) mounting options

The CIC Pro center desktop unit may be physically mounted using one of the following strategies:

- Placed horizontally on a desktop, under the monitor stand/base.
- Physically mounted to a wall or the bottom side of a desk or shelf using the supplied mounting bracket. When using this method, attach the bracket to the desktop unit using the four mounting screws.
- Placed vertically on a desktop or floor, using the optionally orderable foot stand.

Rack-mounted (MP100R) mounting options

The CIC Pro center rack-mounted unit may be physically mounted using one of the following strategies:

- Placed horizontally on a desktop, under the monitor stand/base.
- Physically mounted in a server rack.
- Physically mounted to a rack using the supplied mounting bracket. When using this method, attach the bracket to the rack using the four mounting screws.

Restrictions

---

**CAUTION**

PERFORMANCE ISSUES/DATA LOSS—Failure to adhere to the following restrictions may cause CIC Pro center performance issues and data loss.

---

The following restrictions apply to the mounting options listed above:

- USB ports support passive extenders up to a total of 15 feet (per USB 2.0 standards) and does not support active extenders. The standard keyboard is supplied with a 6-foot cable, so only an additional 9-foot USB passive extender can be used.
- GE does not carry in service stock any USB extenders.
- No extenders are supported for the speaker.
- The part numbers for the supported digital video cables are listed in Accessories on page 9-6.
Connect the cables and peripheral devices

**CAUTION**
Do not insert the CARESCAPE Network IX or CARESCAPE Network MC cable into the CIC Pro center at this time. Network connectivity is enabled after the CIC Pro center has been installed and configured for use.

Connect the keyboard and mouse

**NOTE**
- Always position the mouse on a flat surface to prevent erratic mouse movements and behaviors.
- USB ports support passive extenders (per USB 2.0 standards) and does not support active extenders. For more information, see Restrictions on page 5-11.

Insert the keyboard and mouse cables into any available USB port on the CIC Pro center.

Connect the external speakers

**WARNING**
ALARMS — Do NOT rely exclusively on the audible alarm system for Bedside Monitoring. Adjustment of CIC Pro center alarm volume to a low level or OFF during Bedside Monitoring may result in inability to hear the alarm and a hazard to the patient. Remember that the most reliable method of Bedside Monitoring combines close personal surveillance with correct operation of monitoring equipment.

After connecting the monitor to the central station and/or nurse-alert, verify the function of the alarm system. Repeat this verification periodically, including a check of all connected speakers.

CIC Pro center audible alarms will not sound for patients with bedside monitoring devices configured to “Operating Room” mode.

The functions of the alarm system for monitoring of the patient must be verified at regular intervals. Check speaker volume periodically to ensure audio alarm functionality.

In addition to two internal speakers, the CIC Pro center is equipped with a 1/8-inch external speaker connection port.
NOTE

- External speakers are connected during normal operation. An alert message displays when no external speaker connection is present. This is true even if the CIC Pro center is used as a mirrored CIC Pro center and its audible alarm volume is set to \textit{OFF}.
- All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of the various alarms in your environment and the configuration of the alarm audio settings.
- No extenders are supported for the speaker. For more information, see Restrictions on page 5-11.

1. Connect the external speaker cable into the speaker port \[\text{Speaker Port}\] on the CIC Pro center.

2. Tighten the cable clamp screw to secure the clamp to the chassis.

Connect the display(s)

Valid display configurations

<table>
<thead>
<tr>
<th>Single Display system</th>
<th>Primary</th>
<th>Secondary</th>
<th>Dual Display system (Requires license)</th>
<th>Primary</th>
<th>Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Display system</td>
<td>DVI-D or VGA</td>
<td>N/A</td>
<td>Dual Display system</td>
<td>DVI-D or VGA</td>
<td>DVI-D only</td>
</tr>
</tbody>
</table>

The primary display video connection supports DVI-I analog/digital connections. Analog VGA monitors require a DVI to VGA adapter. See Accessories on page 9-6.

NOTE

- The primary or secondary display can be a non-touchscreen or touchscreen display.
- The part numbers for the supported digital video cables are listed in Accessories on page 9-6.

Connect the primary display

Complete the applicable steps in the following table to connect up to two displays to the CIC Pro center.
When installing and configuring a secondary display to the CIC Pro center, use the following process to ensure proper operation:

1. Ensure that the secondary display meets the hardware requirements listed under Secondary display on page 2-8.

2. Ensure that the dual display licenses have been procured. See Procure necessary licenses on page 5-3.

3. To connect the secondary display, perform the applicable steps in the following table:

<table>
<thead>
<tr>
<th>Non-touchscreen primary display</th>
<th>Touchscreen primary display</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Insert the single display DVI cable into the primary video DVI port (DVI-I 1) on the CIC Pro center.</td>
<td>1. Insert the touchscreen monitor DVI cable into the primary video DVI port (DVI-I 1) on the CIC Pro center.</td>
</tr>
<tr>
<td>2. Firmly screw in the DVI connectors into the connector port.</td>
<td>2. Firmly screw in the DVI connectors into the connector port.</td>
</tr>
<tr>
<td>3. Insert the display power cable into a UPS, if available. See Un-interruptible power supply (UPS) on page 5-7.</td>
<td>3. Insert the touchscreen display data cable into the USB port on the CIC Pro center.</td>
</tr>
<tr>
<td></td>
<td>NOTE</td>
</tr>
<tr>
<td></td>
<td>You can also use the COM1 port to connect the serial touchscreen display cable.</td>
</tr>
<tr>
<td>4. Insert the display power cable into a UPS, if available. See Un-interruptible power supply (UPS) on page 5-7.</td>
<td>4. Insert the display power cable into a UPS, if available. See Un-interruptible power supply (UPS) on page 5-7.</td>
</tr>
</tbody>
</table>
WARNING
LOSS OF MONITORING—Before continuing, notify the site’s biomedical department so patient data communications can be established with an alternative central station. The CIC Pro will not retrieve patient data during the installation procedure.

NOTE
The Black Box CAT-5 VGA video splitter as described in this section is supported with the 20-in NEC 2090UX black LCD display (pn2030604-002) as supplied by GE or equivalent.

If an equivalent display is used, ensure the selected display is compatible with the Black Box CAT-5 VGA video splitter.
Installation

Installation instructions are included with the kits specified.

Install optional accessories

Install laser printers

Before installing a laser printer, determine if connecting using USB or the network. For a list of compatible USB and network printers, refer to Laser printer on page 2-9. If using USB, do not connect the USB cable until instructed during configuration.

1. Do not install any printer software that is enclosed with the printer. Required driver software is included with the CIC Pro center software that you will interface with.

2. There is no need to adjust the date and time on the printer. The time is set by the time master of the central network

3. For registration of the printer, please consult the hospital staff. Registration of the printer is the hospitals responsibility. Registration information is typically included within the printer packaging or manufacturing's instructions. Or you can visit the printer manufacturer's website. Information for the manufacturer's website is included with the printer instructions.

4. Refer to manufacturer's instructions for physical installation of printer.

5. After physical installation of printer, it may be necessary to change the printer configuration. For example, modify the IP address and subnet mask for a network CAT 5 UTP cable
printer. To do this, use the controls and appropriate manufacturer’s instructions enclosed with the printer.

For configuration information, refer to Configure USB laser printers on page 6-29 or Configure network laser printers on page 6-14.

Connect the digital writer

**NOTE**

The PRN 50-M must use software v2B or later to operate properly with the CIC Pro center and telemetry systems.

1. Screw the PRN 50-M adapter into the RS232 2 port on the CIC Pro center.

2. Connect the supplied Category 5 cable into the adapter and into the PRN 50-M port.

3. Load the printer with paper.

4. Insert the digital writer power cable into an electrical power outlet.

Change writer paper

Complete the following procedure to replace the 2-inch digital writer paper:

1. Press the button on the top of the writer to open the writer door.
2. Remove the old spool and install a new paper roll so it unrolls from the bottom.

3. Close the door. Make sure the paper protrudes from the opening.

4. Test the writer by initiating a graph strip.

5. Remove the test graph by tearing downward.

**Plug in the power cable to the CIC Pro center**

**WARNING**
Ample access for AC power cord disconnect (from the wall outlet, or from the back of the unit) is vital to provide positive AC power disconnection for service or in the event of emergency.

1. Insert the power cable into the power outlet on the CIC Pro center.

2. Tighten the cable clamp screw to secure the clamp to the chassis.

3. Insert the power cable into a UPS. See Un-interruptible power supply (UPS) on page 5-7.
Turn on the power

1. Turn on the power by pressing the power switch located on the CIC Pro center and on the displays.
   
   A green power indicator illuminates when the power is turned on. After approximately 30 seconds, the multi-patient viewer should display.

2. Proceed to Configuration on page 6-1.
6 Configuration
Pre-configuration process

Pre-configuration requirements

All the CIC Pro centers connected to the CARESCAPE Network IX and MC networks must comply with the following configuration requirements:

- All devices must have the same time zone settings.
  - The *Automatically adjust clock for daylight saving changes* check box must remain *UNCHECKED* at all times.
- All MC network IP addresses must be in the same IP scheme with the same subnet mask.
- All IX network IP addresses must be in the same IP scheme with the same subnet mask.
- In the hierarchy of multiple compatible CIC Pro center hardware and software versions that co-exist, it is important to assign a set of the highest MC network IP addresses to the highest software version. For example, if you are installing CIC v5.1.x to an existing CARESCAPE Network comprising of CIC v4.0.7 or later, you must allocate a set of the highest MC network IP addresses to all of the CIC Pro center’s hardware running CIC v5.1.x. No lower version CIC Pro center can have an IP address on the MC network that is greater than the IP address of a higher version CIC Pro center.

Use the Check Centrals utility to check for the following on all the CIC Pro centers on the network:

- Time zone settings
- Daylight saving time (DST) status
- CARESCAPE Network IP address errors
- Status of 4.1.1-1 patch application on CIC Pro center v4.1.1 (available only with the release of CIC Pro center v5.0.7 or later)

**NOTE**

- The Check Centrals utility does *not* discover any version of Central Scope.
- The Check Centrals utility *will* discover CIC Pro center hardware running v1.5, but will not report its IP configuration information. This means that you must physically locate these devices if they exist on the network. Please read step 5 on page 6-5.
- The Check Centrals utility will *not* discover any non-CIC Pro center device (e.g., printers, Aware Gateway, PDS) on the network.

The Check Centrals utility is also supplied separately. (For the part number of the Check Centrals utility, see Disaster recovery software kit and Service Tools CD on page 9-6.) You can run the utility directly from the CD on BCM and Nightshade platforms. However, this utility must be copied from the CD to an NTFS formatted USB memory stick for use on Bedrock platforms (v4.1.1 and greater).

Pre-configuration instructions

1. Read and understand the following Caution and communicate this information to the biomedical/clinical staff:
**Configuration**

**CAUTION**

NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within one minute or less) used by the existing GE devices on the CARESCAPE Network.

2. Run the Check Centrals utility to verify that the time zone, IP addresses, and subnet mask are configured correctly. Follow the applicable steps for the software version of CIC Pro center you are running:

**NOTE**

Depending on the size of the network, the data retrieval process could take several minutes.

<table>
<thead>
<tr>
<th>If the following CIC Pro centers are currently running on the CARESCAPE Network</th>
<th>Follow these steps</th>
</tr>
</thead>
</table>
| CIC Pro center software v4.0.x or v4.1.1 or later | 1. From the multi-patient viewer, click *Setup CIC*.  
2. Click the *Service Password* tab.  
3. In the *Password* field, type *mms_com* and press *Enter*.  
4. Run the Unity Time Zone Discovery Tool/Check Centrals utility from the CD (BCM and Nightshade platforms) or a USB memory stick (Bedrock platform).  
5. At the command prompt, navigate to the drive where the Check Centrals utility is located (e.g., E:\ or F:\) and type *checkCentrals -tz*. |
| CIC Pro center software v5.0.3 | 1. If you have not already logged onto Webmin, *Log on to the Webmin service interface on page 4-7*.  
2. Click *Diagnostics > Run CIC Cmd*.  
3. In the command text field, type *checkCentrals -tz* and click *Run Cmd*. |
| CIC Pro center software greater than or equal to 5.0.3 but less than 5.1 (e.g. 5.0.3, 5.0.6) | 1. If you have not already logged onto Webmin, *Log on to the Webmin service interface on page 4-7*.  
2. Click *Diagnostics > Run CIC Cmd*.  
3. In the command text field, type *checkCentrals -tz -presidpatch* and click *Run Cmd*. (This will list the 4.1.1-1 patch application status on 4.1.1 units.) |
| CIC Pro center software v5.1.x and above | 1. If you have not already logged onto Webmin, *Log on to the Webmin service interface on page 4-7*.  
2. Click *Diagnostics > All CICs*.  
3. Click *Run Check Centrals*. |

The following is sample output from the Check Centrals utility.
NOTE

The information in the sample output represents the data format only. Therefore, do not attempt to analyze these IP addresses versus any errors reported.

--- Results for checkCentrals -tz ---
Gathering Central Station information currently on the Unity network...
...UU...U...

<table>
<thead>
<tr>
<th>Unit</th>
<th>Name</th>
<th>Version</th>
<th>MC IP Addr</th>
<th>IX IP Addr</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANNEX</td>
<td>BCM</td>
<td>v4.0</td>
<td>126.4.74.10</td>
<td>121.121.121.121</td>
</tr>
<tr>
<td>ANNEX</td>
<td>KAZ0</td>
<td>v5.0</td>
<td>126.126.126.156</td>
<td>8.20.94.58</td>
</tr>
<tr>
<td>ANNEX</td>
<td>KAZ1</td>
<td>v5.0</td>
<td>126.126.126.157</td>
<td>8.20.94.45</td>
</tr>
<tr>
<td>ANNEX</td>
<td>RBN</td>
<td>v5.0</td>
<td>126.1.4.44</td>
<td>7.20.93.33</td>
</tr>
<tr>
<td>ANNEX</td>
<td>SAF</td>
<td>v5.0</td>
<td>126.1.4.5</td>
<td>7.20.87.149</td>
</tr>
<tr>
<td>DCM</td>
<td>CIC2</td>
<td>v5.0</td>
<td>126.1.244.167</td>
<td>192.168.1.10</td>
</tr>
<tr>
<td>DCM</td>
<td>CIC2</td>
<td>v4.0</td>
<td>126.1.244.167</td>
<td>192.168.1.10</td>
</tr>
<tr>
<td>GEHC</td>
<td>BA1</td>
<td>v5.0</td>
<td>126.4.72.68</td>
<td>7.20.88.69</td>
</tr>
<tr>
<td>ICU</td>
<td>CIC</td>
<td>v4.0</td>
<td>126.1.75.28</td>
<td>192.168.63.56</td>
</tr>
<tr>
<td>ICU</td>
<td>MAX</td>
<td>v5.0</td>
<td>126.1.1.1</td>
<td>192.168.1.1</td>
</tr>
<tr>
<td>ICU</td>
<td>SV5</td>
<td>v4.0</td>
<td>126.21.65.103</td>
<td>** Unknown **</td>
</tr>
<tr>
<td>ICU</td>
<td>DFR</td>
<td>v3.0</td>
<td>126.2.73.199</td>
<td>** Unknown **</td>
</tr>
</tbody>
</table>

Assessing remote Central Stations for...
- Integrity of the IX settings
- DayLight Savings Setting
- Time Zone Setting

X.F..XX.XXU.XUFX

*******************************
** Central Station Summary **
*******************************

**** Network Based Errors ****
'Unknown' IX IP Address Errors
----------------------
1: ICU|SV5
2: ICUX|DFR
3: ORSOUTH|JJO
'Unknown' Error- Address has not been configured
Not able to perform any remote checks for these systems.

'No Path' to the IX IP Address Errors
----------------------
1: ANNEX|BCM
2: DCM|CIC2
3: DFR|CIC
4: ICU|CIC
5: ICU|MAX
6: ORNORTH|AGI
'No Path' Error- Address that does not have a physical path (i.e. unplugged Network cable) or network settings are such that the address cannot be accessed (i.e. ping fails)
Not able to perform any remote checks for these systems.

'No Access' to the remote IX IP Address Errors
----------------------
1: ANNEX|KAZ1
'No Access' Error- Address is correctly configured but the central station is preventing access. This will most often occur because that device is behind a software firewall.
Not able to perform any remote checks for these systems.

Remote Assessment Results

Daylight Savings Time (DTS) Failures
--------------------------------------
No 'DST' errors detected for the devices that could be contacted

TimeZone Failures
--------------------
No 'TZ' errors detected for the devices that could be contacted

** Local System Information **
TimeZone = Central Standard Time
Automatic DTS = FALSE

************************************************
3. Analyze the Check Centrals output:
   a. Identify time zone or daylight saving time network errors:
      ■ Verify that all the CIC Pro centers configured on the CARESCAPE Network are listed.
      
      **NOTE**
      The target CIC Pro center running the Unity Time Zone Discovery Tool utility is the baseline device used for determining time zone or daylight saving time errors.
      ■ If errors are identified for either the time zone (TZ) or daylight saving time (DST) settings, correct the time zone settings as per instructions in Set the time zone on page 6-35.
   b. Identify CARESCAPE Network IX and MC addressing scheme errors:
      ■ Verify the CARESCAPE Network IX and MC addressing schemes match for all the CIC Pro centers on the CARESCAPE Network.
      ■ If the addressing schemes do not match, complete Network IP address configuration for each CIC Pro center that requires IP address changes, as per instructions in the appropriate CIC Pro Clinical Information Center Service Manual.

4. If there is any CIC Pro center hardware running v4.1.1 on the network, make sure that the v4.1.1-1 patch is applied.

5. Make sure that only the following compatible CIC Pro center versions co-exist in a given care area:
   ■ CIC v5.1.x
   ■ CIC v5.0.x
   ■ CIC v4.1.1-1
   ■ CIC v4.0.7 or CIC v4.0.8
   
   **NOTE**
   CIC Pro center hardware running v1.5, or any version of Central Scope, can exist independently in a separate care area, but not in the same care unit name with the software versions listed above.

6. If there is one or more Aware Gateway on the network, configure the Time Master settings at the Aware Gateway. See the latest Aware Gateway Service Manual for instructions. Consult Tech Support and hospital IT if any assistance is required.

7. Investigate if there is any unauthorized, non-GE medical equipment connected to the MC/IX network. If any unauthorized non-GE equipment is found or reported to be connected to the CARESCAPE Network, read and understand the following Warning and communicate this information to the hospital IT/ biomedical or clinical staff before proceeding further:
WARNING
During the timeframe that GE patient monitoring devices are connected to a non-validated network, customers must be aware that they are operating this system with increased risk, especially for devices that rely specifically on the network for real time transmission of alarms and other monitoring data. This increased risk comes about because GE has not been able to review/approve the proposed network design and/or commission the implemented network to ensure it meets required performance specifications.

The devices at increased risk include, but are not exclusive to, medical telemetry and all patient monitoring done from the CIC Pro center.

Since monitoring data flows to and from central stations, telemetry servers, and other medical devices, the lack of a commissioned network can affect the performance of the overall system. Further, the lack of a validated network may result in limited technical support for troubleshooting product issues on products that rely on the CARESCAPE Network.

8. Investigate if there are any spare (un-connected) CIC Pro centers in the biomed shop and/or if there are any CIC Pro centers in the care area that are designed to work on customer demand (e.g., connected to the network, currently switched off and used only when needed). Before introducing such CIC Pro centers to the existing network, do the following:

a. Make sure that those CIC Pro center hardware and software versions are compatible (as listed in step 5):
   - The time zone settings are the same.
   - The Automaically adjust clock for daylight saving changes check box must remain UNCHECKED at all times.
   - All MC IP addresses must be in the same IP scheme with the same subnet mask.
   - All IX IP addresses must be in the same IP scheme with the same subnet mask.

b. Inform the biomed about the following Caution:

CAUTION
NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within one minute or less) used by the existing GE devices on the CARESCAPE Network.

9. Make CIC v5.1.x (or the highest CIC Pro center software version) the Time Master.
NOTE

In the hierarchy of multiple compatible CIC Pro center hardware and software versions that co-exist, it is important to assign a set of the highest MC IP addresses to the highest software version. For example, if you are installing CIC v5.1.x to an existing CAREScape Network comprising of CIC v4.0.7 or later, you must allocate a set of the highest MC IP addresses to all of the CIC Pro center’s hardware running CIC v5.1.x. No lower version CIC Pro center can have an IP address on the MC network that is greater than the IP address of a higher version CIC Pro center.

10. Verify that there is only one Time Master on the network and it is compliant with step 9 by running the following command from any CIC Pro center currently on the network:

```
lw -s "TIME MASTER"(lw<space>-s<space>"TIME<space>MASTER")
```

11. If you have not already connected the service PC to the CIC Pro center, set up the service PC’s network properties on page 4-8.

12. Proceed to the Configuration process checklist on page 6-7.

Configuration process checklist

NOTE

After making configuration changes, ensure the CIC Pro center is functioning properly by completing all relevant checkout procedures before returning it to clinical use. See Checkout procedures on page 7-1.

NOTE

If the System Resource Indicator ( icon in the bottom tray) turns yellow or red during or after configuration, a pop-up message will appear. Take the necessary action. Refer to Environment Monitor messages on page 8-19.

Disconnect CAREScape Network IX and MC networks

☐ Disconnect from the CAREScape Network IX and MC networks on page 6-9.

Install licenses

☐ Activate software licenses on page 6-10.

Configure Webmin-related settings

NOTE

All Webmin modules are static in nature. Since the Webmin service interface session times out after 15 minutes, you must always refresh the browser to load the latest page.

☐ Log on to the CIC Pro center as Administrator on page 4-3.
Configure desktop-related settings

- Configure USB laser printers on page 6-29.
  - Configure HP LaserJet 2430 and HP LaserJet P3005 USB printers on page 6-29
  - Configure HP LaserJet P3015 USB printers on page 6-29
- Set the laser printer default paper size on page 6-30.
- Configure a secondary display on page 6-31.
- Calibrate a touchscreen display on page 6-33.
- Set the time zone on page 6-35.
- Restart the CIC Pro center. Complete step 4 of Perform safe restart of the CIC Pro center on page 8-30

Configure clinical application settings

NOTE

All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit.

- Configure USB laser printers on page 6-29.

NOTE

This step may be performed at a later date if desired.
Configure the printer settings on page 6-37.
Set the CIC Defaults on page 6-37.
Set the Telemetry Unit Defaults on page 6-44.
Set the Telemetry Alarm Control Defaults on page 6-46.
Set the full disclosure defaults on page 6-47.
Set the Display Configuration (non-mirror CIC Pro centers) on page 6-49.
Set the Current Telemetry Listings on page 6-51.
Check and configure the speaker volume on page 7-5.
Set up locked beds on page 6-54.
Configure customized groupings on page 6-62.
Set up custom groupings for graphic trends on page 6-62.
Set up custom groupings for vital signs on page 6-65.
(Chinese only) Set the pressures unit-of-measure on page 6-54.
Screen calibration on page 6-56.
Define the Internet options on page 6-59.
Configure shortcuts to favorite CIC Pro center views on page 6-66.
Configure the print location settings for stored patient data on page 6-68.
Set the time-of-day or the date on page 6-69.
Back up and restore the CIC Pro center configuration on page 6-72.

Reconnect the CIC Pro center with the network

Connect the CIC Pro center to CARESCAPE Network IX and MC networks.
Verify network and time settings. For instructions on running the Check Centrals utility, see Pre-configuration instructions on page 6-2.

Perform MultiKM (Multimouse) setup

Pre-configure the CIC Pro centers on page 6-79.
Configure the keyboard and mouse group on page 6-81.
Change a keyboard and mouse group on page 6-84.

Disconnect from the CARESCAPE Network IX and MC networks

It is important that you disconnect the CIC Pro center from the CARESCAPE Network IX and MC networks before you begin the configuration process.
Configure Webmin-related settings

Activate software licenses

For information about the licenses available for the CIC Pro center, see Description of licenses on page 3-4.

Verify equipment requirements

Before attempting to activate licenses, verify that the following requirements are met:

- The CIC Pro center must be running at least software v5.1.x.
- The CIC Pro center serial number matches the serial number for the license filename. For example, the license filename for CIC Pro center serial number SDY08010027GA should be SDY08010027GA.txt.
- USB memory stick containing required licenses.
- Service PC (desktop or laptop computer) equipped with an Ethernet network card and running Windows NT, 2000, or XP. You will need this if you are accessing the service interface via a service PC.
- Ethernet crossover cable.
- Access to the <Serial Number of CIC Pro center>.txt license activation file. This file may be stored on the NTFS-formatted USB memory stick.

Activate licenses (automatically) using a USB memory stick with the CIC Pro center

1. Insert the NTFS formatted memory stick containing the <Serial Number of CIC Pro center>.txt license file into one of the USB ports on the back panel of the CIC Pro center. See Procure necessary licenses on page 5-3.
2. From the multi-patient viewer, click Setup CIC > Licensing.
3. View the information on the Licensing window.

NOTE

If no licenses have been installed on this CIC Pro center, no option activation codes are listed and the activation icons appear red in color.
4. Click **Install Licenses**.
5. If the path shown is incorrect, navigate to the directory on the USB memory stick where the `<Serial Number of CIC Pro center>.txt` file is stored and click *Open*. After a short delay, a message displays.

6. Click *OK*. The *Licensing* window on the CIC Pro center should now display the option activation codes for the activated licenses.

7. Get the Activation Code Summary Sheet that matches the serialized USB memory stick and the serial number of your CIC Pro center.

8. Verify the licences identified on the Activation Code Summary Sheet were activated on the CIC Pro center.

**NOTE**

A license is installed when an activation code displays and the activation icon appears green in color.

9. Safely remove the USB memory stick.
   a. In the Windows system status tray, click the *Safely Remove Hardware* icon to safely stop running the USB memory stick.
   b. On the *Safe Eject* window, choose the drive running the USB memory stick. Typically, this is the `H:` drive on the CIC Pro center.
   c. Remove the USB memory stick from the USB port.
   d. Store the USB memory stick and the Activation Code Summary Sheet in a safe and accessible location. In the event of a hard drive failure, the option activation codes on this USB memory stick are required for disaster recovery.
   e. Restart the CIC Pro center. You must restart before you can use any of the newly activated features. For more information, refer to Perform safe restart of the CIC Pro center on page 8-30.

### Set the network IP address

**WARNING**

Duplicate IP addresses will cause erratic system communication and data loss! Be extremely careful not to assign the same IP address to two different devices.
WARNING

NETWORK INTEGRITY — The CIC Pro center should not be installed directly on the Hospital Enterprise network. Ensure that the CARESCAPE Network IX and CARESCAPE Network MC are isolated either physically, or on non-routable VLANs or via router.

If the CIC Pro center is configured to reside on the hospital’s enterprise network, it is possible that inadvertent or malicious network activity could adversely affect patient monitoring. The integrity of the computer network is the responsibility of the hospital.

You will need the completed site survey workbook to set the CIC Pro center’s IP addresses required for your network domain.

1. Get the completed site survey workbook for this care area.

2. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

3. Click Configuration > Network.

4. Under Unity MC, if the site uses a custom CARESCAPE Network MC network addressing scheme, change the CARESCAPE Network MC network IP address so that it is unique on the network.

NOTE

- The default IP address settings are recommended. See the site survey workbook for the IP address values.
- Typically, the Unity MC > Subnet Mask setting could remain at the default setting 255.255.0.0. See the site survey workbook for details.

5. Under Unity IX, enter the IP Address, Subnet Mask, and Default Gateway settings according to the values identified in the site survey workbook.
NOTE

- Typically, the **Unity IX > Subnet Mask** setting should remain at **255.255.0.0**. See the site survey workbook.
- A route must exist from the IX network to other CIC Pro centers, Citrix servers, browser services, and the Internet for Remote Connection Services.
- Contact the hospital IT Administrator, as needed, to configure the browser to access hospital intranet applications.

6. If the MC and IX network **IP Address** or **Subnet Mask** has been changed, replace the label on the CIC Pro center cover with a new label displaying the IP address and subnet mask value(s).

7. Under **DNS Settings**, enter the **Primary DNS** and **Secondary DNS** settings according to the values identified in the site survey workbook.

   **NOTE**

   DNS addresses can be used for browser sources and for InSite 2.0 configuration only.

8. Click **Save**.

   **NOTE**

   You must save the changes or the changes will be lost.

9. Complete any other pending CIC Pro center configuration procedures, as required.

   **NOTE**

   You must restart the CIC Pro center for the new IP address settings to take effect.

10. From the Windows taskbar, click **Start > Shut Down > Restart** and press **Enter**.

### Configure clinician review workstation

1. Ensure all multi-patient viewer slots are set to **None**.

2. Remove the display license. See Remove an activated license on page 8-19.

3. Restart the CIC Pro center. See Perform safe restart of the CIC Pro center on page 8-30.

### Configure network laser printers

This section describes the procedures required to configure network laser printers:

- Install a network laser printer on page 6-15.
- Delete a network laser printer on page 6-16.
Install a network laser printer

NOTE

The following installation procedure requires a CARESCAPE Network IX network connection. See Set the network IP address on page 6-12.

The following procedure only applies when the printer TCP/IP scheme follows CARESCAPE Network IX network IP addressing factory defaults, and the printer is physically located on the CARESCAPE Network IX network. When the printer uses a custom TCP/IP addressing scheme, refer to the site survey for resolving TCP/IP values.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Configuration > Printers.

3. With the laser printer physically connected to the CARESCAPE Network IX network, turn on the power to the laser printer.

4. Click Install Laser Printer.

5. In the Printer’s IP Address field, type the IP address assigned to the printer.

   NOTE

   It is recommended that the assigned IP addresses of the printers be maintained at the site for future reference.

   NOTE

   If the IP address is not specified or if it has not valid, the following error will be displayed:

   ![Error Message]

6. In Printer Type, select the default printer driver HP Universal Printing PS.
NOTE

This driver will support the currently released printers listed on page 2-9.

7. In Printer Name, type a name for the printer (up to 29 characters).

NOTE

If a printer name is not specified, the following error will be displayed:

Install Laser Printer

Wed Jun 4 15:17:52 2008

A Printer Name must be specified. Please go back and enter a printer name.

8. If desired, in the Comment field, type a comment about the printer (up to 29 characters).

9. In the Test Page field, choose Yes to print a test page.

NOTE

If the printer is not connected to the network, then the test page will be queued to the printer and will print after it is connected to the network.

10. Click Submit. The installed printer displays in the printer list.

Delete a network laser printer

Complete the following procedure to delete a network laser printer:

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Configuration > Printers.

3. Click Delete Laser Printer.

4. Under Select the printer to delete, select the printer you want to delete from the drop-down list.

5. Click Submit. The printer is deleted from the printer list.

NOTE

Deleting a printer does not remove the references to it under the CIC Setup/care unit default settings.

Configure the server for remote connectivity

The CIC Pro center is capable of remote service using GE Healthcare InSite ExC Digital Services. See the site survey workbook for required configuration information.

This section describes the procedures required to configure the server for remote connectivity:

☐ Configure the Remote Service settings on page 6-17.
☐ Enable or disable the Remote Service Agent on page 6-18.
Configure the Remote Service settings

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Configuration > Remote Service > Configuration.

3. On the Remote Service Configuration screen, make the necessary changes to the appropriate fields:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>If this site uses an HTTP proxy server, a specific IP Address and Port number are required for the Remote Service communication to work. Otherwise, select None.</td>
<td>These values are determined during the site survey. See the site survey workbook.</td>
</tr>
<tr>
<td>Port</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Username and Password</td>
<td>If the HTTP proxy server requires user authorization, a specific Username and Password is required. Otherwise, select None.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**

Remote Service Configuration settings are automatically populated.
4. Click **Save** to save your changes.

### Enable or disable the Remote Service Agent

After the CIC Pro center has been configured for remote serviceability, this option must be enabled for use.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click **Configuration > Remote Service > Control.**
3. On the Remote Service Controls screen, select the appropriate option in the New State field:
   - To enable the Remote Service Agent, click Enable.
   - To disable the Remote Service Agent, click Disable.

4. Click Save to save your changes.

**Set up a Citrix client**

Citrix is an application that runs on top of Microsoft’s Terminal Services in the Windows 2003 server. Citrix servers run applications, such as Notepad, Internet Explorer, GE software, or the hospital’s proprietary applications.

CIC Pro center v5.1.x software is included with a Java Citrix client. Citrix clients display the applications and pass keyboard, mouse, and sound events back and forth to the Citrix server. This means that you are just viewing the application at the CIC Pro center, while the application itself is running on the Citrix server.

If the facility supports a Citrix server, a Citrix client can be set up on the CIC Pro center.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Configuration > Citrix.
3. Get the Citrix configuration (.ica file) information for the Citrix server from the hospital’s IT Administrator or biomedical department.

The following is a sample .ica file:

```
[WFCClient]
Version=2
TCPBrowserAddress=<Citrix server IP address>
PersistencyCachePath=\Documents and Settings\test\Application Data\CIClient\cache

[Applicationservers]
MUSE=

[MUSE]
TWIPCODE=on
ADDRESS=MUSE
InitialProgram=MUSE
ClientAudio=off
Compress=on
ScreenPercent=100
DesiredColor=4
TransportDriver=TCP/IP
WinstationDriver=ICA 3.0
```

4. On the Citrix Configuration window, type the configuration information in the applicable fields.

<table>
<thead>
<tr>
<th>Field name on Citrix Configuration window</th>
<th>Field description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>The values as dictated by the Citrix application. The hospital IT Administrator can supply these values.</td>
</tr>
<tr>
<td>Password</td>
<td>This value corresponds to the <code>TcpBrowserAddress</code> in the sample .ica file.</td>
</tr>
<tr>
<td>Server Address</td>
<td>The default value is 10. This value may need to be adjusted during configuration of the Citrix application.</td>
</tr>
<tr>
<td>Startup Time</td>
<td></td>
</tr>
</tbody>
</table>
5. Click Save. Your changes will not take affect until the CIC Pro center is rebooted.

**Configure browser favorites**

**Define browser favorites**

**NOTE**

Before the browser can access internet web addresses (external to the hospital network), a connection for the CARESCAPE Network IX network to the internet is required. Contact the hospital IT Administrator.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. From the multi-patient viewer, click Browser.
3. In the **Please enter a name for this favorite** field, type the name that will identify this website in the browser’s **Favorites** menu.

4. In the **Please enter an IP address or URL (webpage address)** field, type the internet address (IP address) of this website.

5. In the **Please select a favorite type** field, select the option associated with the type of browser favorite this is.

   **NOTE**

   If necessary, click **Reset** to clear the fields and selections in this window and start again.

6. Click **Create Favorite**.

7. Click the link to test the URL of this website.

**Delete a browser favorite**

1. Select **Setup CIC**.

2. Select the **Service Password** tab.

3. In the **Password** field, type `mms_com`.

4. At the command prompt, type `stop` and press **Enter**.

5. Select **Start > Shut Down > Log off cic**.

6. Click **OK** and immediately hold the **Shift** key down until a logon screen appears.

7. In the **User name** field, type **administrator**.

8. In the **Password** field, type `admin1,3,5,7`.

9. Select **OK**.

10. Double-click the **My Computer** icon on the desktop.

11. Navigate to `D:\Documents and Settings\CIC`.

12. Double-click the **Favorites** icon.
13. Right-click the browser favorite you want to delete and click **Delete**.

**Configure set flags settings**

This section describes the procedures required to configure the *set flags* settings:

- Configure the NO COMM alarm setting, if applicable on page 6-23.
- Configure force age setting, if applicable on page 6-24.
- Configure multiviewer alarm audio setting, if applicable on page 6-25.
- Configure ADU alarm audio setting, if applicable on page 6-26.

---

**CAUTION**

OUT-OF-UNIT ALARMS—If the CIC Pro center is configured to alarm for out-of-unit alarms, any patient displayed on that out-of-unit CIC Pro center, and is alarming, can have their alarms silenced from the out-of-unit CIC Pro center.

---

**NOTE**

All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration.

**Configure the NO COMM alarm setting, if applicable**

**NOTE**

For *NO COMM* alarm behaviors, see the CIC Pro Clinical Information Center Operator’s Manual.

**NOTE**

- If the *NO COMM* is set to **DISABLE**, a visual only indicator will appear in the multi-patient viewer window at the CIC Pro center. The clinical user will not receive an audible notification. **DISABLE** is the factory default setting.
- If the *NO COMM* is set to **ENABLE**, the clinical user will receive a crisis level audible notification in addition to a visual *NO COMM* indicator in the multi-patient viewer window.

When enabled, the system shall provide audible indication for *NO COMM* in no more than 188 seconds from a loss of network communication with a monitor.

Complete the following procedure to activate the *NO COMM* alarm on the CIC Pro center:

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Configuration > Set Flags.
NOTE

The *Set Flags Module* screen shows the current set flags settings, which can be modified.

3. In the **NO COMM** field on the *Set Flags Module* screen, click **Enable**.

4. Click **Submit**.

5. Restart the application. See Perform safe restart of the CIC Pro center on page 8-30.

6. Verify the new settings prior to monitoring patients.

**Configure force age setting, if applicable**

If the force age setting is **enabled**, a default age range will *not* be displayed in the *Age* field, and the **New Patient** button will be disabled. If the force age setting is **disabled**, when a patient admit is attempted and no age is selected, a message will prompt the user to enter the patient age. This setting is usually applicable for pediatric care areas.

**NOTE**

All clinical setting values must be received from the GE CAS or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration.

Complete the following procedure to configure the **Force Age** setting on the CIC Pro center:

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click **Configuration > Set Flags**.

**NOTE**

The *Set Flags Module* screen shows the current set flags settings, which can be modified.
3. In the **FORCE AGE** field on the *Set Flags Module* screen, click **Enable**.

4. Click **Submit**.

5. Restart the application. See Perform safe restart of the CIC Pro center on page 8-30.

6. Verify the new settings prior to monitoring patients.

**Configure multiviewer alarm audio setting, if applicable**

This setting is applicable for *mirror* or out of care unit CIC Pro centers. This setting will affect in-unit audible alarming.

**NOTE**

All clinical setting values must be received from the GE CAS or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration.

---

**CAUTION**

OUT-OF-UNIT ALARMS — If the CIC Pro center is configured to alarm for out-of-unit alarms, any patient displayed on that out-of-unit CIC Pro center, and is alarming, can have their alarms silenced from the out-of-unit CIC Pro center.

---

Complete the following procedure to configure the *Multiviewer Alarm Audio* setting on the CIC Pro center:

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click **Configuration > Set Flags**.

**NOTE**

The *Set Flags Module* screen shows the current set flags settings, which can be modified.
3. Change the settings in the **MULTIVIEWER ALARM AUDIO** field as required:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable</strong></td>
<td>Enables audible alarms for any out-of-unit patient displayed in a multi-patient viewer window at the CIC Pro center.</td>
</tr>
<tr>
<td><strong>Disable</strong></td>
<td>Disables audible alarms for any out-of-unit patient displayed in a multi-patient viewer window at the CIC Pro center.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. Restart the application. See **Perform safe restart of the CIC Pro center on page 8-30**.

6. Verify the new settings prior to monitoring patients.

### Configure ADU alarm audio setting, if applicable

**NOTE**

All clinical setting values must be received from the GE CAS or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration.

**CAUTION**

OUT-OF-UNIT ALARMS — If the CIC Pro center is configured to alarm for out-of-unit alarms, any patient displayed on that out-of-unit CIC Pro center, and is alarming, can have their alarms silenced from the out-of-unit CIC Pro center.
**CAUTION**
AUDIBLE ADU ALARMS MAY NOT SOUND—Depending on the configuration of your CIC Pro center, audible ADU alarms may not sound at the CIC Pro center for any in-unit patient beds. Only on-screen ADU alarm indicators display unless the CIC Pro center is configured to also sound audible alarms.

Complete the following procedure to configure the *ADU Alarm Audio* setting on the CIC Pro center:

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click *Configuration > Set Flags*.
   
   **NOTE**
   The *Set Flags Module* screen shows the current set flags settings, which can be modified.

3. Change the settings in the *ADU ALARM AUDIO* field as required:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Enable</em></td>
<td>Enables any ADU buttons audible alarms for any out-of-unit patient displayed in a multi-patient viewer window at the CIC Pro center.</td>
</tr>
<tr>
<td><em>Disable</em></td>
<td>Disables any ADU buttons audible alarms for any out-of-unit patient displayed in a multi-patient viewer window at the CIC Pro center.</td>
</tr>
</tbody>
</table>

4. Click *Submit*.

5. Restart the application. See Perform safe restart of the CIC Pro center on page 8-30.

6. Verify the new settings prior to monitoring patients.
Configure the CIC Pro center language

WARNING
LANGUAGE LOCALIZATION—The CIC Pro center leaves the factory with the CIC Pro center application software set to English. Prior to placing this device into operation, you must set the language to the language required by your region or locale.

Changing to a new language other than English should only be done if the current CIC Pro center application language is set to English. For example, do not set the language to Chinese unless the CIC Pro center is currently set to English. If the CIC Pro center is not currently running in English, then reimage the system, which will default to English and allow you to set the CIC Pro center to the required language.

NOTE
The Webmin interface is always in English.

Complete the following procedure to set the language of the CIC Pro center’s software application:

1. If you are not already logged onto the CIC Pro center as administrator, Log on to the CIC Pro center as Administrator on page 4-3.
2. From the desktop, launch Internet Explorer.
3. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
4. Click Configuration > Language.
5. In the Language field, select the language from the drop-down list.

NOTE
The languages available are: English, French (France), German, Spanish, Portuguese (Brazil), Swedish, Danish, Dutch, Norwegian, Italian, Hungarian, Polish, Czech, Chinese (Simplified), Japanese, and Russian.

6. Click Submit.
7. From the Windows taskbar, click *Start > Shut Down > Restart* and press *Enter*.

8. Wait for the CIC Pro center application window to display. The CIC Pro center should restart normally in the clinical application mode and display in the new language.

## Configure desktop-related settings

### Configure USB laser printers

The CIC Pro center v5.1 running on the MP100 platform supports the following USB printers:

- **HP LaserJet 2430**: Supported as a Plug and Play device; doesn't require any special installation/configuration. See *Configure HP LaserJet 2430 and HP LaserJet P3005 USB printers* on page 6-29.

- **HP LaserJet P3005**: Supported as a Plug and Play device; doesn't require any special installation/configuration. See *Configure HP LaserJet 2430 and HP LaserJet P3005 USB printers* on page 6-29.

- **HP LaserJet P3015**: Not supported as a Plug and Play device; requires special installation/configuration. See *Configure HP LaserJet P3015 USB printers* on page 6-29.

**NOTE**

To use an HP LaserJet 2430, HP LaserJet P3005 or HP LaserJet P3015 as a Network printer, refer to *Configure network laser printers* on page 6-14.

### Configure HP LaserJet 2430 and HP LaserJet P3005 USB printers

MP100 series hardware running CIC Pro center v5.1.x software supports the HP LaserJet 2430 and HP LaserJet P3005 printers as plug and play USB printers. When used as a USB printer, they do not require any special installation. As long as the printer is connected to the CIC Pro center, it is readily available for configuration at the *CIC Setup*.

### Configure HP LaserJet P3015 USB printers

MP100 series hardware running CIC Pro center v5.1.x software supports the HP LaserJet P3015 printer as a plug and play USB printer and as a Network printer. This printer, when used as a USB printer, requires special installation/configuration as described in this section.

1. Log on to the CIC Pro center as Administrator on page 4-3.

2. Power up the printer to be installed.

3. Connect the supplied printer USB cable to the USB port on the printer and then to the USB port on the CIC Pro center.

4. When the *Found New Hardware Wizard* window displays, select *No, not this time* and select *Next* to continue.
5. Select *Install from a list or specific location (Advanced)* and select *Next* to continue.

6. Select *Don’t search. I will choose the driver to install* and select *Next* to continue.

7. Select *DOT4 USB Printing Support* and select *Next* to continue.

8. Select *Finish*. After approximately 2 minutes, the *Found New Hardware Wizard* window will display. This wizard allows the installation of the generic IEEE 1284.4 printing support.

9. Select *Install from a list or specific location (Advanced)* and select *Next* to continue.

10. Select *Don’t search. I will choose the driver to install* and select *Next* to continue.

11. Select *Printers* as the *Hardware type* and select *Next* to continue.

12. Select *HP* as the *Manufacturer* and *HP Universal Printing PS* as the *Printer* and select *Next* to continue.

13. Select *Yes* to the *Update Driver Warning* message. The installation will take a few minutes.

14. When prompted, select *Finish*.

15. From the CIC Pro center desktop, select *Start > Settings > Printers and Faxes*.

16. In the *Printers and Faxes* window, rename the USB printer you just installed as needed to designate it as a USB printer (i.e., HP LaserJet P3015 USB).

### Set the laser printer default paper size

**NOTE**

The CIC Pro center leaves the factory with the default paper size set to 8 x 11 inches (letter).

1. Log on to the CIC Pro center as Administrator on page 4-3.

2. From the Windows taskbar, click *Start > Settings > Control Panel > Printers and Faxes*.

3. In the *Printers and Faxes* window, right-click the printer you want to configure and select *Properties*.

4. On the *Advanced* tab, click *Printing Defaults*.

5. Select *PaperQuality* tab.

6. In the *Paper Size* field, choose the paper size you want to use as the default.

7. Click *OK* until all windows are closed.
Configure a secondary display

The CIC Pro center is already configured to interface with a secondary display. You just need to verify that this interface is working.

Before the secondary display will function correctly with the CIC Pro center, you must make sure all of the installation and configuration preconditions have been met. Then you can verify that the interface to the secondary display is working.

1. If you are configuring a NEC display as a secondary display, then perform the following tasks only after completing Touchscreen calibration using the Touchware application on page 6-35.

2. Verify the secondary display interface is working.
   a. Connect the secondary display (optional) on page 5-14. After restarting the CIC Pro center and turning on the power to the primary and secondary displays, the secondary display should be illuminated and appear grey in color.
   b. From the multi-patient viewer, click Browser. The Browser window should appear in the secondary display.

3. If the Browser window does not appear in the secondary display, complete the following steps to configure the secondary display properties:
   a. Log on to the CIC Pro center as Administrator on page 4-3.
   b. On the desktop, click the right mouse button.
   c. Choose Properties.
   d. In the Display Properties window, click Settings.
e. Click the display 2 icon.

**NOTE**

If required, drag and drop the display icons into the same orientation as the physical setup.

f. Select the *Extend my Windows desktop onto the monitor* option and click *Apply*. The desktop expands onto the secondary monitor.

**NOTE**

The secondary monitor displays a mirror image of the primary monitor display when the *Extend my Windows desktop onto the monitor* option is not checked.

g. Note the *Screen resolution* setting for display 2.

h. Click the display 1 icon. Make sure the *Screen resolution* setting is the same for both displays. The recommended screen resolution is 1280 x 1024.

i. On the *Display Properties* window, click display 2 and then click *Advanced*.

j. Select the *General* tab in the *Plug and Play Monitor and Mobile Intel(R) 945 Express Chipset Family* window.
k. Select the **Apply the new display settings without restarting** option and click **OK**.

l. Click **OK** to close the **Display Properties** window.

m. Perform **Screen calibration on page 6-56**.

### Calibrate a touchscreen display

**Touchscreen display video drivers**

Calibrating a touchscreen display adjusts the accuracy of the touchpoint on the display used to select an item. Touchscreen displays can be used with a CIC Pro center; however, if present, touchscreen calibration is required.

The type of video driver installed on the touchscreen display determines the application you must use to calibrate the touchscreen display. Use the following information to determine the touchscreen capability with the CIC Pro center:
Configuration

Touchscreen calibration using the Elo application

When two USB touchscreen displays (using the Elo video driver) are connected to the CIC Pro center, you will first calibrate the primary display, then the secondary display, and go back and calibrate the primary display again.

When one USB touchscreen display and one serial touchscreen display (both using the Elo video driver) are both connected to the CIC Pro center, you will first calibrate the primary display, then calibrate the secondary display. You do not need to go back and calibrate the primary display as required when using two USB touchscreen displays.

1. Log on to the CIC Pro center as Administrator on page 4-3.
2. From the Windows taskbar, click Start > Settings > Control Panel.
3. Double-click the Elo Touchscreen icon.
4. On the General tab, click Align.
5. Follow the onscreen instructions to touch each of the targets displayed.
6. Tap the screen at different locations and ensure that the cursor moves to the locations tapped.
   a. If the cursor followed your finger, click the green-colored check mark button.
   b. If the cursor did not follow your finger, click the blue-colored arrow button and repeat steps 5 and 6.
7. If a secondary display is connected, complete steps 5 and 6 to calibrate the second touchscreen display.
8. If two USB touchscreen displays are used, you must go back and calibrate the primary touchscreen display again. Repeat steps 5 and 6 to calibrate the primary USB touchscreen display.

Touchscreen display | Model name | Part number | Driver used | Secondary display configuration | Single touchscreen setup | Dual touchscreen setup
--- | --- | --- | --- | --- | --- | ---
19" NEC display | NEC 1980SXi | 2023609-002 | 3M Touchware | Yes | Yes³ | No
20" NEC display | NEC 2080UXi | 2020737-003 | 3M Touchware | Yes | Yes⁴ | No
19" GE medical grade display | CDA19T | 2025280-004 | Elo Touchsystems | Yes | Yes | Yes⁵

¹In a single touchscreen setup, either the primary or the secondary display may be a touchscreen.
²In a dual touchscreen setup, both the primary and the secondary displays are touchscreens.
³The 19" NEC display supports single touch only, even though enough USB ports are available at the CIC Pro center.
⁴The 20" NEC display supports single touch only, even though enough USB ports are available at the CIC Pro center.
⁵The 19" GE medical grade display supports USB and serial COM1 port dual touch.
9. When all of the connected touchscreen displays are calibrated, click OK from the Elo Touchscreen Properties window.

Touchscreen calibration using the Touchware application

**If a single display is connected to the CIC Pro center**

1. If you have a secondary display connected to the CIC Pro center, you must disconnect it before calibrating the primary display.

2. Log on to the CIC Pro center as Administrator on page 4-3.

3. From the Windows desktop, double-click the Calibration icon.

4. Follow the onscreen instructions to touch each of the targets displayed.

5. Click Accept.

6. Click OK.


8. Connect the secondary display to the CIC Pro center.


**Set the time zone**

**NOTE**

To change the time zone, daylight saving time, time-of-day, or the date on a CIC Pro center on a v4.0.x or v4.1.1 software or later, see the CIC Pro Clinical Information Center Service Manual that was provided with your equipment.

**NOTE**

Do not set the time zone until all other configuration steps have been completed. Setting the time zone must be the last step before configuring the clinical settings.

1. Disconnect the CIC Pro center from the CARESCAPE Network IX and MC networks.

2. Log on to the CIC Pro center as Administrator on page 4-3.

3. From the Windows system tray, double-click the (time) icon.

4. On the Date and Time Properties window, click the Time Zone tab.

5. Select the time zone from the drop-down list next to the time zone setting.

**NOTE**

Sri Jayawardenapura time is listed as GMT + 5:30 for CIC Pro center software v5.1.x and GMT + 6:00 for CIC Pro center software v.5.0.x and earlier.
6. Verify the *Automatically adjust clock for daylight saving changes* box is *not* checked.

   ![Date and Time Properties dialog box](image)

   **CAUTION**
   DATA CORRUPTION—Do *not* select the *Automatically adjust clock for daylight saving changes* check box. You must manually make Daylight Saving Time changes in the monitoring system. This change may affect the CARESCAPE Network time and date parameter of some patient data and FD data corruption.

7. Click **Apply** to apply your changes.

   **CAUTION**
   Do *not* make any changes on the *Internet Time* or *Date & Time* tab to change the time. The time change request must be made only from Webmin. Otherwise, the time change request will not be sent to the Time Master.

8. Click **OK** to close the window.

9. Restart the CIC Pro center. From the Windows taskbar, click **Start > Shut Down > Restart** and press **Enter**.

   **CAUTION**
   LOSS OF FULL DISCLOSURE DATA — Failure to reboot the CIC Pro center after changing the time zone results in: 1) The loss of stored full disclosure data. 2) The discontinuance of full disclosure data collection. 3) The inability to access the full disclosure function.

10. Run the Check Centrals utility to ensure that there are no time zone or network errors. See Pre-configuration instructions on page 6-2 for instructions.
Restart CIC Pro center

NOTE

If you have completed Set the time zone on page 6-35, it is not necessary to restart the CIC Pro center again at this point.

Restart the CIC Pro center. From the Windows taskbar, click Start > Shutdown > Restart and press Enter.

Configure clinical application settings

Configure the printer settings

1. If you are printing to a laser printer, configure the print settings for the laser printer:
   b. Set the laser printer default paper size on page 6-30.
   c. Configure the CIC Pro center’s Printer/Writer settings on the CIC Defaults window. See Set the CIC Defaults on page 6-37.

2. If you are printing to the bedside patient monitor’s default printer, verify the correct printer is selected in the Print Window field under Graph Setup on the Telemetry Unit Defaults window. See Set the Telemetry Unit Defaults on page 6-44.

Configure clinical application, telemetry, and care unit settings

This section describes the procedures required to configure the clinical application, telemetry, and care unit settings protected by the Service mode password.

- Set the CIC Defaults on page 6-37.
- Set the Telemetry Unit Defaults on page 6-44.
- Set the full disclosure defaults on page 6-47.
- Set the Display Configuration (non-mirror CIC Pro centers) on page 6-49.
- Set the Current Telemetry Listings on page 6-51.

Set the CIC Defaults

1. From the multi-patient viewer, click Setup CIC.

2. Log on to Setup CIC with service access on page 4-5.
WARNING
QUALIFIED PERSONNEL — The Service mode is intended for use only by qualified personnel with training and experience in its use. The consequences of misuse include loss of alarm configuration, loss of patient data, creation of an unmonitored bed scenario, corruption of the CIC Pro center operating system software, or disruption of the CARESCAPE Network.

3. From the CIC Setup menu, click CIC Defaults.

4. On the CIC Defaults window, make the appropriate changes to the following default settings:
<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Type the central name (up to four characters). Make sure no other central stations have the same central name in the same care unit. All other systems on the GE CARESCAPE Network MC network use the Central name to identify this CIC Pro center system. The central name should be relevant to the location, such as CS2 or SDU3.</td>
</tr>
</tbody>
</table>
| Unit         | **CAUTION**  
LOSS OF DATA — Once the care unit name is programmed, and the CIC Pro center is placed in use, avoid changing the care unit name. Changing the care unit name deletes all full disclosure data and the list of transmitters/transceivers stored on the CIC Pro center. You must re-enter that data after you change the care unit name.  

Select a Unit name from the drop-down list. When entering a Unit name, the following rules apply:  
- All other systems on the CARESCAPE Network MC network use the care Unit name to identify this CIC Pro center. The care unit name should be relevant to the location, such as CCU or ICU1.  
- It is very important to enter the correct care unit name. Be especially careful of the name's spelling.  
- If any other CIC Pro centers are intended to have the same care unit name, make sure the care unit names match exactly.  
- If the care unit name is not displayed in the Unit list, you must type it in. Then press Enter. |
| Mirror Central Display | Set up a mirror image view of a primary CIC Pro center. See Mirror another CIC Pro center on page 6-42. |
| Waveforms    | Set the waveforms you want to display (up to three in addition to the ECG waveform):  
- **ECG1 <From ECG Source>**  
  This waveform data automatically displays from the default ECG source.  
- **Waveform 2 to Waveform 4**  
  Choose to graph subsequent ECG leads. |
| Printer/Writer | Set the default print devices used to print alarm graphs, manual graphs, and full disclosure or flow volume loops data.  
**NOTE**  
- Use a laser printer when the CIC Pro center is interfacing with the Patient Data Server (PDS) or when printing full disclosure reports or flow volume loops information. A digital writer does not print data under these conditions.  
- Full disclosure reports can potentially be very large and take a very long time to print. This can block alarm graphs sent to that printer. As a result, the printer selection list for full disclosure is different from the printer selection list for graphing patient data. The printer selection list may not include printers defined on the CARESCAPE Network IX network.  
- **Laser**: Choose the printer.  
- **DDW**: If a digital writer is connected to the CIC Pro center’s COM2 port, choose **COM2**.  
- **Full Disclosure**: Choose the laser printer. |
### Configuration

#### Alarm Volume

**WARNING**

ALARMS — Do NOT rely exclusively on the audible alarm system for Bedside Monitoring. Adjustment of CIC Pro center alarm volume to a low level or OFF during Bedside Monitoring may result in inability to hear the alarm and a hazard to the patient. Remember that the most reliable method of Bedside Monitoring combines close personal surveillance with correct operation of monitoring equipment.

After connecting the monitor to the central station and/or nurse-alert, verify the function of the alarm system. Repeat this verification periodically, including a check of all connected speakers.

**NOTE**

All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration.

Set the alarm volume for the CIC Pro center.

**NOTE**

The *Minimum* alarm volume can only be set via the Service mode. You can set the *Current* alarm volume to any level above the *Minimum* via the user or Service mode.

All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration.

- **Current**: Choose any value from the *Minimum* alarm volume setting or above. This *Current* alarm volume setting determines the actual alarm volume.
- **Minimum**: Choose the minimum alarm volume level. The minimum alarm volume in user mode cannot be adjusted below this set value.

<table>
<thead>
<tr>
<th>Real-Time Trend Graph Configuration</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable or disable the display of real-time trend windows in the multi-patient viewer. The real-time trend window displays the recent patient trends for a maximum of two parameters in a graph format. You can configure the Real-Time Graph for each patient while in user mode only.</td>
<td></td>
</tr>
</tbody>
</table>

To enable the display of the real-time trend windows in the multi-patient viewer, click the **Display Real-Time Trend Graph** checkbox.
**Configuration**

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alarms OFF Selection</strong></td>
<td><strong>WARNING</strong> ALARMS — Do NOT rely exclusively on the audible alarm system for Bedside Monitoring. Adjustment of CIC Pro center alarm volume to a low level or OFF during Bedside Monitoring may result in inability to hear the alarm and a hazard to the patient. Remember that the most reliable method of Bedside Monitoring combines close personal surveillance with correct operation of monitoring equipment. After connecting the monitor to the central station and/or nurse-alert, verify the function of the alarm system. Repeat this verification periodically, including a check of all connected speakers.</td>
</tr>
</tbody>
</table>
|                                       | **NOTE** All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration. Set the alarm behaviors for telemetry alarms and for arrhythmia detection. **Yes**: Allow the clinician to:  
  ♦ Turn off a monitored telemetry patient’s alarms via Monitor Setup > Alarm Control > Alarms On/Off.  
  ♦ Turn off a monitored patient’s ECG arrhythmia detection via Monitor Setup > ECG > Arrhythmia.**  
|                                       | **No**: Do not allow the clinician to be able to turn off a monitored patient’s telemetry alarms or ECG arrhythmia detection.  
|                                       | **NOTE** The **Alarms OFF Selection** affects two areas of live patient monitoring:  
  ♦ The ability to turn off alarms for a selected telemetry patient while in user mode.  
  ♦ The ability to turn off arrhythmia detection for a selected patient while in user mode.  
| **Real-Time BP/NIBP UOM Selection**   | **NOTE** This option is only available on CIC Pro centers running software v5.0.6 or later configured for the Chinese language. Pressure values may be displayed in kPa when configured for the Chinese language. This option will be displayed in the Chinese language when the CIC Pro center is configured for the Chinese language. Set the unit-of-measure for pressures value display:  
  ♦ mmHg  
  ♦ kPa  
|                                       | To set the pressures value, see (Chinese only) Set the pressures unit-of-measure on page 6-54.  
| **Color Set**                         | Set the color scheme for waveforms. The preset choices are: Clinical, Transducer, or Custom. **NOTE**  
  ♦ When you choose Custom, you can select colors for each of the fourteen waveform types individually.  
  ♦ When you choose either Clinical or Transducer, access to the color palettes for individual waveforms is disabled.  
  ♦ Clinical: Set the colors for single-parameter or double-parameter patient monitoring. ECG waveforms display in orange; ART, PA, FEM, CVP, RA, LA, ICP, SP, UAC, and UVC display in green, and RESP, SPO2, and CO2 display in blue.  
  ♦ Transducer: Set the colors for multi-parameter patient monitoring. ECG displays in brown, ART displays in red, PA displays in yellow, FEM displays in red, CVP and RA display in blue, LA and ICP display in white, SP displays in green, UAC displays in red, UVC displays in blue, RESP and SPO2 display in green, and CO2 displays in white.  
  ♦ Custom: Set each waveform color individually. To set custom default waveform colors, click the down arrow next to the parameter waveform color you want to change. Then, click on the desired color for each parameter.  

---

2026419-130B CIC Pro™ 6-41
5. After making your selections, choose one of the following:
   - Click OK or Cancel to apply your changes and close the CIC Setup window.
   - Click Apply to apply your changes without closing the CIC Setup window.

6. Verify the new settings prior to monitoring patients.

Mirror another CIC Pro center

Mirroring rules

---

**WARNING**
A single primary CIC Pro center can support up to two CIC Pro centers configured as mirrors.

---

**CAUTION**
LOSS OF MONITORING — Use caution when configuring a mirror CIC Pro center. Since changes at a mirror CIC Pro center can affect patient monitoring at the primary CIC Pro center, there may be an inadvertent loss of patient monitoring at the primary CIC Pro center.

---

You can set up a mirror CIC Pro center for remote viewing/monitoring. Mirror configuration is done in Service mode. Changes made on the primary CIC Pro center are not always made at the mirror CIC Pro center. When a mirror CIC Pro center is configured, the following behavioral rules apply:

- It is recommended that the mirror CIC Pro center license set quantity is equal to the number of bed/view licenses on the primary CIC Pro center. If there is a quantity mismatch on the mirror CIC Pro center, an error message is displayed stating that there are not enough display licenses.
- The title bar of the mirror CIC Pro center displays *mirror of [CIC SELECTED]*.
- The mirror CIC Pro center and the primary CIC Pro center must be at the same software version.
- The user cannot change the display configuration on the mirror CIC Pro center.
- *Auto Display* is disabled at the mirror CIC Pro center. However, it is still active on the primary CIC Pro center. You must click Setup CIC > Display Configuration > Disable Auto Display at the primary CIC Pro center.
- If the user selects new parameters or colors to view on one display, that view is not mirrored on the other display.
- All other CIC Pro center functionality is unaffected.

Set up a mirror CIC Pro center

**NOTE**
Perform the following procedure only if you have a sufficient number of mirror license sets. See Mirroring rules on page 6-42.

Complete the following procedure to set up a mirror CIC Pro center:
1. From the multi-patient viewer, click **Setup CIC**.

2. Log on to Setup CIC with service access on page 4-5.

3. At the remote CIC Pro center (mirroring the primary CIC Pro center), click **Setup CIC > Display Configuration**.

   **NOTE**

   *Auto Display* is disabled on the remote CIC Pro center. However, it is still active on the primary CIC Pro center.

4. Click the **Disable Auto Display Button** checkbox in the **Auto Display Button** section of the **Display Configuration** tab.

5. Verify all the **Display Configuration** settings are the same for the primary and remote CIC Pro centers.

6. Set the **Columns** and **Rows** in the **Display Configuration** tab of the remote CIC Pro center to match the primary CIC Pro center.

7. Click **CIC Defaults**.

8. From the **Mirror Central Display** drop-down list, choose the primary CIC Pro center you want mirrored on the remote CIC Pro center.

9. Check the title bar on the remote CIC Pro center to verify that it is mirroring the correct CIC Pro center.
10. Click **Apply** to apply your changes without closing the *CIC Setup* window.

11. Confirm proper operation of the mirror CIC Pro center and the primary CIC Pro center by completing the appropriate checkout procedures. See Configuration checkout procedures on page 7-3.

**Set the Telemetry Unit Defaults**

This option sets telemetry unit default settings. In user mode, all of the controls on the *Telemetry Unit Defaults* tab are view-only. You must be in the Service mode to set the Telemetry Unit Defaults at the CIC Pro center.

**NOTE**

For more information on setting Telemetry Unit Defaults, refer to the telemetry system’s operator manual.

Complete the following procedure to configure the Telemetry Unit Defaults settings:

1. From the multi-patient viewer, click **Setup CIC**.
2. Log on to Setup CIC with service access on page 4-5.
3. Click **Telemetry Unit Defaults**.

4. On the *Telemetry Units Defaults* tab, change the settings as needed:
NOTE

When changing the Graph Setup options for admitted patients, the changes do not take effect until the patients are discharged. Temporary changes may be made for a specific patient via the single patient viewer > Monitor Setup > Graph Setup.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Location for this CIC</td>
<td>Set the print location for telemetry bed patient data:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Manual</strong>: Designate the default manual graph location for telemetry patients.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Alarm</strong>: Designate the default alarm graph location for telemetry patients.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Print Window</strong>: Designate the default print window location for telemetry patients.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>These default locations are only used for telemetry beds and determine where patient data prints for either manual or alarm conditions. Since a telemetry patient is not linked to a patient monitor, these defaults are necessary to specify the destination for alarm and manual graph printouts.</td>
</tr>
</tbody>
</table>

**Waveforms**

Designate the primary ECG lead for printing and enable or disable printing from subsequent ECG leads.

- **ECG 1**: Designate the primary ECG lead for printing.
- **Waveform 2 to Waveform 4**: Choose other ECG leads to print or choose **OFF** to disable printing an ECG lead.

**Transmitter Graph**

Turn transmitter graph printing on or off.

**Alarm Graph**

Turn alarm graph printing on or off.

**Event Marker Graph**

Turn event marker graph printing on or off.

**Display Lead**

Set the primary ECG lead for display in the patient’s waveform window.

**Arrhythmia**

Enable or disable an arrhythmia analysis program.

**Lead Analysis**

Designate **Single-Lead** or **Multi-Lead** analysis for ECG and arrhythmia analysis.

**ST Analysis**

Enable or disable ST analysis.

**Va Lead**

**Vb Lead**

**Va Lead/Vb Lead**: Set the default for the V leads that will be monitored in these positions. A 6-lead cable is required for multiple V-lead monitoring.

**Detect Pace**

Enable or disable pacer detection.

**Patient Age**

Set patient age.

**Transmitter Alarm Pause**

Turn transmitter alarm pausing on or off.

**Alarm Pause Breakthrough**

Turn transmitter alarm pause breakthrough on or off.

**Event Marker**

Turn event marker alert on or off.

5. After making your selections, choose one of the following:
   - Click **OK** to apply your changes and close the CIC Setup window.
   - Click **Apply** to apply your changes without closing the CIC Setup window.

6. Verify the new settings prior to monitoring patients.
Set the Telemetry Alarm Control Defaults

This option sets the telemetry default alarm limits and alarm level settings. In user mode, all of the controls on the Telemetry Alarm Control Defaults tab are view-only. You must be in the Service mode to set the Telemetry Unit Defaults at the CIC Pro center.

NOTE

For more information on setting Telemetry Alarm Control Defaults, refer to the telemetry system’s operator manual.

Complete the following procedure to configure the Telemetry Alarm Control Defaults settings:

1. From the multi-patient viewer, click Setup CIC.
2. Log on to Setup CIC with service access on page 4-5.
3. From the CIC Setup screen, click Telemetry Alarm Controls Defaults.
4. On the Telemetry Alarm Control Defaults tab, change the settings as needed:
After making your selections, choose one of the following:

- Click **OK** to apply your changes and close the *CIC Setup* window.
- Click **Apply** to apply your changes without closing the *CIC Setup* window.

Verify the new settings prior to monitoring patients.

**Full disclosure license management setup**

**Overview**

Every CIC Pro center with v4.0.x or later software has the ability to store 16 beds of full disclosure data for one hour without a license. A CIC Pro center with the full disclosure option has the ability to store up to 16 beds for 72 hours with the appropriate licenses and license settings.

When operating two CIC Pro centers within the same care unit, with one having the full disclosure option, and the other without: It is necessary to turn full disclosure OFF on the CIC Pro center without the full disclosure option, to prevent a conflict between the two different storage capacities of the CIC Pro centers.

To turn off full disclosure on the CIC Pro center without the full disclosure option, you must set the full disclosure License type to none. See Set the full disclosure defaults on page 6-47.

Full disclosure is a distributed sub-system for CIC Pro centers in the care area. As such, it is advisable that all CIC Pro centers in the care area be at the same revision. It is recommended that the CIC Pro center with the highest software version in the care unit be assigned as the full disclosure master. See CIC Pro center master and full disclosure on page 2-15 for further details.

**Set the full disclosure defaults**

This option sets the full disclosure settings. In user mode, only the full disclosure Report and Strip settings are configurable. You must be in the Service mode to set the other full disclosure settings at the CIC Pro center.

Complete the following procedure to configure the Full Disclosure Defaults settings:

1. From the multi-patient viewer, click **Setup CIC**.
2. Log on to Setup CIC with service access on page 4-5.
3. From the CIC Setup screen, click Full Disclosure Defaults.

![Configuration Screen](image)

4. On the Full Disclosure Defaults tab, change the settings as needed:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report: Duration</strong></td>
<td>Designate how much data is included in the report. The maximum report duration is 72 hours, depending upon licensing.</td>
</tr>
<tr>
<td></td>
<td>To set the report duration, move the scroll bar to the left for shorter duration or to the right for longer duration.</td>
</tr>
<tr>
<td><strong>Report: Hole Location</strong></td>
<td>Provide space for binding printed reports.</td>
</tr>
<tr>
<td><strong>Include</strong></td>
<td>Set print characteristics. You may set any or none of these options.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Graybar</strong>: Display every other line of the report on a shaded background to provide visual differentiation from other lines.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Arrhythmia Annotations</strong>: Display the name of an applicable arrhythmia call underneath its occurrence in the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Heart Rate</strong>: Display the last active heart rate included in the report appears at the end of the report line.</td>
</tr>
<tr>
<td><strong>Line Time</strong></td>
<td>Designate how much data shows on an individual report line.</td>
</tr>
<tr>
<td><strong>Strip: Duration</strong></td>
<td>Designate how much data is included in the strip. The maximum strip duration is 60 minutes.</td>
</tr>
<tr>
<td></td>
<td>To set the strip duration, move the scroll bar to the left for shorter duration or to the right for longer duration.</td>
</tr>
<tr>
<td><strong>Strip: Hole Location</strong></td>
<td>Provides space for binding printed report strips.</td>
</tr>
</tbody>
</table>
5. After making your selections, choose one of the following:
   - Click OK to apply your changes and close the CIC Setup window.
   - Click Apply to apply your changes without closing the CIC Setup window.

6. Verify the new settings prior to monitoring patients.

Set the Display Configuration (non-mirror CIC Pro centers)

The Display Configuration tab allows you to format the CIC Pro center’s multi-patient viewer with the required number of patient windows.

The amount of displayed patient data is dependent on the total number of patient windows displayed in the multi-patient viewer. It is also dependent on the Auto Display Button settings on the Display Configuration tab (e.g., Maximizing the Waveform Length or Maximizing the Number of Waveforms).

Modifications to Display Configuration are subject to licensing restrictions. Licensing determines the number of beds displayed on the CIC Pro center screen. Modifying the display to show more than the licensed number of beds will result in blank slots in the display.

NOTE

You must remove admitted beds from the display before you can select a Display Configuration that would eliminate those patient slots from the display. In the multi-patient viewer, right-click on the patient bed you want to remove and choose Select Care Unit then Bed Number > None.
NOTE

An alarm will sound when removing admitted beds from the display if the beds are not viewed on another CIC Pro center.

Complete the following procedure to configure the Display Configuration settings:

1. From the multi-patient viewer, click Setup CIC.
2. Log on to Setup CIC with service access on page 4-5.
3. On the CIC Setup screen, click Display Configuration.

4. On the Display Configuration tab, change the settings as needed:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Set the number of columns of patient windows displayed in the multi-patient viewer.</td>
</tr>
<tr>
<td>Rows</td>
<td>Set the number of rows of patient windows displayed in the multi-patient viewer.</td>
</tr>
<tr>
<td>Screen Calibration</td>
<td>Display the Screen Calibration window used for adjusting the displayed waveform gain and sweep speed of non-touchscreen displays. See Screen calibration on page 6-56.</td>
</tr>
</tbody>
</table>
5. After making your selections, choose one of the following:
   - Click **OK** to apply your changes and close the **CIC Setup** window.
   - Click **Apply** to apply your changes without closing the **CIC Setup** window.

6. Verify the new settings prior to monitoring patients.

### Set the Current Telemetry Listings

**NOTE**

Setting *Current Telemetry Listings* should only be done after the CIC Pro center name and computer name have been configured.

**NOTE**

Telemetry beds are distinguished from monitoring beds by an asterisk appended to the end of the bed number.

Complete the following procedure to configure the *Current Telemetry Listings* settings:

1. From the multi-patient viewer, click **Setup CIC**.
2. Log on to Setup CIC with service access on page 4-5.
3. From the **CIC Setup** screen, click **Current Telemetry Listings**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto Display Button</strong></td>
<td>Configure the <strong>Auto Display</strong> button:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Maximize Waveform Length</strong>: Maximizes the duration of displayed waveforms.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Maximize Number of Waveforms</strong>: Maximizes the number of displayed waveforms.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Disable Auto Display Button</strong>: Removes the <strong>Auto Display</strong> button from the multi-patient viewer menu bar and prevents the use of this function.</td>
</tr>
</tbody>
</table>

When enabled, the **Auto Display** button is selectable from the CIC Pro center's menu bar. Clicking the **Auto Display** button while viewing the multi-patient viewer can automatically complete the following tasks:

- Remove any unoccupied display slots.
- Add at least one empty patient window with an **Admit** button.
- Resize the remaining patient windows to maximize the amount of displayed patient data.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter Font Setup</strong></td>
<td>Designate the font color and font size of the parameter numeric data displayed in the multi-patient and single patient viewers:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Apply Color Set to Parameter</strong>: When enabled, apply the same parameter waveform color to the numeric parameter text. When disabled, the numeric parameter text will be white in color.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Standard Font</strong>: Display parameter numeric data in a smaller font size.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Large Font</strong>: Display parameter numeric data in a larger font size.</td>
</tr>
</tbody>
</table>
4. On the **Current Telemetry Listings** tab, change the settings as needed:
To add a new hardwire bed, telemetry bed, or telemetry transmitter/transceiver, complete the following tasks:

a. Click inside the blank box at the top of the list.

b. Press Enter to add the entry to the list.

To change an existing hardwire bed, telemetry bed, or telemetry transmitter/transceiver, complete the following tasks:

a. Use the scroll bar to locate the item you want to change.

b. Click on the item to display an editing window.

c. Press Enter to add the entry to the list.

After making your selections, complete one of the following tasks:

- Click OK to apply your changes and close the CIC Setup window.
- Click Apply to apply your changes without closing the CIC Setup window.

Verify the new settings prior to monitoring patients.
Set up locked beds

When logged into the Service mode, the CIC Pro center can be configured with the bed names either in locked or unlocked mode. When locked, the bed name is permanently allocated to a particular slot on the CIC Pro center and users are unable to move the bed to another slot.

**WARNING**
QUALIFIED PERSONNEL — The Service mode is intended for use only by qualified personnel with training and experience in its use. The consequences of misuse include loss of alarm configuration, loss of patient data, creation of an unmonitored bed scenario, corruption of the CIC Pro center operating system software, or disruption of the CAREScape Network.

**NOTE**
It is possible to admit a patient to a window with a bed name that is locked to NONE. To avoid duplication of patient waveforms, a window locked as NONE should not be used to admit a patient.

Complete the following procedure to lock or unlock a bed:
1. From the multi-patient viewer, click **Setup CIC**.
2. Log on to Setup CIC with service access on page 4-5.
3. Position the mouse pointer in the patient’s waveform window and right-click.
4. Click to choose either **LOCK** or **UNLOCK**. The change takes effect immediately.

**(Chinese only) Set the pressures unit-of-measure**

**NOTE**
This option is only available on CIC Pro centers running software v5.0.6 or later configured for the Chinese language. Pressure values may be displayed in kPa when configured for the Chinese language.

Complete the following procedure to set up the pressures values to display in kPa.
1. On the **CIC Setup** screen, click **CIC Defaults**. The default pressures value is **mmHg**.
2. On the **CIC Defaults** window under *Real-Time BP/NIBP UOM Selection*, select *kPa*.

3. Click **Apply** to apply your changes without closing the **CIC Setup** window. The pressure value now displays in kPa.
Screen calibration

CAUTION
When using a video splitter with the CIC Pro center, screen calibration may be possible with only one of the monitors connected to the splitter. This is because changing calibration for one monitor will effect the calibration of all other monitors connected to that same splitter.

When using monitors connected to a splitter, only the last monitor calibrated will have proper calibration. Manual measurements should be made from that monitor only.

NOTE
Screen calibration should be performed every time a monitor is installed or serviced.

NOTE
If two displays are connected to the CIC Pro center, complete the screen calibration on the primary display first, then the secondary display.

Calibrating the display screen adjusts the waveform gain and sweep speed to ensure the displayed sweep speed is accurate.

A flexible clear plastic ruler calibrated in inches and centimeters is recommended for this procedure.

1. From the multi-patient viewer, click *Setup CIC*.
2. Log on to Setup CIC with service access on page 4-5.
3. On the *CIC Setup* screen, click *Display Configuration*. 
4. Under *Screen Calibration*, click *Begin Calibration*. The *Screen Calibration* window displays on the primary display and also the secondary display, if present.
5. In the **Units** field, choose *Inches* or *Centimeters* as the unit of measurement you are calibrating to.

6. Click **Default** to set the display to the default resolution.

7. Hold your ruler horizontally across the computer screen, aligning the zero mark of your ruler with the horizontal zero mark of the screen ruler.

8. Position the cursor on the screen ruler. Click and drag the screen ruler as required until the calibration marks of the screen ruler match the calibration marks of your ruler, and then release the mouse button.

9. Repeat this procedure to calibrate the vertical screen ruler.

**NOTE**

The **Maintain Aspect Ratio** option allows you to adjust both screen rulers simultaneously. However, because of differences in monitors and screen resolution, it is recommended that each ruler be adjusted separately. Therefore, this option should be unchecked.

10. When finished, click **Apply** to apply your changes without closing the **CIC Setup** window.

11. Repeat steps 5 through 10 for the secondary display, if present.

**Browser configuration**

This section describes the procedures required to configure the browser:
Define the Internet options on page 6-59.
Define browser favorites on page 6-21.

Navigate the browser

The following table identifies the icons you use to navigate the *Browser* window:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Previous" /></td>
<td>Return to previous (cached) webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Next" /></td>
<td>Advance to next (cached) webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stop the webpage loading process.</td>
</tr>
<tr>
<td><img src="image" alt="Reload" /></td>
<td>Reload the current webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Home" /></td>
<td>Go to the home webpage. To set a home page, see Define the Internet options on page 6-59.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print the current webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Options" /></td>
<td>Configure the internet options for the CIC Pro center. See Define the Internet options on page 6-59.</td>
</tr>
<tr>
<td><img src="image" alt="Favorites" /></td>
<td>View the list of webpage shortcuts (favorites) displayed on the right side of the browser. To change the list of displayed favorites, see Define browser favorites on page 6-21.</td>
</tr>
</tbody>
</table>

Define the Internet options

---

**WARNING**

QUALIFIED PERSONNEL — The Service mode is intended for use only by qualified personnel with training and experience in its use. The consequences of misuse include loss of alarm configuration, loss of patient data, creation of an unmonitored bed scenario, corruption of the CIC Pro center operating system software, or disruption of the CARESCAPE Network.
WARNING
LOSS OF MONITORING — If the browser function is inappropriately used, loss of monitoring function may result. Use alternate monitoring devices or close patient observation until the monitoring function at the CIC Pro center is restored.

When using the browser, follow these restrictions:

- Do not attempt to access the file systems of the CIC Pro center through the use of the browser.
- Do not attempt to download files of any type. This includes, but is not limited to, audio or video files.

1. Log on to Setup CIC with service access on page 4-5.
2. From the multi-patient viewer, click Browser.
3. Click the Internet Properties icon to display the Internet Properties window.

NOTE

The internet options icon will not be selectable unless you first log on to the CIC Pro center in the clinical application mode. See Log on to Setup CIC with service access on page 4-5.

4. In the Home page Address field, enter the internet address you want for your browser home page, or select Use Blank. Click OK.
NOTE

When Internet Explorer starts, the browser displays the specified Home Page.

5. Click the Connections tab.

6. Under Local Area Network (LAN) settings, click LAN Settings.
7. Enter the *Automatic configuration* script or *Proxy server* address and port according to the hospital IT Administrator. Click **OK**.

8. Under *Automatic Configuration*, uncheck *Automatically detect settings* and check *Use automatic configuration script options*.

9. Click **OK** to close the *Local Area Network (LAN) settings* window.

10. Click **OK** again to close the *Internet Properties* window.

11. Confirm proper operation of the browser and the CARESCAPE Network by completing the respective checkout procedures, Check the hospital intranet browser functionality on page 7-7, Check access to all other care units on page 7-6, and Check full disclosure report printing on page 7-9.

### Configure customized groupings

You can configure customized groups of parameters for viewing patient data.

**NOTE**

- You can delete the default groups.
- You can configure up to 12 custom groupings for patient data.

### Set up custom groupings for graphic trends

1. Log on to Setup CIC with service access on page 4-5.

2. From the multi-patient viewer, select any patient window.

3. Click *Patient Data*.

4. Click *Graphic Trends*. 
5. In the upper-right corner of the single patient viewer, click .

6. From the Customize Graphic Trends menu, click .

7. Using the onscreen or external keyboard, enter the name of the custom view (up to 10 characters) and click Enter. The name of the custom view is displayed under Groups on the Customize Graphic Trends menu.
8. From the Customize Graphic Trends menu:
   a. Under 1 Select parameter, select the parameter label that you want to change.
   b. Under 2 Choose action, click Change.
9. On the Select Parameters popup window, select the appropriate parameter, and click Close.
10. Repeat steps 8 and 9 for the remaining parameters.

**NOTE**
- In split screen or on a single display, you can configure up to 6 parameters.
- In full screen or on a secondary display, you can configure up to 12 parameters.
11. When you have finished configuring groups, click Close on the Customize Graphic Trends window.
12. Verify the new settings prior to monitoring patients.
Set up custom groupings for vital signs

1. Log on to Setup CIC with service access on page 4-5.
2. From the multi-patient viewer, select any patient window.
3. Click Patient Data.
4. Click Vital Signs.
5. In the upper-right corner of the single patient viewer, click .
6. From the Customize Vital Signs menu, click .
7. Using the onscreen or external keyboard, enter the name of the custom view (up to 10 characters) and click Enter. The name of the custom view is displayed under Groups on the Customize Vital Signs menu.
8. Reposition the parameters in the list as needed:
   a. Under Order on the Customize Vital Signs menu, highlight the parameter you want to move to a new position.
   b. Under Change Order, click the up or down arrow to move the parameter up or down in the list.

9. Repeat step 8 to reposition the remaining parameters.

10. When you finish the configuration, click Close on the Customize Vital Signs menu.

11. Verify the new settings prior to monitoring patients.

**Configure shortcuts to favorite CIC Pro center views**

**NOTE**
- You can configure up to eight shortcut buttons for favorite CIC Pro center views when in dual display mode (primary and secondary displays are connected/configured with a CIC Pro center).
- You can configure up to two shortcut buttons for favorite CIC Pro center views when in single display mode.

1. Log on to Setup CIC with service access on page 4-5.

2. From the multi-patient viewer, select any patient window.

3. Select the layout of your favorite review screen (e.g., graphic trends, vital signs, full disclosure, etc.), and click Save as Favorite.
4. In the popup window, type the text (up to 10 characters) that should appear on the shortcut button, and click **OK**.

5. Verify the new settings prior to monitoring patients.
Configure the print location settings for stored patient data

Overview

You can configure specific categories of non-real-time patient data to print to a local laser printer or to the bedside patient monitor’s current Print Window configuration. You can also prevent non-real-time patient data from being printed by disabling the CIC Pro center’s menu bar print button.

NOTE

- The patient data categories available to print are determined by the licensed features and functions activated on your CIC Pro center.
- You must configure the laser printer and bedside monitor print settings before you can configure the print location of the patient data categories.
- The bedside monitor only prints the categories of patient data it supports.
- Consult with your CAS or hospital staff about the use of this function and if it should be used with your configuration.

Configure the print location settings for the patient data categories

1. Make sure the print settings are configured for the laser printer and bedside patient monitor’s default printer.

2. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

3. Click Configuration > Printers > Config Func Location.

NOTE

When configuring printing for Graphic Trends, do not use Bedside Determined. Use Local Laser. This will use the local CIC Pro center laser printer and print in landscape mode. Using Bedside Determined for Graphic Trends prints in portrait mode but not all time ranges work in portrait mode. The Graphic Trends time ranges are the choices in the dropdown menu (e.g. 12hr, 4hrs, 24hrs, etc.).
4. For each patient data category, select the appropriate option. Refer to the following table.

<table>
<thead>
<tr>
<th>Patient data category</th>
<th>Selection/outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Laser</td>
<td>Bedside Determined(^1)</td>
</tr>
<tr>
<td><strong>Alarm Control</strong></td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Calipers/FD Report/FD Strip</strong></td>
<td>The print button is enabled. The CIC Pro center application prints to the Full Disclosure printer location as configured in CIC Setup. N/A</td>
</tr>
<tr>
<td><strong>Event Directory</strong></td>
<td>The two printer buttons point to the Laser Printer location as configured in CIC Setup. The two printer buttons point to the printer set up at the Print Window location under Graph Setup.</td>
</tr>
<tr>
<td><strong>Event Strip/Graphic Trends/Vital Signs</strong></td>
<td>The printer button points to the Laser printer location as configured in CIC Setup. The printer button points to the printer set up at the Print Window location under Graph Setup.</td>
</tr>
</tbody>
</table>

\(^1\)Depending on the CIC Pro center’s network configuration and the patient data category selected to print, some bedside monitors will ignore their Print Window configuration settings. As a result, the requested patient data will not print.

5. Click **Apply** to apply your changes.

**NOTE**

Any changes to Setup CIC printer settings will be overwritten with any printer settings made in Webmin.

**Set the time-of-day or the date**

**CAUTION**

NETWORK DEVICE TIME SYNCRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time used by the existing devices on the CARESCAPE Network.
CAUTION
RESTART AFTER ADVANCING THE TIME SETTING — When advancing the time 72 hours or greater, you must restart the CIC Pro center to continue collecting full disclosure data. If you do not restart the CIC Pro center, full disclosure data collection stops and it may also cause other data integrity and CIC Pro center performance issues.

All the CIC Pro centers connected to the CARESCAPE Network IX and MC networks must all use the same time zone setting. Before making any changes to the time zone, time-of-day, or the date settings, you must make sure the time zone and Daylight Saving time (DST) settings match for all of the CIC Pro centers on the CARESCAPE Network.

NOTE
To change the time zone, daylight saving time, time-of-day, or the date on a CIC Pro center using v4.0.x or v4.1.1 software or later, see the CIC Pro Clinical Information Center Service Manual that was provided with your equipment. Use the Check Centrals utility. See Pre-configuration instructions on page 6-2.

This section describes the procedures required to set the time and date of a CIC Pro center using v5.1.x software or later.

1. If you need to change the time zone or daylight saving time (DST) settings, be sure to change the time zone and DST settings before you change the time-of-day or the date settings.

2. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

3. Click Configuration > Time Date.

4. On the Time Date window, make the applicable selections:
   a. In the Date field, choose the date from the drop-down list.
   b. In the Month field, choose the month from the drop-down list.
   c. In the Year field, choose the year from the drop-down list.
   d. In the Time field, choose the appropriate time-of-day (hours:minutes:seconds) from the drop-down lists.

5. Click Change Time to update your changes.
If this CIC Pro center v5.1.x is the Time Master on the CARESCAPE Network:

If this CIC Pro center v5.1.x is not the Time Master on the CARESCAPE Network:

<table>
<thead>
<tr>
<th>If this CIC Pro center v5.1.x is the Time Master on the CARESCAPE Network:</th>
<th>If this CIC Pro center v5.1.x is not the Time Master on the CARESCAPE Network:</th>
</tr>
</thead>
<tbody>
<tr>
<td>While changing time using Webmin, please note that only 3 time changes will be allowed every 10 minutes.</td>
<td>While changing time using Webmin, please note that only 6 time changes will be allowed every 10 minutes.</td>
</tr>
</tbody>
</table>

The 10-minute window is a rolling window; therefore, if no new time change is attempted, the user will be able to change time again after 10 minutes.

Exceeding the number of permitted time changes does not result in any user notification; the system simply ignores the time change request. However, an entry is made into the CIC Pro center log files indicating the reason the time change request was ignored.
Configuration

Back up and restore the CIC Pro center configuration

**NOTE**

The backup and restore procedure must only be completed from a remote computer.

**NOTE**

The backup portion of this section should be performed at regular intervals, whenever changes are made to CIC Pro center configuration settings, and after each preventative maintenance is performed. Regular backups ensure a complete system restore if it should become necessary.

You can back up and restore the following:

- Care unit defaults. See page 6-72.
- Custom defaults. See page 6-76.

Back up care unit default configuration settings

**NOTE**

The real-time trend graph setting is not saved during backup. It must be restored manually.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface remotely via the CARESCAPE network IX network on page 4-7.

2. Click *Configuration > Backup/Restore > Unit Defaults*.

3. Click *Backup*. The default files are temporarily written to the CIC Pro center and are prepared for downloading to your local computer.
4. Right-click the cic_xxxxxxxxxx.cfd link and select **Save Target As** to save the backup file.

**Planning your care unit defaults restore strategy**

**NOTE**

Understand the functionality as described below before you proceed with the restore procedure.

**NOTE**

The real-time trend graph setting is not saved during backup. It must be restored manually.

When planning a restore strategy in a care unit running more than one CIC Pro center, it is important to know that when a CIC Pro center starts up, it will update some of its configuration data to match any other CIC Pro centers it finds on the care unit network. The exact data that is automatically updated in this fashion is shown in **Data module detail on page B-2**.

In general, this would be data common to the care unit that should be consistent between all the CIC Pro centers within that care unit. All other configuration data is specific to the local CIC Pro center only, and is not shared between the CIC Pro centers in the care unit.

See the following scenarios for information about how this automatic update impacts the backup and restoration process of a CIC Pro center.

- **Scenario 1: Restore a CIC Pro center in a care unit running only one CIC Pro center on page 6-73**
- **Scenario 2: Add or upgrade a CIC Pro center in a care unit running multiple CIC Pro centers on page 6-75**
- **Scenario 3: Restore multiple CIC Pro centers in a care unit to a previous configuration on page 6-75**

**Scenario 1: Restore a CIC Pro center in a care unit running only one CIC Pro center**

In this situation, automatic update does not occur, and is not a factor. All configuration data written to the CIC Pro center during the restoration process remains intact, since no other CIC Pro centers exist to trigger an automatic update.
NOTE

The CIC Pro center application must be stopped in order to perform a restore. Because configuration data is automatically updated to match other CIC Pro centers found running on the care unit, if other CIC Pro centers are left running, when the restored CIC Pro center application starts back up, some configuration data would be overwritten by the automatic update.

When you are restoring a CIC Pro center with an existing backup file, the restored CIC Pro center will be assigned the same unit name and CIC name. Therefore, you must be careful to edit the unit name while the restored CIC Pro center is disconnected from the network.

1. Stop the CIC Pro center application.
   a. From the multi-patient viewer, click Service Password.
   b. Click the Service Password tab.
   c. Type mms_com as the password and press Enter.
   d. At the Windows command line prompt, type stop and press Enter.

2. Disconnect the CIC Pro center from the CARESCAPE Network IX and MC networks.

3. Connect a service PC directly to the CIC Pro center and Log on to the Webmin service interface remotely via the CARESCAPE network IX network on page 47.

4. Click Configuration > Backup/Restore > Unit Defaults.

5. Click Browse to select a backup file from the service PC/remote computer.

6. On the Choose file window, navigate to the directory where a file from a previous backup was saved.

7. Select the backup file, and click Open. The backup file location displays in the Browse field.

8. Click Upload. The CIC Pro center uploads this backup file. After the restore is complete, the message, Unit defaults have been restored, is displayed.

9. Click Logout to exit the Webmin application.

10. Restart the CIC Pro center application on this CIC Pro center. From the Windows taskbar, click Start > Shut Down > Restart and press Enter.
11. Verify the new settings prior to monitoring patients.

**Scenario 2: Add or upgrade a CIC Pro center in a care unit running multiple CIC Pro centers**

When a CIC Pro center is added to or upgraded in a care unit already running other CIC Pro centers, configuration data common to the care unit is changed in the new or upgraded CIC Pro center, when it starts up, to match the other CIC Pro centers found in the care unit network. Configuration data specific only to the new or upgraded CIC Pro center does not change. Therefore, restore is not useful in this situation. Verify the new settings prior to monitoring patients.

**Scenario 3: Restore multiple CIC Pro centers in a care unit to a previous configuration**

In certain cases, it may be necessary to restore the CIC Pro centers in a care unit to a previous configuration.

1. Shut down all but one of the CIC Pro centers in the care unit. See Perform safe shutdown of the CIC Pro center on page 8-31.

   This prevents the restore from being overwritten by associated data from other CIC Pro centers running on the care unit network.

   **NOTE**

   The CIC Pro center application must be stopped in order to perform a restore. Because configuration data is automatically updated to match other CIC Pro centers found running in the care unit, if other CIC Pro centers are left running, when the restored CIC Pro center application starts back up, some configuration data would be overwritten by the automatic update.

2. Stop the CIC Pro center application on the one CIC Pro center that was left running.
   a. From the multi-patient viewer, click **Setup CIC**.
   b. Click the **Service Password** tab.
   c. Type `mms_com` as the password and press **Enter**.
   d. At the Windows command line prompt, type **stop** and press **Enter**.

3. Disconnect the CIC Pro center from the CARESCAPE Network IX and MC networks.

4. Connect a service PC directly to the CIC Pro center and Log on to the Webmin service interface remotely via the CARESCAPE network IX network on page 4-7.

5. Click **Configuration > Backup/Restore > Unit Defaults**.
6. Click **Browse** to select a backup file from the service PC/remote computer.

7. On the **Choose file** window, navigate to the directory where a file from a previous backup was saved.

8. Select the backup file, and click **Open**. The backup file location displays in the **Browse** field.

9. Click **Upload**. The CIC Pro center uploads this backup file.

10. Click **Logout** to exit the Webmin application.

11. Restart the CIC Pro center application on this CIC Pro center. From the Windows taskbar, click **Start > Shut Down > Restart** and press **Enter**.

12. Start up the other CIC Pro centers, one at a time. Common configuration data associated with the care unit is updated with data from the restored CIC Pro center as the other CIC Pro centers start up.

13. Verify the new settings prior to patient monitoring.

### Backing up and restoring local custom default configuration settings

You can back up and restore any of the custom default configuration settings associated with the Single Patient Viewer applications. These configurations may be unique to each CIC Pro center and can include the following functions:

- **FD Page**: Displayed waveforms and waveform display enhancements (e.g., Zoom Window).
- **Graphic Trends**: Customized trend groups.
- **Vital Signs**: Customized data sort modes.
- Menubar: Customized **Save As Favorites** for single or secondary display configurations.

### Back up local custom default configuration settings

**NOTE**

The backup and restore procedures must only be completed from a remote computer.
1. If you have not already logged onto Webmin, Log on to the Webmin service interface remotely via the CARESCAPE network IX network on page 4-7.

2. Click **Configuration > Backup/Restore > Customize Settings**.

3. Click **Backup**. The default files are temporarily written to the CIC Pro center and are prepared for downloading to your local computer.

4. Right-click on the link to download the backed up defaults file.

5. On the file download window, click **Save Target As...**.

6. On the **Save As** window, navigate to a directory on your local computer where you want to save the downloaded configuration file. If required, rename the file.

7. Click **Save**.

8. On the **Download complete** window, click **Close**.

**Restore local custom default configuration settings**

**NOTE**

The backup and restore procedures must only be completed from a remote computer.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface remotely via the CARESCAPE network IX network on page 4-7.

2. Click **Configuration > Backup/Restore > Customize Settings**.
3. Click **Browse**.

4. On the **Choose file** window, navigate to the directory where a file from a previous backup was saved.

5. Select the backup file and click **Open**. The backup file link displays in the **Browse**... field.

6. Click **Upload**. After the restore is complete, the message, **Customize settings have been restored**, is displayed.

7. Click **Logout** to exit the Webmin application.

8. From the Windows taskbar, click **Start > Shutdown > Restart** and press **Enter**. The CIC Pro center restarts and applies the restored configuration settings.

9. Verify the new settings prior to monitoring patients.

### Reconnect the CIC Pro center with the network

Connect the CIC Pro center to the IX and MC networks.

### Perform MultiKM (Multimouse) setup

The MultiKM license allows you to connect a minimum of one keyboard and one mouse to a group of centralized and configured CIC Pro centers.

**NOTE**

To prevent temporary loss of navigation control in a configured keyboard and mouse group, you should always have a redundant navigation control device connected in each configured group. A redundant navigation control device includes one or more of the following:

- A touchscreen display connected to a second CIC Pro center in the configured keyboard and mouse group.
- A second keyboard and mouse connected to a second CIC Pro center in the configured keyboard and mouse group.
NOTE

If you connect more than one mouse to a configured mouse group, always position the additional mice on a flat surface. Otherwise, erratic mouse movements and behaviors may result.

NOTE

All CIC Pro center devices in the MultiKM group have to be of the same version.

- In any given CARESCAPE Network, many Multimouse groups can co-exist as long as each individual group’s devices are the same CIC Pro center version. (Example: all CIC Pro center v5.0.x in one group and all CIC Pro center v5.1.x in another group.)
- If a CIC Pro center is swapped from an existing Multimouse group A, ensure that the new CIC Pro center is the same version as the other CIC Pro centers in the Multimouse group A.

NOTE

If the MultiKM license is activated, you must position the mouse cursor in the CIC Pro center patient window where the user action is to take place.

NOTE

The use of Multimouse and MultiKM names appear in both this manual and in the software application. Please be aware that these names refer to the same licensed software application, MultiKM.

With the MultiKM license activated, you can do the following tasks:

- Move the mouse across all of the CIC Pro centers in the group.
- Support right and left mouse clicks and scroll wheel movement.
- Access any CIC Pro center’s display screen or enter text into any of the CIC Pro center’s text fields in the group.

This section describes the procedures required to configure a keyboard and mouse group:

☐ Pre-configure the CIC Pro centers on page 6-79.
☐ Configure the keyboard and mouse group on page 6-81.
☐ Change a keyboard and mouse group on page 6-84.

- Add a CIC Pro center to an existing keyboard and mouse group on page 6-84.
- Divide a mouse and keyboard group into two groups on page 6-85.
- Combine two keyboard and mouse groups into one group on page 6-88.

Pre-configure the CIC Pro centers

When configuring a keyboard and mouse group, you can use one or more sets of mice and keyboards. If you use a pair of mice and keyboards across multiple CIC Pro centers, just connect or disconnect the mouse and keyboard from each CIC Pro center as you configure a keyboard and mouse group.
1. Connect a mouse and keyboard to every CIC Pro center in the group. You can remove all but one set once you have configured the keyboard and mouse group.

2. From the primary control CIC Pro center where the mouse and keyboard will remain connected, if you have not already logged into Webmin, Log on to the Webmin service interface on page 4-7.

3. Click **Configuration > Licensing.**

4. Write the **Computer Name** on a label and apply the label to the front bezel of each display screen. This will help you configure the displays of a MultiKM keyboard and mouse group.

   **NOTE**
   
   Be sure to apply a **Computer Name** label to both the primary (1) and secondary (2) displays.

5. Verify the MultiKM license is activated on each CIC Pro center you want in the keyboard and mouse group.
   
   a. In the **Feature List**, locate **System Utilities - MultiKM**.
   
   b. Next to **System Utilities - MultiKM**, verify the **Activation Code** field displays an activation code:
      
      - If an activation code is displayed, the MultiKM license has been activated on this CIC Pro center.
      - If an activation code is not displayed, the MultiKM license has not been activated on this CIC Pro center. You must activate the license on this CIC Pro center before you can configure it into a keyboard and mouse group. See **Activate software licenses on page 6-10**.
c. Repeat step 5 for each CIC Pro center you are configuring into a keyboard and mouse group.

**Configure the keyboard and mouse group**

After you have identified the Computer Name and activated the MultiKM license (if required) on each CIC Pro center, you need to configure a keyboard and mouse group.

**NOTE**

You cannot enable, disable, or configure the MultiKM application from a remote location. You can only perform these tasks while you are locally seated at the CIC Pro center and logged on to the local webmin service interface.

1. If you have not already logged onto Webmin, Log on to the direct access (local) Webmin service interface on page 4-7.

2. Click *Configuration > MultiKM.*

3. On the *MultiKM Configuration* window, click *Enable.*

**NOTE**

To disable the MultiKM application on this device, click *Disable.*

4. Repeat steps 1 - 3 for each CIC Pro center that will be in the group.

5. On the CIC Pro center that will have the keyboard and mouse attached, on the *Multimouse* application window, click *Configure* to set up a keyboard and mouse group.
6. The **Change Configuration** window displays the list of computer names of available centralized CIC Pro centers that have the MultiKM application enabled.

7. Verify the computer names of the CIC Pro centers to be added or removed from a group are displayed in the list. All CIC Pro centers that have Multimouse enabled but do not belong to a group will be automatically added to the list.

8. Remove any names of the CIC Pro centers you do not want included in this group:
   a. Under **Other Computers**, click the computer name of the CIC Pro center you want to remove and click **Remove**.
   b. Repeat step 8 to remove additional CIC Pro centers from this group.

9. Click **Next**. A window displays a linear configuration of the centralized CIC Pro center monitor displays.
10. Click and drag the location of the computer names to match the physical layout of the CIC Pro center displays in this group.

**NOTE**

- Leave the *Hot key* field blank.
- CIC Pro centers with a secondary display will move together.

11. Click *Finish*. 
12. Click **Hide** to hide the **Multimouse** window.

13. Verify that the MultiKM application is running on each CIC Pro center in the keyboard and mouse group:
   a. Look for the MultiKM application icon (while the CIC Pro center is running) in the bottom right corner of the display screen.
   b. Verify the mouse pointer moves into each of the display screens in the group.
   c. If the mouse pointer does not move to each display screen, see MultiKM issues on page 8-10.

14. Remove any extra keyboards, but leave the mice connected.

**Change a keyboard and mouse group**

**Add a CIC Pro center to an existing keyboard and mouse group**

At any time, you may add one or more CIC Pro centers to an existing keyboard and mouse group.

1. At each CIC Pro center that you want to add to the keyboard and mouse group:
   a. If you have not already logged onto Webmin, Log on to the direct access (local) Webmin service interface on page 4-7.
   b. Click **Configuration > Licensing** and do the following:
      - Identify the Computer Name of the CIC Pro center you are adding.
      - Verify the MultiKM license is activated on the CIC Pro center you are adding.
   c. Click **Configuration > MultiKM > Enable** and start the MultiKM application on the CIC Pro center you are adding.
   d. Repeat step 1 for each CIC Pro center you are adding.

2. At any one of the CIC Pro centers that is already in this keyboard and mouse group:
   a. If you have not already logged onto Webmin, Log on to the direct access (local) Webmin service interface on page 4-7.
   b. Click **Configuration > MultiKM > Configure** and start the MultiKM application.
Divide a mouse and keyboard group into two groups

**Preliminary steps**
At any time, you may divide a single mouse and keyboard group into two groups (e.g., Group 1 and Group 2).

1. Note the computer names of the CIC Pro centers located in the group (e.g., A, B, C, D, E, and F).
2. Determine how you want to divide the single CIC Pro center group into two groups (e.g., Group 1: A, B and C and Group 2: D, E and F).
3. Go to CIC Pro center A.
4. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
5. Click **Configuration > MultiKM** and start the MultiKM application.
6. On the **Multimouse** application window, click **Configure**.

**Create Group 1**

**NOTE**
Because the primary CIC Pro center is the device that has the mouse and keyboard connected to it, the computer name of this device will not be displayed in the **Other computers** list. This prevents you from accidentally removing the only device with the mouse and keyboard from a keyboard and mouse group.

1. On the **Change Configuration** window, remove the names of the CIC Pro centers you do not want included in Group 1:
   a. Under **Other Computers**, click the computer name of the CIC Pro center you want to remove from the group (e.g., D).
b. Click **Remove**.

c. Repeat step 1 to remove additional CIC Pro centers from this group (e.g., E and F).

**NOTE**

If any CIC Pro center is taken off of an existing Multimouse group for any reason, you must remove that CIC Pro center from the existing group.

2. On the **Change Configuration** window, click **Next**.

3. Click and drag the location of the computer names to match the physical layout of the CIC Pro center displays in this group.
**NOTE**

CIC Pro centers with a secondary display will move together.

4. Click **Finish**. A message displays the computer names of the CIC Pro centers the computer is grouped with.

5. Click **Hide** to hide the Multimouse window. The first group has been created (e.g., Group 1: A, B, and C).

6. Verify that the MultiKM application is running on each CIC Pro center in the keyboard and mouse group. If there are problems, see MultiKM issues on page 8-10.

**Create Group 2**

1. Determine which CIC Pro center in Group 2 will be the primary device and connect a mouse and keyboard to it.

2. From any one of the CIC Pro centers that will be in Group 2 (e.g., D, E, or F):
   a. If you have not already logged onto Webmin, Log on to the direct access (local) Webmin service interface on page 4-7.
   b. Click **Configuration > MultiKM** and start the MultiKM application.
   c. Configure the keyboard and mouse group on page 6-81.
d. Verify that the MultiKM application is running on each CIC Pro center in the keyboard and mouse group. If there are problems, see MultiKM issues on page 8-10.

Combine two keyboard and mouse groups into one group

At any time, you may combine two keyboard and mouse groups into one group:

1. Identify the computer groups you want to combine (e.g., Group 1: A, B, C and Group 2: D, E, F).
2. Go to CIC Pro center A. (The CIC Pro center that will have the keyboard and mouse connected.)
3. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
4. Click Configuration > MultiKM > Configure and start the MultiKM application.
5. Repeat the configuration starting with step 5. See Configure the keyboard and mouse group on page 6-81.
6. Complete step 2 to step 5 on CIC Pro centers D, E, F, B and C.
7. Go to CIC Pro center A. Verify that all the CIC Pro center computer names are listed and then click Next.
8. Click and drag the location of the computer names to match the physical layout of the CIC Pro center displays in this group.
9. Click Hide to hide the Multimouse application window. The MultiKM application should be active on all of the CIC Pro centers in the configured keyboard and mouse group.
10. Verify that the MultiKM application is running on each CIC Pro center in the keyboard and mouse group. If there are problems, see MultiKM issues on page 8-10.
Complete configuration checkout procedures

NOTE

Close all files before starting the checkout procedures.

Before using the CIC Pro center to monitor patients, you must verify proper operation of this device in the patient care and networking environments. Use the following checklist to thoroughly test the system for proper function and operation.

☐ Check date and time on the network after installation of this current device. See Pre-configuration instructions on page 6-2.

☐ Verify that the Remote Service agent is enabled. See Enable or disable the Remote Service Agent on page 6-18.

☐ Check the unit defaults on page 7-3.

☐ Check the laser printer connectivity. See Check status of installed printers on page 7-3.

☐ Check the digital writer connectivity. See Check status of installed printers on page 7-3.

☐ Check operation of the secondary display on page 7-4 (if applicable).

☐ Check the status of installed licenses on page 7-4.

☐ Verify settings with Check Centrals command on page 7-5.

☐ Check and configure the speaker volume on page 7-5.

☐ Check operation of audible alarm tones on page 7-6.

☐ Check access to all other care units on page 7-6.

☐ Check the operation of the Citrix application viewed at the CIC Pro center on page 7-7 (Hospital responsibility).

☐ Check the hospital intranet browser functionality on page 7-7 (Hospital responsibility).

☐ Check the status of locked beds on page 7-7.

☐ Check the language settings on page 7-7 (applicable for all non-English applications only).

☐ Check the pressures unit-of-measure on page 7-7 (for Chinese applications only).

☐ Check the custom groupings for patient data on page 7-7.

☐ Check the shortcuts to favorite CIC Pro center views on page 7-7.

☐ Check MultiKM (Multimouse) operation on page 7-8.

☐ Check current system settings on page 7-8.

☐ Check full disclosure license type for all admitted in-unit beds on page 7-9.

☐ Check full disclosure report printing on page 7-9.

☐ Save backup defaults file on the USB memory stick on page 7-9 (Optional).

☐ Check operation of the Watchdog countdown function on page 7-18.
7 Checkout procedures
Safety tests and checkout procedures

Overview

WARNING
ACCIDENTAL SPILLS — To avoid electric shock or device malfunction, liquids must not be allowed to enter the device. If liquids have entered a device, take it out of service and have it checked by a service technician before it is used again.

WARNING
DISCONNECTION FROM MAINS — When disconnecting the system from the power line, remove the plug from the wall outlet first. Then you may disconnect the power cord from the device. If you do not observe this sequence, there is a risk of coming into contact with line voltage by inserting metal objects, such as the pins of leadwires, into the sockets of the power cord by mistake.

The safety tests and checkout procedures provide a method of verifying operational and functional performance without having to disassemble the unit. Failure to attain the prescribed results indicates a need for calibration, configuration, or repair of the equipment.

The safety tests and checkout procedures are based on the assumption that the equipment being tested is using known, good cables. It also requires that the user be familiar with the operation of the system. For more information concerning the operation of these components, refer to the operator manual associated with the equipment.

Perform all of the checkout procedures included in this section to completely test the system for proper function and operation.

Perform the checkout procedures upon receipt of the equipment, every year thereafter, and each time a component is removed or replaced.

Checkout procedures need to be performed at the following times:

- When initially installing, modifying the configuration, or upgrading the software. See Configuration checkout procedures on page 7-3.
- When replacing any FRU. See FRU checkout procedures on page 7-10.

Test equipment

The safety tests and checkout procedures are written for the GE recommended test equipment listed for each test. If you use test equipment other than those GE recommends, you may need to slightly modify some test steps.
Configuration checkout procedures

NOTE

All Webmin modules are static in nature. Since the Webmin service interface session times out after 15 minutes, you must always refresh the browser to load the latest page.

Check the unit defaults

Confirm the unit defaults match the customer’s needs as provided by the clinical application specialist or the responsible hospital care nurse.

Check status of installed printers

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Information > Printer Information.

View system information

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Information > System Information.
Checkout procedures

Check operation of the secondary display

1. If you have just restarted the CIC Pro center and turned on the power to the primary and secondary displays, the secondary display should be illuminated and appear grey in color.

2. From the multi-patient viewer, click Browser. The Browser window should appear in the secondary display.

3. Click any bed from the multi-patient viewer. The single patient viewer should appear in the secondary display.

Check mirror configuration

1. Verify that the Display Configuration tab is missing in the CIC Setup window.

2. Perform all of the checkout procedures as listed in Configuration checkout procedures on page 7-3.

3. At the top of the multi-patient viewer window, confirm that the name of the mirror is displayed as Mirror of XXX. (XXX is the name of the intended primary CIC Pro center.)

Check the status of installed licenses

Complete the following procedure to confirm all purchased licenses for this CIC Pro center have been activated.

1. Get the Activation Code Summary Sheet that matches the serialized USB Memory stick and the serial number of your CIC Pro center.

2. Compare that all of the licenses identified on the Activation Code Summary Sheet were activated on the CIC Pro center. A license is activated when an activation code displays and the activation icon appears green in color.
Checkout procedures

Verify settings with Check Centrals command

After introducing the upgraded or new CIC Pro center onto a verified compatible IX/MC network, it is recommended that you run the Check Centrals diagnostic from the CIC Pro center via Webmin as a final checkout. See page Pre-configuration instructions on page 6-2 for instructions on running the Check Centrals utility.

Check and configure the speaker volume

WARNING
ALARMS — Do NOT rely exclusively on the audible alarm system for Bedside Monitoring. Adjustment of CIC Pro center alarm volume to a low level or OFF during Bedside Monitoring may result in inability to hear the alarm and a hazard to the patient. Remember that the most reliable method of Bedside Monitoring combines close personal surveillance with correct operation of monitoring equipment.

After connecting the monitor to the central station and/or nurse-alert, verify the function of the alarm system. Repeat this verification periodically, including a check of all connected speakers.

The functions of the alarm system for monitoring of the patient must be verified at regular intervals. Check speaker volume periodically to ensure audio alarm functionality.
Complete the following procedure to configure the speaker volume for the CIC Pro center:

**NOTE**

All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of the various alarms in your environment and the configuration of the alarm audio settings.

1. From the multi-patient viewer, click *Setup CIC*.
2. Determine the *Current* alarm volume setting.
3. Determine the *Minimum* alarm volume setting.
4. Verify that the settings are correct, based on the needs of the configured care area.
5. If the settings are not correct for the care area, follow the procedure to set the correct volume settings on page 6-40.

### Check operation of audible alarm tones

**WARNING**

The CIC Pro center audible alarms will not sound for bedside patients configured to the *Operating Room* mode.

**NOTE**

All clinical setting values must be received from the GE Clinical Application Specialist (CAS) or from the nursing director of the care unit. Consult with your CAS or hospital staff about the use of these functions and if they should be used with your configuration.

**NOTE**

Active alarms override this test.

1. From the single patient viewer menu, click *Monitor Setup > Alarm Control*.
2. Click *Alarm Help > Advisory Alarm*.
3. Verify the alarm sounds through both speakers.

### Check access to all other care units

1. From the multi-patient viewer menu, click *View Other*.
2. Verify that the list shows all care units that should be networked.
Checkout procedures

Check the operation of the Citrix application viewed at the CIC Pro center

It is the responsibility of the hospital’s IT or Biomedical department to meet the required CIC Pro center configuration needs to check this functionality.

Check the hospital intranet browser functionality

It is the responsibility of the hospital’s IT or Biomedical department to meet the required CIC Pro center configuration needs to check this functionality.

Check the status of locked beds

Based on the needs of the hospital staff, ensure that the required beds are locked. See Set up locked beds on page 6-54.

Check the language settings

In the multi-patient viewer window, check if the patient names are displayed the appropriate language.

Check the pressures unit-of-measure

In the multi-patient viewer window, verify that the pressure value displays in the following unit-of-measure:

- kPa if the language of the CIC Pro center is set to Chinese
- mmHg if the language of the CIC Pro center is set to any language other than Chinese

Check the custom groupings for patient data

In the single patient viewer window, verify that the custom groupings display properly.

Check the shortcuts to favorite CIC Pro center views

In the single patient viewer window, verify that the favorite view buttons are displayed.
Checkout procedures

Check MultiKM (Multimouse) operation

Verify that the MultiKM application is running on each CIC Pro center in the keyboard and mouse group. If there are problems, see MultiKM issues on page 8-10.

Check current system settings

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Configuration > Set Flags.
3. Verify that the following settings listed on the Set Flags Module window are correct:
   - No COMM
   - Force age
   - Multiviewer alarm audio
   - ADU alarm audio
Check full disclosure license type for all admitted in-unit beds

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Full Disclosure.


4. Verify all admitted beds in the care unit have the correct full disclosure license type.

Check full disclosure report printing

1. From the single patient viewer, click Patient Data > FD Page.

2. Verify waveforms appear.

3. On the FD Page window, click the print button.

4. Print a one-hour full disclosure report.
   a. Set the Start and End time.
   b. Set the Time Per Line time duration.
   c. Click Print.

5. Verify the full disclosure report printed out at the printer.

6. Repeat for every CIC Pro center in the care unit.

Save backup defaults file on the USB memory stick

Ensure that you have backed up the CIC defaults file on the USB memory stick. See Back up and restore the CIC Pro center configuration on page 6-72.
FRU checkout procedures

Check read and write integrity of hard drive and solid state flash drive

The following table lists the drives/partitions on the CIC Pro center hardware:

<table>
<thead>
<tr>
<th>Drive/partition</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Clinical application and service application</td>
</tr>
<tr>
<td>D</td>
<td>OS1</td>
</tr>
<tr>
<td>F</td>
<td>Configuration data</td>
</tr>
<tr>
<td>G</td>
<td>FD data</td>
</tr>
</tbody>
</table>

NOTE

The CIC Pro center application must be stopped before you can check for disk errors on a disk drive.

CAUTION

During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

1. Log on to the CIC Pro center as Administrator on page 4-3.
2. From the Windows taskbar, click Start > Run.
3. At the command prompt, type cmd.
4. At the D:\> prompt, type chkdsk and press Enter.
5. Ensure that there are no errors. If errors are found, refer to Troubleshooting on page 8-1. If you require additional information or troubleshooting assistance, contact Technical Support.

6. Check the C:\ drive:
   a. Type `c:` and press **Enter**.
   b. At the `C:\>` prompt, type `chkdsk` and press **Enter**.

   ![chkdsk command output](image)

7. Ensure that there are no errors. If errors are found, refer to Troubleshooting on page 8-1. If you require additional information or troubleshooting assistance, contact Technical Support.

8. Repeat the procedure described in step 6 to check the F:\ and G:\ drives.

**Check USB devices**

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click **Diagnostics** > **Preventative Maintenance** > **USB Loopback Test**.
3. Verify all connected USB devices are shown (e.g., keyboard, mouse, USB printer).

**NOTE**

The value 8 in the *NumberOfPorts* field corresponds to 2 internal ports which are not used and 6 external physical ports.

### Check internal hardware temperature and voltage status

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click *Diagnostics > Runtime Diagnostics > Temp/Voltage Info*.

3. On the *Temp/Voltage Info* screen, verify that the values displayed are within the following acceptable limits:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Acceptable limits</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Voltage</strong> (5V)</td>
<td>Actual real-time voltage of the CIC Pro center’s 5-volt internal power sub-system.</td>
<td>4850 — 5250 mV</td>
</tr>
<tr>
<td><strong>System Voltage</strong> (12V)</td>
<td>Actual real-time voltage of the CIC Pro center’s 12-volt internal power sub-system.</td>
<td>11400 — 12600 mV</td>
</tr>
<tr>
<td><strong>CPU Temperature</strong></td>
<td>Real-time CIC Pro center’s internal temperature at the CPU.</td>
<td>5 — 90 °C</td>
</tr>
<tr>
<td><strong>Enclosure Temperature</strong></td>
<td>Real-time CIC Pro center’s internal temperature.</td>
<td>5 — 70 °C</td>
</tr>
</tbody>
</table>
Check COMM ports

NOTE

The CIC Pro center application must be stopped before conducting this test.

1. Log on to the CIC Pro center as Administrator on page 4-3.
2. From the desktop, launch Internet Explorer.
3. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
4. Click Diagnostics > Preventative Maintenance > COMM Port Test.

5. Verify all ports are configured properly.

Check BIOS information

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Diagnostics > Preventative Maintenance > Bios Information.
3. Verify that the following information displays in the **BIOS Version** field on the **Bios Information** screen:

   *Phoenix - AwardBIOS v6.00PG*
   *Phoenix - AwardBIOS v6.00PG*

**Check drive operation information (Flash drive and hard drive)**

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click **Diagnostics > Preventative Maintenance > Drive Test.**

3. View the Flash drive information on the first screen that is displayed.
Flash drive information

NOTE

This software currently does not support a temperature reporting feature for the flash drive. Therefore, the zeroes which are displayed in the Drive Temperature section do not reflect the actual temperature.

4. Scroll down to view the hard drive information.
Check audio component operation

NOTE

The CIC Pro center application must be stopped before conducting this test.

CAUTION

During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

1. Log on to the CIC Pro center as Administrator on page 4-3.
2. From the desktop, launch Internet Explorer.
3. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
4. Click Diagnostics > Preventative Maintenance > Audio Test.
5. On the Audio Test screen, select CIC Alarm Sounds from the drop-down list and click Submit Query.
6. View the results on the **Audio Test** screen and verify a beeping tone sounds from the CIC Pro center.

**Check speaker status**

1. If you have not already logged onto Webmin, **Log on to the Webmin service interface on page 4-7**.

2. Click **Diagnostics > Runtime Diagnostics > Closed-loop Audio Info**.

3. On the **Closed-loop Audio Info** screen, verify the speakers are plugged into the correct socket.
Checkout procedures

**Check operation of the Watchdog countdown function**

**NOTE**

The CIC Pro center application must be stopped before conducting this test.

**CAUTION**

During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

1. Log on to the CIC Pro center as Administrator on page 4-3.
2. From the desktop, launch Internet Explorer.
3. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
4. Click **Diagnostics** > **Preventative Maintenance** > **Watchdog Test**.
5. On the **Watchdog Testing** screen, click **Start Test**.

Once the Watchdog timer counts down to zero, the CIC Pro center will reboot and must return to the normal state.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
</table>
| **External Speaker Status** | - **Plugged (1)** indicates connector is plugged into the external speaker socket.  
- **Unplugged (0)** indicates nothing is plugged into the external speaker socket. |
| **Internal Speaker Status** | - **Plugged (1)** indicates connector is plugged into the internal speaker socket.  
- **Unplugged (0)** indicates nothing is plugged into the internal speaker socket. |
Check processor fan status

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Preventative Maintenance > Fan Test.

3. On the Fan Testing screen, verify the following values are within acceptable limits:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Acceptable limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chassis Fan 1 Speed</td>
<td>Real-time speed of fan for CIC Pro center’s CPU.</td>
<td>2700 — 4000 RPM</td>
</tr>
<tr>
<td>Chassis Fan 2 Speed</td>
<td>Real-time speed of fan for CIC Pro center’s chassis.</td>
<td>1700 — 4000 RPM</td>
</tr>
</tbody>
</table>

Check video function and status of video card and drivers

**NOTE**

The CIC Pro center application must be stopped before conducting this test.

**CAUTION**

During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

1. Log on to the CIC Pro center as Administrator on page 4-3.

2. From the desktop, launch Internet Explorer.

3. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

4. Click Diagnostics > Preventative Maintenance > Video Test.
5. Verify all colors pass the test.

**Check integrity of system files**

1. If you have not already logged onto Webmin, [Log on to the Webmin service interface on page 4-7](#).
2. Click **Diagnostics > Preventative Maintenance > Store Integrity Test**.

3. Ensure that there are no extra, invalid, or missing files.

**Check asset information**

1. If you have not already logged onto Webmin, [Log on to the Webmin service interface on page 4-7](#).
2. Click **Configuration > Asset Settings**.
3. If needed, in the *Change Value To* field, type the asset ID for the device and click *Submit*. 
Checkout procedures
8 Troubleshooting
Overview

A systematic approach to the diagnosis of problems, as well as a general understanding of the hardware and software architecture of the CIC Pro center are essential to ensure successful troubleshooting. GE recommends formal service training before repairs are attempted. These troubleshooting procedures combined with training provide the service technician with skills necessary to service and repair this device, in the event of a malfunction.

Required tools

The following tools and equipment are required to troubleshoot this device:

- Standard set of hand tools.
- Digital multimeter.

See Gather required equipment and tools on page 11-2.

Tips

WARNING
ACCIDENTAL SPILLS — To avoid electric shock or device malfunction, liquids must not be allowed to enter the device. If liquids have entered a device, take it out of service and have it checked by a service technician before it is used again.

Before starting any detailed troubleshooting, you should always check for the following conditions:

- Verify all cable connections are secure and properly seated.
- Verify all components are connected properly.
- Verify all devices are properly powered.
- Verify the electrical wall outlet is operating properly.
- Verify that the UPS, if connected, is working properly.
- Verify that there are no errors reported after running the Check Centrals utility.

See Pre-configuration instructions on page 6-2.

Consult the documentation provided with each component of the system for additional troubleshooting information.

Error messages

NOTE

Alarm messages from the CIC Pro center, monitors, and telemetry transmitters/transceivers are explained in the operator’s manuals for each device.
<table>
<thead>
<tr>
<th>Message/Symptom/Issue</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Printer Name must be specified. Please go back and re-enter a printer name.</td>
<td>The printer name was not specified.</td>
<td>Enter a valid printer name. See Install a network laser printer on page 6-15.</td>
</tr>
<tr>
<td>Error response returned from picklist server</td>
<td>The information from the server is not valid and cannot be used.</td>
<td>Wait a few seconds and retry your search request. If this does not resolve the problem, try entering different search criteria.</td>
</tr>
<tr>
<td>Invalid picklist query</td>
<td>Your search request is not valid.</td>
<td>Try entering different search criteria.</td>
</tr>
<tr>
<td>No matches found for the picklist request</td>
<td>There are no valid matches for your search request.</td>
<td>Try entering different search criteria.</td>
</tr>
<tr>
<td>Operating system missing</td>
<td>A USB memory stick other than the stick containing the reload image is connected to the CIC Pro center.</td>
<td>1. Remove the USB memory stick.</td>
</tr>
<tr>
<td>Operating system does not boot from the USB memory stick</td>
<td>An incorrect boot order in the system BIOS is the most likely cause.</td>
<td>2. Reboot the CIC Pro center. See Perform safe restart of the CIC Pro center on page 8-30. The CIC Pro center software should come back normally.</td>
</tr>
<tr>
<td>Picklist server is not available</td>
<td>■ The server is not present on the network.</td>
<td>Contact your Information Technology department.</td>
</tr>
<tr>
<td>■ There are network problems and you cannot perform a search now.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request time out, cancelling request</td>
<td>Communication to the server has failed and your search request is cancelled.</td>
<td>Wait a few seconds and retry your search request.</td>
</tr>
<tr>
<td>Server off network</td>
<td>The Hospital Information System (HIS) is either not available or not present.</td>
<td>There are network problems and you cannot perform a search now. Wait a few seconds and retry your search request.</td>
</tr>
<tr>
<td>Service Monitor Battery</td>
<td>The CIC Pro center CPU battery has a low charge and requires replacement.</td>
<td>Replace the CPU battery.</td>
</tr>
<tr>
<td>There is a problem with your IP address. Please go back and re-enter the correct IP.</td>
<td>■ The printer’s IP address was not entered correctly.</td>
<td>Enter the correct IP address. See Install a network laser printer on page 6-15.</td>
</tr>
<tr>
<td>■ The Printer's IP Address field was left blank.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Troubleshooting

#### Time does not advance or alternates frequently between two or more times

<table>
<thead>
<tr>
<th>Message/Symptom/Issue</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Time does not advance or alternates frequently between two or more times | Abrupt time change on the CARESCAPE Network caused by one of the following:  
  - Abrupt power cycle  
  - UPS is not connected.  
  - Time zone mismatch.  
  - Unused CIC Pro center connected to the existing network without adjusting the time on the CIC Pro center to be as close as possible to the CARESCAPE Network time on any existing GE bedside device or CIC Pro center.  
  - Non-GE equipment connected to the MC/IX network  
  - DST check box checked | Arrange alternate monitoring at the bedside.  
Verify IP addresses, time zone/Time Master settings:  
1. Run the **Check Centrals** utility to check for time zone settings, DST status, and CARESCAPE Network IP address errors. Resolve any issues.  
2. Run `lw -s time` to identify the Time Master on the network.  
3. Using the results of steps 1 and 2, ensure that the Time Master (highest MC network IP address) is the CIC Pro center with the highest CIC Pro center application software version on the network. See Pre-configuration instructions on page 6-2.  
4. Shutdown the Time Master CIC Pro center. See Perform safe shutdown of the CIC Pro center on page 8-31.  
5. Wait two minutes.  
6. Power up the Time Master CIC Pro center. Initiate a time change from the Time Master CIC (~1 minutes ahead) and check to see if the tie has advanced properly on at least a few CARESCAPE Network devices in the care area.  
7. If the time has advanced and not alternating, no additional steps need to be done.  
8. If the time has not advanced correctly, continue to Verify Aware Gateway settings. |
<table>
<thead>
<tr>
<th>Message/Symptom/Issue</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Time does not advance or alternates frequently between two or more times - continued. | Verify Aware Gateway settings:  
1. Check if there are one or more Aware Gateways connected to the CARESCAPE Network.  
2. If there is one or more Aware Gateways on the network. Verify that the Time Master settings on all the Aware Gateways are set per the instructions in the Aware Gateway Service Manual.  
3. Initiate a time change from the Time Master CIC (~1 minute ahead) and check to see if the time has advanced properly and not alternating on at least a few CARESCAPE Network devices in the care area. |  
Segment the network:  
1. If the settings on Aware Gateway are correct or if corrections made to the Aware Gateway Time Master settings do not resolve the issue, then it is recommended that you try to segment the network, closet by closet.  
   **NOTE**  
   After completing the tasks in this step, you know have multiple segmented closets on different isolated networks.  
2. If the problem still persists on any network, then power down the MC network switch in the specific segmented closet (e.g. closet A).  
3. Wait for approximately 15 seconds and power on the MC network switch in the segmented closet A.  
4. Wait for two minutes.  
5. If time is not alternating, no additional steps need to be done for closet A.  
6. If time is alternating, repeat the Verify IP addresses, time zone/Time Master settings part of this procedure.  
7. Repeat the Segment the network section as needed for each segmented closet. |  
Checkout  
1. Re-connect the segmented closets one closet at a time.  
2. Verify that the time is not alternating before connecting the next closet. |  
Final checkout  
1. Repeat Verify IP addresses, time zone/Time Master settings steps 1 - 7. |
<table>
<thead>
<tr>
<th>Message/Symptom/Issue</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms are silenced for out-of-unit beds at the CIC Pro center</td>
<td>Even though the setflags option <code>all_mvaudio</code> is set to on at the central station, alarms may have been silenced.</td>
<td>Since this capability exists on the CIC Pro center, care must be exercised not to silence the alarm when setflags <code>all_mvaudio</code> is configured to be on.</td>
</tr>
<tr>
<td>CIC Pro center continuously reboots during the USB reload procedure</td>
<td>The reload process started without disconnecting the network cables from the CIC Pro center.</td>
<td>Disconnect all the network cables before starting the reload process.</td>
</tr>
<tr>
<td>Loss of browser functionality</td>
<td>Parsing defect with Microsoft Internet Explorer&lt;br&gt;Level of security prevents certain applications from running</td>
<td>See Browser connectivity issues on page 8-9.</td>
</tr>
<tr>
<td>Printer button dimmed and unselectable when viewing stored patient data</td>
<td>Laser printer is not configured correctly&lt;br&gt;Restricted support from the Bedside monitor</td>
<td>See Laser printer on page 8-9.</td>
</tr>
<tr>
<td>Unable to print to the Digital Writer</td>
<td>Digital writer not powered up&lt;br&gt;Printer door is open&lt;br&gt;Printer is out of paper&lt;br&gt;Printer is not configured correctly</td>
<td>See Digital display writer on page 8-10.</td>
</tr>
<tr>
<td>Unable to use the MultiKM feature</td>
<td>MultiKM license is missing&lt;br&gt;MultiKM feature is not configured</td>
<td>Activate the MultiKM license and perform the required configuration as described in Perform MultiKM (Multimouse) setup on page 6-78.</td>
</tr>
<tr>
<td>MultiKM worked for only one hour</td>
<td>MultiKM enable has failed</td>
<td>See MultiKM issues on page 8-10.</td>
</tr>
<tr>
<td>When using Multimouse, unable to locate the control/focus screen</td>
<td>Cannot physically locate due to the physical layout of the displays</td>
<td>Use Ctrl+F1 to change the focus to the CIC Pro center where the keyboard and mouse are connected.</td>
</tr>
<tr>
<td>Unable to access CIC Pro center within a Multimouse group</td>
<td>Incompatible software versions within the Multimouse group</td>
<td>See Perform MultiKM (Multimouse) setup on page 6-9.</td>
</tr>
<tr>
<td>Blank display screen</td>
<td>Abrupt Power failure&lt;br&gt;No UPS&lt;br&gt;Loose cables/connectors/connections&lt;br&gt;Internal component is loose</td>
<td>See Blank screen on page 8-8.</td>
</tr>
<tr>
<td>Blue display screen</td>
<td>Windows Operating system has encountered a functional error</td>
<td>See Blue screen on page 8-8.</td>
</tr>
<tr>
<td>Red display screen</td>
<td>CIC Pro Application is starting up</td>
<td>See Red screen on page 8-9.</td>
</tr>
<tr>
<td>Incorrect display colors</td>
<td>Issue with the video</td>
<td>See Check video function and status of video card and drivers on page 7-19.</td>
</tr>
<tr>
<td>Unable to communicate with a device</td>
<td></td>
<td>See Unable to communicate with a device on page 8-11.</td>
</tr>
<tr>
<td>Need to stop full disclosure collection at a CIC Pro center running v5.1.x or later</td>
<td></td>
<td>See Set full disclosure mode on page 8-13.</td>
</tr>
<tr>
<td>Need to Ping full disclosure server</td>
<td></td>
<td>See Ping full disclosure server on page 8-14.</td>
</tr>
<tr>
<td>Need to get information regarding full disclosure data collection CIC Pro center units</td>
<td></td>
<td>See List full disclosure beds on page 8-12.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Message/Symptom/Issue</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Need to find out current system settings related to NO-COMM, Force Age, multi-patient viewer Audio, ADU alarm Audio</td>
<td></td>
<td>See Display current system settings on page 8-14.</td>
</tr>
<tr>
<td>Unable to access ADT information</td>
<td>More than one ADT system on the Network</td>
<td>See Admit Request Info button on page 8-15.</td>
</tr>
<tr>
<td>Experiencing waveform dropout</td>
<td>RF or Network connectivity issues</td>
<td>See Display waveform indicators on page 8-15.</td>
</tr>
<tr>
<td>Improper age selection criteria</td>
<td>For neonatal patients Age selection is mandatory</td>
<td>See Require age selection for admit on page 8-16.</td>
</tr>
</tbody>
</table>
| Unable to activate licenses | • USB stick is not NTFS-formatted  
• USB stick does not contain the required licenses  
• Serial number of the device and the serial number in the Licensing file do not match  
• The proper license activation process is not being followed | See Licensing issues on page 8-16. |
| Need to remove a license key |  | See Remove an activated license on page 8-19. |
| Need to download log files for the last 60 days |  | See Download log files on page 8-20. |
| Need to download log files up to 60 days including current day |  | See Access current log files on page 8-21. |
| Need to access application logs |  | See Application logs on page 8-23. |
| Need to access operating system event logs |  | See Operating system event logs on page 8-24. |
| Need to access operating system Dr. Watson log |  | See Operating system Dr. Watson log on page 8-25. |
| Need to view Webmin action log |  | See Webmin action log on page 8-25. |
| Unable to access PDF file | Microsoft security restrictions with the Win XP OS Service pack | See PDF file access from MUSE on page 8-19. |
| Need to access device driver information |  | See Device driver information on page 8-26. |
| Need to access network information |  | See Network information on page 8-26. |
| Need to access operating system runtime statistics |  | See Operating system runtime statistics on page 8-27. |
| Need to access operating system service process information |  | See Operating system service process information on page 8-28. |
| Need to access process information |  | See Process information on page 8-28. |
| Need to access time zone information |  | See Time zone information on page 8-29. |
| Need to view SMART drive status |  | See SMART drive status on page 8-29. |
| Need to perform safe shutdown |  | See Perform safe shutdown of the CIC Pro center on page 8-31. |
| Need to perform safe restart |  | See Perform safe restart of the CIC Pro center on page 8-30. |
## Troubleshooting

### Display issues

<table>
<thead>
<tr>
<th>Message/Symptom/Issue</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>During CIC reboot, the display screen shows a blank screen with the cursor blinking</td>
<td>A USB device other than a keyboard or mouse is connected to the CIC Pro center</td>
<td>Remove/unplug USB memory stick from the back of the CIC Pro center and power cycle the CIC Pro center using the power switch.</td>
</tr>
<tr>
<td>Need to edit the password for the Webmin logon</td>
<td></td>
<td>See Change the logon password for Webmin on page 8-32.</td>
</tr>
<tr>
<td>System resource icon is yellow or red Or Environment Monitor Notification message received stating System Resources are low and require restart or contacting immediately for service</td>
<td>System resources are outside normal operating limits</td>
<td></td>
</tr>
<tr>
<td>Incorrect Webmin page displayed</td>
<td>All Webmin modules are static in nature. Webmin service interface session times out after 15 minutes.</td>
<td>Refresh the browser to load the latest page</td>
</tr>
</tbody>
</table>

### Blank screen

1. Verify all the display screens and the device are plugged into a UPS.
2. Verify that all cables are properly seated.
3. Verify that all components are connected correctly.
4. Verify the electrical wall outlet is operating properly.
5. Verify the power cords are operating properly.
6. Shut down (Perform safe shutdown of the CIC Pro center on page 8-31), turn off, and unplug the CIC Pro center from the electrical wall outlet.
7. Follow the electrostatic discharge (ESD) precautions on page 9-11.
8. Remove the cover from the CIC Pro center and ensure all internal components are properly seated.
9. If necessary, Connect the display(s) on page 5-13.

**NOTE**

For more information, refer to the manufacturer’s document that is shipped with the display.

### Blue screen

Indicates the Windows operating system has a functional error and patient monitoring at the CIC Pro center is not occurring. If the CIC Pro center does not automatically restart after 90 seconds, the monitoring function at the CIC Pro center will not resume...
until you turn off the power to the CIC Pro center and then turn the power back on. The monitoring function should resume in approximately 90 seconds.

Red screen

Indicates the CIC Pro center application is restarting itself and patient monitoring at the CIC Pro center is not occurring. The monitoring function at the CIC Pro center will automatically resume in less than 30 seconds.

Incorrect colors

See Check video function and status of video card and drivers on page 7-19.

Browser connectivity issues

NOTE

If you are using Patient Viewer Version 1, the level of security present on the CIC Pro center server currently prevents browser connection to Patient Viewer.

A parsing defect in the Microsoft Internet Explorer browser can, in some cases, prevent access to certain sites. Also, the level of security present on the CIC Pro center server prevents running applications from the Windows desktop. The combination of these two factors contribute to loss of browser function under certain circumstances.

- Add a forward slash (/) to the end of an internet address.
- Add the following suffixes to the MUSE Web address:
  - Without a frame: http://museserver1/Museweb.dll?InitializeDefaultPage?Frames=0

For proper browser configuration, refer to Browser configuration on page 6-58.

Printer issues

Laser printer

- Check the printer settings for the laser and full disclosure printers.
- Verify the bedside monitor supports this type of print.
Try printing a test page on the printer.

Digital display writer

- Check if the printer is powered up.
- Check if the printer door is closed.
- Check if the printer has a paper roll.
- Check the configuration of this printer in the CIC Setup and bedside graph locations.

MultiKM issues

If the MultiKM license activation fails on any one of the CIC Pro centers in a group, the MultiKM application will work for a maximum of one hour.

Complete the following procedure to troubleshoot a MultiKM license activation failure.

License activation failures

1. Look in the bottom right corner of the display screen for the failed MultiKM license icon with the red slash through it. This icon indicates that the MultiKM license has failed.

2. Remove the CIC Pro center where MultiKM license failed out of the group:
   a. From any other CIC Pro center in the group, if you have not already logged into Webmin, Log on to the Webmin service interface on page 4-7.
   b. Click Configuration > MultiKM.
   c. Click Enable.
d. On the MultiKM Configuration screen, click Configure.

e. In Other Computers on the Change Configuration window, click the CIC Pro center that has a failed MultiKM license and click Remove to remove this CIC Pro center from the group.

3. Click Hide to hide the Multimouse application window.

4. Use the hotkey Ctrl + F1 to change the focus to the CIC Pro center where the keyboard and mouse is connected.

**CIC Pro center setup issues**

**Unable to communicate with a device**

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Ping.
3. In the *Address to Ping* field, type the IP address of a known device on the network and click *Ping*.

   If you receive a reply, then you are able to connect to the device.

4. If you do not receive a reply, perform a network integrity check. Run the Check Centrals utility and resolve any configuration errors. See Pre-configuration instructions on page 6-2.

**List full disclosure beds**

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click *Diagnostics > Full Disclosure*.

3. Click *FD List*.

   A typical listing includes the following data:
Set full disclosure mode

NOTE

You cannot change the full disclosure mode while the clinical application is running.

1. Stop the CIC Pro center application.
   a. From the multi-patient viewer, click Setup CIC.
   b. Click the Service Password tab.
   c. Type mms_com as the password and press Enter.
   d. At the Windows command line prompt, type stop and press Enter.

2. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

3. Click Diagnostics > Full Disclosure.

4. In the Full Disclosure Mode field, click On or Off to begin or end full disclosure mode.

5. Click Submit.
Troubleshooting

Ping full disclosure server

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Ping.

3. Type the address of the full disclosure server process you want to ping, in the format:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;UNIT|CIC| X.X.X.X:p]</td>
<td>Ping FDDataSvr (Database) process.</td>
</tr>
<tr>
<td>&quot;UNIT|CIC|</td>
<td>Ping FDSvr (control and acquisition) process.</td>
</tr>
</tbody>
</table>

4. Click Ping!

Display current system settings

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Configuration > Set Flags.

For information on changing these settings, refer to Configure set flags settings on page 6-23
Enable alarms

**WARNING**
CIC Pro center audible alarms will not sound for patients with bedside monitoring devices configured to *Operating Room* mode.

For instructions on enabling alarms, refer to the following procedures:

- Configure multiviewer alarm audio setting, if applicable on page 6-25
- Configure ADU alarm audio setting, if applicable on page 6-26

Admit Request Info button

**NOTE**

The ADT-Picklist license must be activated on the CIC Pro center before you can retrieve patient demographic information from a networked database.

If the *Admit Request Info* button is dimmed and unselectable and both ADT configurations are being run simultaneously, only the Prism IS information is accessible. You must choose to run only one ADT configuration. Two Admission Discharge Transfer (ADT) configurations can exist:

- Prism IS: Legacy existing technology.
- Picklist: CIC Pro center v5.0.x and later technology.

Display waveform indicators

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click *Diagnostics > Waveform Indicators*.

3. Click the appropriate option to change the waveform indicator value:
4. Click **Submit**.

5. If the waveforms are one of the colors listed in the following table, contact Technical Support.

<table>
<thead>
<tr>
<th>Waveform color</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>Missing data from the transmitter.</td>
</tr>
<tr>
<td>Dark green</td>
<td>Missing data from RX network.</td>
</tr>
<tr>
<td>Magenta</td>
<td>Missing data from the Receiver subsystem (Rack).</td>
</tr>
<tr>
<td>Orange</td>
<td>Missing data from Hardware Manager.</td>
</tr>
<tr>
<td>Light gray</td>
<td>Invalid telemetry data.</td>
</tr>
<tr>
<td>Cyan</td>
<td>Missing data from network.</td>
</tr>
<tr>
<td>White</td>
<td>Waveform re-sync.</td>
</tr>
<tr>
<td>Blue</td>
<td>Waveform buffer empty.</td>
</tr>
<tr>
<td>Red</td>
<td>Waveform buffer overflow.</td>
</tr>
<tr>
<td>Dark gray</td>
<td>Unknown error.</td>
</tr>
</tbody>
</table>

**Require age selection for admit**

For instructions on forcing age selection when admitting a pediatric patient, refer to **Configure force age setting, if applicable** on page 6-24.

**Licensing issues**

If you are installing a new CIC Pro center, see **Activate licenses (automatically) using a USB memory stick with the CIC Pro center** on page 6-10. If you are activating licenses at a later date, perform one of the following procedures:

- Activate licenses (automatically) via a service PC on page 8-16.
- Activate licenses (manually) via the Activation Code Summary Sheet on page 8-18.

**Activate licenses (automatically) via a service PC**

Use this procedure when the license activation codes are retrieved from a service PC via a USB memory stick, CD, or the service PC’s hard drive.
1. If you would like to configure the system via a service PC, complete the steps to set up the service PC’s network properties on page 4-8 and connect a crossover cable from the service PC’s Ethernet port to the CIC Pro center’s IX network port.

Otherwise, you can Log on to the CIC Pro center as Administrator on page 4-3.

**NOTE**

While there is no need to log in as administrator, the steps are provided here so that you do not have to toggle between different access modes.

2. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

3. Click **Configuration > Licensing**.

4. Scroll down to the bottom of the **Add/Remove Feature Activation Codes** window.

5. Click **Browse** and navigate to the location where you stored the `<Serial Number of CIC Pro center>.txt` license activation file on the service PC.

6. Click **Upload** to load the licenses on this CIC Pro center.

7. Store the media containing the `<Serial Number of CIC Pro center>.txt` file and the Activation Code Summary Sheet in a safe and accessible location. In the event of a system failure, the option activation codes are required for disaster recovery.
WARNINGS

LOSS OF MONITORING — Provide alternate patient monitoring or close observation before performing the system resource reset procedure. Beds displayed on the CIC Pro center will not be monitored during the system resource reset.

After system resource reset is complete and the monitoring function at the CIC Pro center has been restored (about 30 seconds), verify the correct monitoring state and alarm function.

8. Restart the CIC Pro center. See Perform safe restart of the CIC Pro center on page 8-30.

Activate licenses (manually) via the Activation Code Summary Sheet

Use this procedure when the license activation codes reside on the printed Activation Code Summary Sheet.

The printed Activation Code Summary Sheet that matches the serial number of the CIC Pro center you are the activating the options on is required.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Configuration > Licensing.
3. Next to the license you want to activate, type the activation code into the Activation Code field. See the Activation Code Summary Sheet.
4. Click Activate to activate the license on this CIC Pro center.

NOTE

To remove an activated license, click Remove next to the license you want to remove.
5. Repeat step 3 and step 4 until you have activated all of the purchased licenses.

6. Store the Activation Code Summary Sheet in a safe and accessible location. In the event of a hard drive failure, the option activation codes are required for disaster recovery.

7. Restart the CIC Pro center. For more information, refer to Perform safe shutdown of the CIC Pro center on page 8-31.

Remove an activated license

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Configuration > Licensing.

3. Next to the license you want to remove, click Remove.

Time zone, daylight saving time setting, and network time issues

Follow the Pre-configuration instructions on page 6-2.

PDF file access from MUSE

Because of changes to security restrictions with Windows XP OS Service Pack2, you must use <IP addresses> for the server location instead of the domain name.

Environment Monitor messages

When the CIC Pro center is experiencing limited or compromised system resources, the Environment Monitor displays one of the following messages.

<table>
<thead>
<tr>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply - VCCP out of range (X - X). Currently: X V.</td>
</tr>
<tr>
<td>Power supply - 1.8V out of range (X - X). Currently: X V.</td>
</tr>
<tr>
<td>Power supply - 3.3V out of range (X - X). Currently: X V.</td>
</tr>
<tr>
<td>Power supply - 5V out of range (X - X). Currently: X V.</td>
</tr>
<tr>
<td>Power supply - 12V out of range (X - X). Currently: X V.</td>
</tr>
<tr>
<td>Enclosure temperature out of range (X - X). Currently: X °C.</td>
</tr>
<tr>
<td>Message</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Hard Disk temperature out of range (X - X). Currently: X °C.</td>
</tr>
<tr>
<td>CPU temperature out of range (X - X). Currently: X °C.</td>
</tr>
<tr>
<td>Chassis Fan 1 speed out of range (X - X). Currently: X rpm. (MP100 platform)</td>
</tr>
<tr>
<td>Fan A speed out of range (X - X). Currently: X rpm. (Legacy platform)</td>
</tr>
<tr>
<td>Chassis Fan 2 speed out of range (X - X). Currently: X rpm. (MP100 platform)</td>
</tr>
<tr>
<td>Fan B speed out of range (X - X). Currently: X rpm. (Legacy platform)</td>
</tr>
<tr>
<td>Internal speaker is unplugged.</td>
</tr>
<tr>
<td>External speaker is unplugged.</td>
</tr>
<tr>
<td>Hard Disk Drive failure.</td>
</tr>
</tbody>
</table>

**CAUTION**
LIMITED DATA STORE IN FULL DISCLOSURE —If rotating the hard drive fails, the system can be used for patient monitoring, but with limitations on the amount of data stored in full disclosure, and provided that the hard drive be replaced within five days of hard drive failure notice on the CIC Pro center.

---

<table>
<thead>
<tr>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash Disk Drive failure. (MP100 platform)</td>
</tr>
<tr>
<td>Warning! System resources are running low. A Preventive Maintenance action is required.¹</td>
</tr>
<tr>
<td>Warning! Available system resources are running low. System restart is required to correct the problem. Patients will not be monitored at this Central while the System is restarting. If the system is not restarted now, it will restart automatically in approximately X minutes.²</td>
</tr>
</tbody>
</table>

¹The system resource indicator changes to yellow until this condition is resolved.

²The system resource indicator changes to red until this condition is resolved.

---

## Log files

### Download log files

When you contact GE Service, you may have to provide required log file information.

1. If you have not already logged onto Webmin, **Log on to the Webmin service interface on page 4-7**.

2. Click **Diagnostics > Logfiles**.
3. Click **Download Logs**.

4. Right-click the log file (in the format yyyymmddc.bfp) you would like to download and select **Save Target As to save the log file**.

   **NOTE**

   This log file contains the previous log files for up to 60 days. It does not contain today’s log file. To collect logs for today (current day), refer to Access current log files on page 8-21.

5. Send this log file to GE Service for further investigation.

### Access current log files

This feature allows the user to download the current day’s log files, which include up to a total of 60 days.

1. Log in as administrator. See Log on to the CIC Pro center as Administrator on page 4-3.

2. Log on to the Webmin service interface on page 4-7.

3. Click **Diagnostics > Logfiles**.
4. Click **Download Logs**.

5. Click **Package Current Logfiles**.

The job status information is displayed on the **Download Logs** window. A link to the current log files is added to the list of **Archived Logs**.
6. Right-click the log file (in the format yyyymmdd_hhmmssss.bfp) and select **Save Target As to save the log file**.

7. Send the log files to GE Service for further investigation.

**Application logs**

1. If you have not already logged onto Webmin, **Log on to the Webmin service interface on page 4-7**.

2. Click **Diagnostics > Logfiles > View Application Logs**.
3. Select the log files you want to view and click View Selected Files.

**NOTE**

To select multiple files, hold down the Ctrl key and click the files you want to view.

**Operating system event logs**

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Logfiles > View OS Event Logs.

3. From the Event Log drop-down list, select the type of event logs (Application, Security, or System) you want to view.

4. From the Number of entries drop-down list, select the number of entries you want to include in the log.

5. Click View.
Operating system Dr. Watson log

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Logfiles > View OS Dr. Watson Log.

Webmin action log

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Logfiles > View Webmin Action Log.

3. Select the applicable options to search for the user(s), module(s), time and date range you want to view.

4. Click Search.
Access additional runtime diagnostic information

Device driver information

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Diagnostics > Runtime Diagnostics > Device Driver Info.

Network information

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.
2. Click Diagnostics > Runtime Diagnostics > Network Info.
Operating system runtime statistics

1. If you have not already logged onto Webmin, log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Runtime Diagnostics > OS Runtime Stats.
Operating system service process information

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Runtime Diagnostics > OS Service Process Info.

Process information

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Runtime Diagnostics > Process Info.
Time zone information

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > Runtime Diagnostics > Timezone Info.

SMART drive status

Self-Monitoring, Analysis, and Reporting Technology (SMART) is a monitoring system for computer hard disks to detect and report various indicators of reliability. The tests you can execute from the SMART Drive Status window do not interfere with the normal functioning of the disk.

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Diagnostics > SMART Drive Status.
3. From the **SMART Drive Status** window, select the drive from the drop-down list and click **Show**.

4. Click on either the **Run Short Self Test** or the **Run Extended Self Test** button, depending on the test you want to execute.

   **NOTE**
   - The short self test typically takes a minute or two to complete.
   - The extended self test takes approximately one hour to complete.

5. Click **View Self Test Log** to view the logs resulting from the test.

**Perform safe restart of the CIC Pro center**

---

**WARNING**

If a USB memory stick (blank or containing data) is connected to the USB port of this device (CIC Pro center or ApexPro), you need to remove it prior to restarting the CIC Pro center. Otherwise, the system software may not restart.
Troubleshooting

CAUTION
During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

CAUTION
Stored data is never the latest data. Therefore, you must first verify the contents.

1. From the multi-patient viewer, click Setup CIC > Service Password.
2. Type mms_com and then press Enter.
3. At the c:\Program Files\Marquette\CIC\<version#> prompt, type stop and press Enter.
4. From the Windows taskbar, click Start > Shut Down > Restart and press Enter.

Perform safe shutdown of the CIC Pro center

CAUTION
During shutdown or while in administrator mode, beds displayed by the CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

CAUTION
EQUIPMENT DAMAGE OR DATA LOSS — Turn off the CIC Pro center power switch only when the message *It is now safe to turn off your computer* displays. Equipment damage or data loss can occur if this instruction is not followed.

1. From the multi-patient viewer, click Setup CIC > Service Password.
2. Type mms_com and then press Enter.
3. At the c:\Program Files\Marquette\CIC\<version#> prompt, type stop and press Enter.
4. From the Windows taskbar, click Start > Shut Down > Shut Down > OK.
5. When the message *It is now safe to turn off your computer* displays, you can turn off the CIC Pro center power switch.

NOTE
If no action is taken after the message *It is now safe to turn off your computer* displays, the system will automatically reboot in 2 minutes.
Change the logon password for Webmin

1. If you have not already logged onto Webmin, Log on to the Webmin service interface on page 4-7.

2. Click Configuration > Passwords.

3. On the Edit User Password window, type the new password in the Password field.

4. Retype the new password in the Confirm Password field and click Save.
9 Field replaceable units (FRUs)
Exploded views

Desktop

- Front bezel
- Fans
- Speakers
- Power supply FRU
- CPU
Field replaceable units (FRUs)

- Hard drive
- Flash drive
Rack-mount
Interconnect diagram

FRUs

For a list of FRUs and their corresponding part numbers, see Replacement procedures on page 9-8.

If you require additional information, schematics, or troubleshooting assistance, contact Technical Support.

Disaster recovery software kit and Service Tools CD

<table>
<thead>
<tr>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2040226-001</td>
<td>CIC MP100 V5.1 DISASTER RECOVERY SW KIT</td>
</tr>
<tr>
<td>2010433-047</td>
<td>SERVICE TOOLS CD</td>
</tr>
</tbody>
</table>

Accessories

<table>
<thead>
<tr>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>420650-005</td>
<td>CABLE ASSY 20 FT DVI-D SINGLE LINK</td>
</tr>
<tr>
<td>420650-009</td>
<td>ADPTR DVI (M) TO VGA ADAPTER</td>
</tr>
<tr>
<td>422310-001</td>
<td>MOUSE PAD</td>
</tr>
<tr>
<td>2001323-001</td>
<td>KOSS HDM/5 COMPUTER SPEAKERS</td>
</tr>
<tr>
<td>Part number</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>2006550-001</td>
<td>ADAPTER DB9F TO RJ-45</td>
</tr>
<tr>
<td>2016194-001</td>
<td>KIT CAT5E VIDEO SYSTEM 0-360FT 1 REMOTE VIEW</td>
</tr>
<tr>
<td>2016194-002</td>
<td>KIT CAT5E VIDEO SYSTEM 0-360FT 2 REMOTE VIEW</td>
</tr>
<tr>
<td>2016194-003</td>
<td>KIT CAT5E VIDEO SYSTEM 0-360FT 3 REMOTE VIEW</td>
</tr>
<tr>
<td>2016194-004</td>
<td>KIT CAT5E VIDEO SYSTEM 0-360FT 4 REMOTE VIEW</td>
</tr>
<tr>
<td>2016195-001</td>
<td>KIT CAT5E VIDEO SYSTEM 360-800FT 1 REMOTE VIEW</td>
</tr>
<tr>
<td>2016195-002</td>
<td>KIT CAT5E VIDEO SYSTEM 360-800FT 2 REMOTE VIEW</td>
</tr>
<tr>
<td>2016195-003</td>
<td>KIT CAT5E VIDEO SYSTEM 360-800FT 3 REMOTE VIEW</td>
</tr>
<tr>
<td>2016195-004</td>
<td>KIT CAT5E VIDEO SYSTEM 360-800FT 4 REMOTE VIEW</td>
</tr>
<tr>
<td>2022038-001</td>
<td>PWR SPLY UPS 600VA 120 VOLTS</td>
</tr>
<tr>
<td>2022038-002</td>
<td>PWR SPLY UPS SMK 600VA 220 VOLTS</td>
</tr>
<tr>
<td>2022038-003</td>
<td>PWR SPLY UPS SMK 2000VA 120 VOLTS</td>
</tr>
<tr>
<td>2022144-002</td>
<td>USB MOUSE OPTICAL SCROLL LIGHTED</td>
</tr>
<tr>
<td>2028077-002</td>
<td>1GB USB 2.0 MEMORY STICK (UNFORMATTED)</td>
</tr>
</tbody>
</table>

### Power cables

<table>
<thead>
<tr>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>80274-006</td>
<td>CORD PWR 125V 6FT STR</td>
</tr>
<tr>
<td>401855-001</td>
<td>PWR SPLY CRD RA CONT Euro 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-002</td>
<td>PWR SPLY CRD RA British 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-003</td>
<td>PWR SPLY CRD RA Italian 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-004</td>
<td>PWR SPLY CRD RA Israeli 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-005</td>
<td>PWR SPLY CRD ST Harness 10A 125V 2M</td>
</tr>
<tr>
<td>401855-006</td>
<td>PWR SPLY CRD ST Harness 10A 250V 2M</td>
</tr>
<tr>
<td>401855-007</td>
<td>PWR SPLY CRD RA Swiss 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-008</td>
<td>PWR SPLY CRD RA Indian 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-009</td>
<td>PWR SPLY CRD RA Danish 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-010</td>
<td>PWR SPLY CRD RA Australian 10A 250V 2.5M</td>
</tr>
<tr>
<td>401855-018</td>
<td>PWR CRD ST CHINA RA PLUG 10A 250V 2.5M</td>
</tr>
<tr>
<td>405535-014</td>
<td>PWR SPLY CRD ST-ST PSE 10A 250V 12FT</td>
</tr>
</tbody>
</table>
Keyboard kits

<table>
<thead>
<tr>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012217-037</td>
<td>KYBD KIT CIC USB WIN95-POLISH</td>
</tr>
<tr>
<td>2012217-038</td>
<td>KYBD KIT CIC USB WIN95-HUNGARIAN</td>
</tr>
<tr>
<td>2012217-021</td>
<td>KYBD KIT CIC USB ENG US</td>
</tr>
<tr>
<td>2012217-022</td>
<td>KYBD KIT CIC USB WIN95-BELGIAN</td>
</tr>
<tr>
<td>2012217-023</td>
<td>KYBD KIT CIC USB WIN95-DANISH</td>
</tr>
<tr>
<td>2012217-024</td>
<td>KYBD KIT CIC USB WIN95-ENG EU</td>
</tr>
<tr>
<td>2012217-025</td>
<td>KYBD KIT CIC USB WIN95-ENG UK</td>
</tr>
<tr>
<td>2012217-026</td>
<td>KYBD KIT CIC USB WIN95-FRENCH</td>
</tr>
<tr>
<td>2012217-027</td>
<td>KYBD KIT CIC USB WIN95-GERMAN</td>
</tr>
<tr>
<td>2012217-028</td>
<td>KYBD KIT CIC USB WIN95-NORWEGIAN</td>
</tr>
<tr>
<td>2012217-029</td>
<td>KYBD KIT CIC USB WIN95-SPANISH</td>
</tr>
<tr>
<td>2012217-030</td>
<td>KYBD KIT CIC USB WIN95-SWISS</td>
</tr>
<tr>
<td>2012217-031</td>
<td>KYBD KIT CIC USB WIN95-CZECH</td>
</tr>
<tr>
<td>2012217-032</td>
<td>KYBD KIT CIC USB WIN95-DUTCH</td>
</tr>
<tr>
<td>2012217-033</td>
<td>KYBD KIT CIC USB WIN95-RUSSIAN</td>
</tr>
<tr>
<td>2012217-034</td>
<td>KYBD KIT CIC USB WIN95-SWED/FIN</td>
</tr>
<tr>
<td>2012217-035</td>
<td>KYBD KIT CIC USB WIN95-ITALIAN</td>
</tr>
<tr>
<td>2012217-036</td>
<td>KYBD KIT CIC USB WIN95-PORTUGUESE</td>
</tr>
</tbody>
</table>

Replacement procedures

**WARNING**
REPAIR TO THE FRU LEVEL — Field repairs are recommended to the FRU only. Attempting a field repair on a PCB or a factory-sealed component or assembly could jeopardize the safe and effective operation of the device.

**WARNING**
DISCONNECTION FROM MAINS — When disconnecting the system from the power line, remove the plug from the wall outlet first. Then you may disconnect the power cord from the device. If you do not observe this sequence, there is a risk of coming into contact with line voltage by inserting metal objects, such as the pins of leadwires, into the sockets of the power cord by mistake.
NOTE

GE recommends that you assemble the devices using the new hardware (screws, washers, etc.) provided in the FRU. Some hardware (e.g., screws with a thread locking coating) are not intended for re-use.

NOTE

During disassembly, note the positions of wires, cables, and different sized screws; labeling them if necessary to ensure they are replaced correctly.

Use the following table as a checklist for replacing FRUs for the CIC Pro center:

<table>
<thead>
<tr>
<th>ID on assembly diagrams¹</th>
<th>Part number</th>
<th>Description</th>
<th>Replacement and checkout procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2039793-002</td>
<td>FRU MP100 CPU PCB</td>
<td>Replacing the CPU PCB (mother board) on page 9-14.</td>
</tr>
<tr>
<td>2</td>
<td>2039793-003</td>
<td>FRU MP100 FAN</td>
<td>Replacing the fan on page 9-21.</td>
</tr>
<tr>
<td>3</td>
<td>2039793-004</td>
<td>FRU MP100 DUAL SPEAKERS</td>
<td>Replacing the dual speakers on page 9-22.</td>
</tr>
<tr>
<td>4</td>
<td>2039793-005</td>
<td>FRU MP100 POWER SUPPLY</td>
<td>Replacing the power supply on page 9-20.</td>
</tr>
<tr>
<td>5</td>
<td>2039793-006</td>
<td>FRU MP100 SATA DRIVE CABLES</td>
<td>Replacing the SATA drive cables on page 9-19.</td>
</tr>
<tr>
<td>6</td>
<td>2039793-009</td>
<td>FRU MP100 120G SATA HD</td>
<td>Replacing the hard drive on page 9-17.</td>
</tr>
<tr>
<td>7</td>
<td>2039793-010</td>
<td>FRU MP100 8G SATA FLASH DRIVE</td>
<td>Replacing the flash drive on page 9-18.</td>
</tr>
<tr>
<td>8</td>
<td>2039793-008</td>
<td>FRU MP100 FRONT BEZEL (Desktop unit only)</td>
<td>Replacing the front bezel on page 9-23.</td>
</tr>
<tr>
<td>not pictured</td>
<td>2039793-007</td>
<td>FRU MP100 HARDWARE</td>
<td>Since this FRU contains screws, etc., no specific procedure is provided.</td>
</tr>
<tr>
<td>not pictured</td>
<td>2020183-006</td>
<td>FRU CIC PRO 4A SB FUSES</td>
<td>Replacing the fuse on page 9-22.</td>
</tr>
</tbody>
</table>

¹These numbers are shown on the following desktop and rack-mount assemblies.

Desktop assembly

Refer to Replacement procedures on page 9-8 for a description of the parts referenced in the following diagram.
Rack-mount assembly

Refer to Replacement procedures on page 9-8 for a description of the parts referenced in the following diagram.
Common replacement procedures

The following procedures are standard for all FRUs:

- Follow the electrostatic discharge (ESD) precautions on page 9-11.
- Prepare the unit for disassembly on page 9-12.
- Remove the cover on page 9-13.

Follow the electrostatic discharge (ESD) precautions

**WARNING**
PERSONAL INJURY OR EQUIPMENT DAMAGE — Follow these precautions whenever performing disassembly. Failure to follow this instruction could result in serious injury or product/property damage.

All external connector inputs and outputs of the device are protected from electrostatic discharge (ESD) damage. However, if the interior of the device needs to be accessed for any reason, internal components and assemblies are susceptible to ESD damage. This includes human hands, non-ESD protected work stations, and improperly grounded test equipment.
The following guidelines help make a service workstation more resistant to ESD damage:

- Discharge any static charge you may have built up before handling semiconductors or assemblies containing semiconductors. This can be done by touching any bare metal on the CIC Pro center chassis, the cable connector jacks or the ground post on the back of the unit. Do this frequently and repeatedly while working on the unit.
- Wear a grounded, antistatic wristband (3M part number 2046 or equivalent) or heel strap at all times while handling or repairing assemblies containing semiconductors.
- Use properly grounded test equipment.
- Use a static-free work surface (3M part number 8210 or equivalent) while handling or working on assemblies containing semiconductors.
- Keep the work surface free of nonconducting materials such as ordinary plastic assembly aids and foam packing.
- Do not remove assemblies containing semiconductors from antistatic containers (Velo-stat bags) until absolutely necessary.
- Make sure power to an assembly is turned off before removing or inserting a semiconductor.
- Do not slide electrical/electronic assemblies across any surface.
- Semiconductors and electrical/electronic assemblies should be stored only in antistatic bags or boxes.

These guidelines cannot guaranty a 100% static-free workstation, but greatly reduce the potential for failure of any electrical/electronic assemblies due to electrostatic discharge.

Prepare the unit for disassembly

1. Perform safe shutdown of the CIC Pro center on page 8-31.

   **CAUTION**
   During shutdown or while in administrator mode, beds displayed by this CIC Pro center will be unmonitored if not displayed by a different CIC Pro center.

2. Turn off the power to the CIC Pro center.

3. Unplug the AC power cord from the processor box and from the electrical wall outlet.

   **WARNING**
   DISCONNECTION FROM MAINS — When disconnecting the system from the power line, remove the plug from the wall outlet first. Then you may disconnect the power cord from the device. If you do not observe this sequence, there is a risk of coming into contact with line voltage by inserting metal objects, such as the pins of leadwires, into the sockets of the power cord by mistake.
WARNING
The CIC Pro center remains energized after AC power is removed. Wait 30 seconds before proceeding.

4. Turn off the power to all connected peripheral devices.
5. Label, then disconnect all peripheral cables and telecommunication lines connected to the connectors or ports on back of the processor box.
6. Follow the electrostatic discharge (ESD) precautions on page 9-11.

Remove the cover

WARNING
SHOCK HAZARD —Whenever the cover is removed, you can disrupt internal components and potentially disrupt proper power or ground connections. The potential for electric shock exists. When the cover is replaced, perform Electrical safety tests on page 10-6 and FRU checkout procedures on page 7-10.

Desktop
1. Prepare the unit for disassembly on page 9-12.
2. Remove the eight screws that connect the cover to the sides of the chassis (retain the screws).
3. Lift the cover off the chassis.

Rack-mount
1. Prepare the unit for disassembly on page 9-12.
2. Remove the four screws that connect the cover to the back of the chassis (retain the screws).
3. Lift the cover off the chassis.

Replacing the CPU PCB (mother board)

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Remove the speaker cable from the CPU PCB.
4. Remove the two SATA cables from the CPU PCB.
5. Remove the LED light pipe from the CPU PCB.
6. Remove the power supply cable from the CPU PCB.
7. Remove the two fan cables from the CPU PCB.
8. Remove the two serial cables from the CPU PCB.
9. Remove the four screws that connect the DVI ports to the chassis (retain the screws).
10. Remove the six screws that connect the CPU PCB to the chassis (retain the screws).
11. Replace the CPU PCB.

**NOTE**

Do not discard the memory cards (qty 2) and battery.

12. Reverse steps to re-assemble the CPU.
13. Replace the original memory cards (qty 2) and battery.
15. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Perform time adjustment. See Set the time-of-day or the date on page 6-69.
CAUTION

NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

- Check the status of installed licenses on page 7-4.
- Check access to all other care units on page 7-6.
- Check the pressures unit-of-measure on page 7-7 (for Chinese applications only).
- Verify that the Remote Service agent is enabled. See Enable or disable the Remote Service Agent on page 6-18.
- Check the laser printer connectivity. See Check status of installed printers on page 7-3.
- Check the digital writer printer connectivity. See Check status of installed printers on page 7-3.
- Check MultiKM (Multimouse) operation on page 7-8.
- Check full disclosure report printing on page 7-9.
- Check read and write integrity of hard drive and solid state flash drive on page 7-10.
- Check audio component operation on page 7-16.
- Check integrity of system files on page 7-20.
- Check operation of the secondary display on page 7-4.
- Check COMM ports on page 7-13.
- Check BIOS information on page 7-13.
- Check drive operation information (Flash drive and hard drive) on page 7-14.
- Check operation of the Watchdog countdown function on page 7-18.
- Check video function and status of video card and drivers on page 7-19.
- Check internal hardware temperature and voltage status on page 7-12.
- Check system resources. See Environment Monitor messages on page 8-19.
- Verify that the power LED is on after the unit is powered up.

NOTE

Do not re-image the Flash drive or hard drive after replacing the CPU PCB.

Replacing the CPU battery

Once the battery is replaced, the system loses its time and the time must be reset before connecting the CIC Pro center to the existing CARESCAPE Network.
WARNING
DATA LOSS—It is required that you set the time as close as possible to any other device on the CARESCAPE Network before connecting the CIC Pro center to the existing CARESCAPE Network. Otherwise, abrupt data loss may occur and CIC Pro center performance may be corrupted.

NOTE
This part is not stocked by GE service and can be purchased from your local store. When purchasing from a retail supplier, use the specification number on the battery to ensure an equivalent battery is purchased.

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Push the battery latch away from the battery until the battery pops loose and remove the battery.
4. Replace the battery.
5. Reverse steps to re-assemble.
7. Set the time on the CIC Pro center as close as possible to any other device on the CARESCAPE Network.

CAUTION
NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

8. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Check access to all other care units on page 7-6.
   - Verify that the power LED is on after the unit is powered up.
Replacing the hard drive

**CAUTION**
NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Remove the power cable from the hard drive.
4. Remove the SATA cable from the hard drive.
5. Loosen the four screws that connect the hard drive to both sides of the mounting bracket.

**NOTE**
The mounting bracket holds both the hard drive and the Flash drive. The hard drive is on the top; the Flash drive on the bottom.

6. Slide the hard drive out of the mounting bracket.
7. Replace the hard drive.
8. Reverse steps to re-assemble.
10. Re-image the system. See option 2 on page 11-5.
11. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Check read and write integrity of hard drive and solid state flash drive on page 7-10.
Replacing the flash drive

CAUTION
NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Remove the power cable from the hard drive.
4. Remove the SATA cable from the hard drive.
5. Remove the power cable from the Flash drive.
6. Remove the SATA cable from the Flash drive.
7. Loosen the four screws that connect the Flash drive to both sides of the mounting bracket.

NOTE
The mounting bracket holds both the hard drive and the Flash drive. The hard drive is on the top; the Flash drive on the bottom.

8. Slide the Flash drive out of the mounting bracket.
9. Replace the Flash drive.
10. Reverse steps to re-assemble.
12. Re-image the Flash drive. See option 1 on page 11-5.
13. Configure the system as necessary as described in Configuration on page 6-1.

**NOTE**

If the System Resource Indicator turns yellow or red during configuration, refer to Environment Monitor messages on page 8-19.


**Replacing the SATA drive cables**

---

**CAUTION**

NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

---

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Remove the two SATA cables that connect to the PCB CPU.
4. Remove the two SATA cables that connect to the hard and Flash drives.
5. Replace the SATA cables.
7. Perform the following checkout procedures:
   - For the HDD SATA:
     - Perform Ground continuity test on page 10-6.
     - Perform Ground (earth) wire leakage current test on page 10-7.
     - Perform Enclosure leakage current test on page 10-8.
     - Check read and write integrity of hard drive and solid state flash drive on page 7-10.
     - Check drive operation information (Flash drive and hard drive) on page 7-14.
     - Check system resources. See Environment Monitor messages on page 8-19.
   - For the Flash drive SATA:
     - Perform Ground continuity test on page 10-6.
     - Perform Ground (earth) wire leakage current test on page 10-7.
     - Perform Enclosure leakage current test on page 10-8.
     - Check read and write integrity of hard drive and solid state flash drive on page 7-10.
     - Check integrity of system files on page 7-20.
     - Check system resources. See Environment Monitor messages on page 8-19.
- Verify that the power LED is on after the unit is powered up.

**Replacing the power supply**

---

**WARNING**

POWER SUPPLY—The device must be connected to a properly installed power outlet with protective earth contacts only. If the installation does not provide for a protective earth conductor, disconnect the monitor from the power line and operate it on battery power, if possible.

GE recommends the use of an Uninterrupted Power Supply (UPS) with the CIC Pro center. If a UPS is not used, improper shutdowns of the system could result in the event of a power outage and cause a lengthy disk scan procedure when the unit reboots. You could also lose data in the event of a power outage if you do not use a UPS.

All devices of a system must be connected to the same power supply circuit. Devices which are not connected to the same circuit must be electrically isolated when operated.

---

**WARNING**

SHOCK HAZARD—Never touch components inside the power supply. There are no field-serviceable components in the power supply. Capacitors in the power supply present a shock hazard even when the power is off.

---

**CAUTION**

BURNS—During operation, the power supply can become hot enough to cause severe burns. Allow the power supply to thoroughly cool before disassembly.

---

**CAUTION**

NETWORK DEVICE TIME SYNCHRONIZATION—When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

---

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Remove the power supply cable that connects to the PCB CPU from the power supply PCB.
4. Remove the AC power cable that connects to the power supply.

5. Remove the four screws that connect the power supply to the chassis (retain the screws).

6. Replace the power supply.

7. Reverse steps to re-assemble.


9. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Check internal hardware temperature and voltage status on page 7-12.
   - Verify that the power LED is on after the unit is powered up.

Replacing the fan

---

**CAUTION**

NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

---

**NOTE**

There are two internal fans. Either can be replaced independently.

1. Prepare the unit for disassembly on page 9-12.

2. Remove the cover on page 9-13.

3. Remove the two fan cables from the CPU PCB.

4. Remove the two screws that connect the fan to the back of the chassis (retain the screws).

5. Replace the fan.

6. Reverse steps to re-assemble.


8. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Check internal hardware temperature and voltage status on page 7-12.
Check processor fan status on page 7-19.
Verify that the power LED is on after the unit is powered up.

Replacing the dual speakers

**CAUTION**

NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Remove the speaker cable from the CPU PCB.
4. Remove the two screws that connects the speaker to the mounting bracket (retain the screws).
5. Replace the dual speaker assembly.
6. Reverse steps to re-assemble.
8. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Check operation of audible alarm tones on page 7-6.
   - Check audio component operation on page 7-16.
   - Check speaker status on page 7-17.
   - Verify that the power LED is on after the unit is powered up.

Replacing the fuse

**CAUTION**

NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.
NOTE

Do not touch fuses with bare hands. Oils and acids on your skin can reduce fuse life. Wear gloves or use a clean, dry cloth to handle the fuses.

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Pry open the latch on the top of the fuse door.
4. Pry the fuse drawer out of the unit.
5. Remove the defective fuse(s).
6. Replace the fuse(s).
7. Reverse steps to re-assemble.
9. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Check internal hardware temperature and voltage status on page 7-12.
   - Verify that the power LED is on after the unit is powered up.

Replacing the front bezel

CAUTION

NETWORK DEVICE TIME SYNCHRONIZATION — When adding a new device (e.g., CIC Pro center) to the CARESCAPE Network, the existing devices on the CARESCAPE Network will synchronize to the new device’s time. To prevent potential time synchronization issues, you should set the new device’s time to be as close as possible to the time (within a few seconds) used by the existing GE devices on the CARESCAPE Network.

NOTE

Desktop units only.

1. Prepare the unit for disassembly on page 9-12.
2. Remove the cover on page 9-13.
3. Remove the two screws that connect the bezel to the chassis (retain the screws).
4. Remove the LED light pipe from the PCB CPU.
5. Push the three plastic bezel tabs and lift the bezel off the chassis.
6. Replace the bezel.
7. Reverse steps to re-assemble.

9. Perform the following checkout procedures:
   - Perform Ground continuity test on page 10-6.
   - Perform Ground (earth) wire leakage current test on page 10-7.
   - Perform Enclosure leakage current test on page 10-8.
   - Perform general visual inspection. See Visual inspection on page 10-3.
   - Inspect fans and power supply.
   - Inspect connectors.
   - Inspect cable insulation.
   - Clean internal components. See Internal components on page 10-5.
   - Clean fans.
   - Clean filters.
   - Check access to all other care units on page 7-6.
   - Verify that the power LED is on after the unit is powered up.

Re-assemble the cover

---

**WARNING**

SHOCK HAZARD — Whenever the cover is removed, you can disrupt internal components and potentially disrupt proper power or ground connections. The potential for electric shock exists. When the cover is replaced, perform Electrical safety tests on page 10-6 and FRU checkout procedures on page 7-10.

---

Re-assemble the cover on the desktop

1. Slide the cover over the chassis.
2. Replace the eight screws that connect the cover to the sides of the chassis.
3. If you did replace any parts after opening up the cover, you will have to perform Electrical safety tests on page 10-6 and FRU checkout procedures on page 7-10.

Re-assemble the cover on the rack-mount

1. Slide the cover into the chassis.
2. Replace the four screws that connect the cover to the back of the chassis.
3. If you did replace any parts after opening up the cover, you will have to perform Electrical safety tests on page 10-6 and FRU checkout procedures on page 7-10.
10 Preventive maintenance
Maintenance schedule

**WARNING**
Failure to implement a satisfactory maintenance schedule may result in equipment failure and present health hazards. The sole responsibility for performing the recommended maintenance schedule rests with the individuals, hospitals, or institutions utilizing the device. The manufacturer does not in any manner assume the responsibility for performing the recommended maintenance schedule, unless an Equipment Maintenance Agreement exists. GE service personnel may, at their discretion, follow the procedures provided in this manual as a guide during visits to the equipment site.

To make sure the CIC Pro center hardware remains in proper operational and functional order, a proper maintenance schedule must be observed. GE recommends that maintenance be performed by service personnel upon installation, every 12 months after original installation, and each time the unit is serviced.

In addition, the following preventative maintenance should be performed:

- Perform periodic calibration of bedside monitors by a satisfactory maintenance schedule.
- Test UPS yearly to confirm it meets at least 80% of rated capacity.
- Perform the SMART Run Short Self-Test at least once during product preventative maintenance. Once the test has fully completed, verify that the Passed drive check? is Yes. If the Passed drive check? is No, then the hard drive should be replaced.
- It is recommended to replace the system's hard drive once every three years.

**Checklist**

Use the following checklist to ensure completion of all preventive maintenance and checkout procedures.

- Visual inspection on page 10-3.
- Cleaning on page 10-3.
- Power source tests on page 10-6.
- Electrical safety tests on page 10-6.
- Check the operation of input devices and displays on page 10-10.
- Perform checkout procedures on page 10-10.
Visual inspection

- General condition: Carefully inspect the equipment for physical damage to the case, the display screen, and the controls. Do not use the equipment if damage is determined. Refer damaged equipment to qualified service personnel.
- Connectors: Inspect all external connectors for damaged pins, prongs and connector housings. Refer damaged equipment to qualified service personnel for repair. Ensure that all connections are properly seated and secure.
- Cable insulation: Inspect all external cables, insulation, strain-reliefs and connectors for damage, cracks or degradation. Refer damaged equipment to qualified service personnel for repair.
- Display: Inspect the display face for marks, scratches, or other damage. Physical damage to a touchscreen face may jeopardize its performance. Replace if necessary.
- Fans: Inspect all cooling fans in the CIC Pro center to make sure they are in good working order and are not clogged with dust. These fans draw outside air into the unit to cool internal components.
- Safety labels and inscriptions: Check that safety labels and inscriptions on the device are clearly legible.
- Mounting hardware: Check for loose or missing screws on the mounting hardware.

Cleaning

---

**CAUTION**

Never immerse the device in any liquid.

---

**CAUTION**

Do not pour or spray any liquid directly on the device or permit fluid to seep into connections or openings.

---

**CAUTION**

Never use conductive solutions, solutions that contain chlorides, wax, or wax compounds to clean the device.

---

**CAUTION**

Never autoclave or steam clean the device.
Preventive maintenance

CAUTION
Never use solutions or products that contain the following:

- Any type of Ammonium Chloride such as, but not limited to, Dimethyl Benzyl Ammonium Chloride and Quaternary Ammonium Chloride solutions
- Abrasive cleaners or solvents of any kind
- Acetone
- Keytone
- Betadine
- Alcohol-based cleaning agents
- Sodium salts

The following consequences can occur if you do not follow the cautionary guidelines when cleaning the equipment:

- Product discoloration.
- Melting, dulling, or distorting of the device case.
- Brittle and breaking device case.
- Blurring the lettering on label text.
- Equipment malfunction or failure.
- Void warranty.

Cleaning products known to cause the types of problems listed previously include, but are not limited to:

- Sani-Cloth® Wipes
- Ascepti® Wipes
- HB Quat®
- Clorox® Wipes (they do not contain bleach)
- Over-the-counter detergents (e.g., Fantastic®, Tilex®, etc.)

Products that contain active ingredients and solutions similar to these products should be avoided.

External surfaces

NOTE
Any contact of the disinfectant solutions with metal parts may cause corrosion.

Clean the exterior surface as required in compliance with your institution’s infection control and biomedical engineering department.

1. For cleaning all displays, including touchscreen and standard displays, you may turn off the power to the touchscreen and standard displays before you start cleaning the displays.

2. For cleaning the equipment, wipe the exterior with a soft lint-free cloth, using the following solution as recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996):
NOTE
The GE service personnel will not be carrying these items.

- Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free chlorine) and a maximum 1:10 dilution.
- Any sodium hypochlorite wipe product that meets the above guidelines can be used.

3. Wipe off cleaning solutions with a clean, lightly moistened cloth. Wring excess disinfectant from wipe before using.

4. Dry thoroughly with a dry lint-free cloth and let air dry for at least 30 minutes.

NOTE
Drying times may vary based on the environmental conditions.

5. Take care not to let fluid pool around connection pins. If this should happen, blot dry with a soft lint-free cloth.

6. Do not use excessive drying techniques, such as oven, forced heat, or sun drying.

Internal components

CIC Pro center

WARNING
In order to remove power from the CIC Pro center, disconnect the power cord from the wall outlet. The power switch on the back panel of the processor box does not disconnect the CIC Pro center from AC power.

Additionally, wait 40 seconds after disconnecting the CIC Pro center power cord from the wall outlet. The unit remains energized for a period of time after shutdown.

The fan, fan intakes, and internal components require cleaning to remove accumulated dust.

1. Perform safe shutdown of the CIC Pro center on page 8-31.
2. Disconnect all peripheral devices from the CIC Pro center.
3. Turn off and unplug all equipment.
4. Remove the CIC Pro center cover.
5. Clean as necessary.
6. Replace the CIC Pro center cover.
Power source tests

Power outlet test

Verify with the facilities or biomedical maintenance department that the power outlet is wired correctly per the country’s electrical code standard before starting the following electrical safety tests. The results of the safety tests will be inaccurate unless a properly wired power outlet is used.

Power cord and plug test

Verify the power cord being used with the monitor is good. This can be accomplished following the Ground continuity test on page 10-6.

- Failure of the power cord strain relief is very common. Often times users of the equipment pull on the power cord itself, rather than the power cord plug, to unplug the monitor from a power outlet. If in doubt, test for continuity through each conductor of the power cord connector and plug.
- Verify line, neutral, and ground conductors are properly connected to the power cord plug and are not short-circuited. Rewire and tighten these, or replace the power cord, as necessary.

Electrical safety tests

Electrical safety tests provide a method of determining if potential electrical health hazards to the patient or operator of the device exist.

Electrical safety tests may be performed under normal ambient conditions of temperature, humidity, and pressure.

The recommended test equipment is listed below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leakage current tester</td>
<td>Equivalent to the circuits shown</td>
</tr>
<tr>
<td>Digital multimeter (DMM)</td>
<td>AC volts, ohms</td>
</tr>
<tr>
<td>Ground bond tester</td>
<td>0 – 1 ohm</td>
</tr>
</tbody>
</table>

Ground (earth) integrity

Listed below are two methods for checking the ground (earth) integrity. These tests determine whether the device's exposed metal and power inlet's earth (ground) connection has a power ground fault condition. Perform the test method that is required by your country/local governing safety organization.

Ground continuity test

1. Disconnect the CIC Pro center under test from the power outlet.
2. Connect the negative (-) lead of the DMM to the protective earth terminal (ground pin in power inlet connector) or the protective earth pin in the Mains plug (ground pin in power cord).

3. Set the DMM to the milliohm (mW) range.

4. Connect the positive (+) lead of the DMM to the equipotential plug on the CIC Pro center.

5. Resistance must read:
   - 0.1 ohm or less without power cord
   - 0.2 ohms or less with power cord

**Impedance of protective earth connection test**

This test, unlike a ground continuity test, will also stress the ground system by using special ground bond testers. This test normally is only required as a manufacturing production test to receive safety agency compliance. Some country agencies do require this test after field equipment repairs (i.e., Germany's DIN VDE 0751 standards). Consult your country/local safety agency if in question.

1. A current of 25A from a current source with a frequency of 50 or 60 Hz with a no-load voltage not exceeding 6 V is passed for at least 5 s through the protective earth terminal or the protective earth pin in the mains plug and each accessible metal part which could become live in case of failure in basic insulation.

2. The voltage drop between the parts described is measured and the impedance determined from the current and voltage drop. It shall not exceed the values indicated.

For equipment without a power supply cord the impedance between the protective earth terminal and any accessible metal part which is protectively earthed shall not exceed 0.1 ohms.

For equipment with a power supply cord, the impedance between the protective earth pin in the mains plug and any accessible metal part which is protectively earthed shall not exceed 0.2 ohms.

When taking this measurement, move the unit's power cord around. There should be no fluctuations in resistance.

**Ground (earth) wire leakage current test**

**NOTE**

The DMM plus leakage tester network shown is the circuitry defined by the IEC/EN/UL 60601-1 standard for measuring leakage current.

Perform this test to measure current leakage through the ground (earth) wire of the equipment during normal operation.
1. Configure the leakage tester like the circuit shown below.

![Circuit Diagram]

2. Connect the power cord of the device under test to the power receptacle on the leakage tester.

3. The device under test is to be tested at its normal operating voltage.

4. Set the power switch of the device under test to **ON**.

5. Read the current leakage indicated on DMM.

6. Set the polarity switch on the leakage tester to **RVS** (reverse).

7. Read the current leakage indicated on DMM.

**NOTE**

If either reading is greater than the appropriate specification below, the device under test fails. Contact GE Technical Support.

- 300 µA (0.3 volts on the DMM), and the device under test is powered from 100-120 V/50-60 Hz
- 300 µA (0.3 volts on the DMM), and the device under test is powered from a centered-tapped 200-240 V/50-60 Hz, single-phase circuit
- 500 µA (0.5 volts on the DMM), and the device under test is powered from a non-center-tapped, 200-240 V/50-60 Hz, single-phase circuit

**NOTE**

Center-tapped and non-center-tapped supply circuits produce different leakage currents and the UL and IEC limits are different.

8. Set the power switch of the device under test to **OFF**.

**Enclosure leakage current test**

Perform this test to measure current leakage through exposed conductive surfaces on the device under test during normal operation.
1. Configure the leakage tester like the circuit shown below with GND switch OPEN and polarity switch NORM.

![Leakage Tester Diagram]

2. Connect probe to an unpainted, non-anodized chassis ground on the unit under test.

3. Set the power switch of the device to ON.

4. Read the current leakage indicated on DMM.

**NOTE**

Center-tapped and non-center-tapped supply circuits produce different leakage currents and the UL and IEC limits are different.

5. Set the polarity switch to RVS.

6. Read the current leakage indicated on DMM.

**NOTE**

If either reading is greater than the appropriate specification below, the device under test fails. Contact GE Technical Support.

- 300 µA (0.3 volts on the DMM), and the device under test is powered from 100-120 V/50-60 Hz
- 300 µA (0.3 volts on the DMM), and the device under test is powered from a centered-tapped 200-240 V/50-60 Hz, single-phase circuit
- 500 µA (0.5 volts on the DMM), and the device under test is powered from a non-center-tapped, 200-240 V/50-60 Hz, single-phase circuit

7. Set the GND switch on the leakage tester to CLOSED.

8. Read the current leakage indicated on DMM.

9. Set the polarity switch to RVS.

10. Read the current leakage indicated on DMM.

100 µA (0.1 volts on the DMM), and the device under test is powered from 100-240 V/50-60 Hz
Preventive maintenance

NOTE

If the reading is greater than the specification below, and the device under test is powered from 100-240 V/50-60 Hz, the device under test fails. Contact GE Technical Support.

11. Set the power switch of the device under test to **OFF**.

Test completion

1. Disconnect the leakage tester from the power outlet.
2. Disconnect all test equipment from the device.
3. Disconnect the device power cord from the leakage tester.

Check the operation of input devices and displays

1. Check the keyboard. If any keys stick, or are otherwise non-functional, replace the keyboard.
2. Check the mouse to make sure the cursor follows mouse movements smoothly and the mouse buttons function properly.
3. Check the display to make sure it meets proper operation requirements. Refer to the operating instructions packaged with each display to check for (and adjust if necessary) the following operational requirements:
   - Proper contrast and color for best viewing in the environment where used.
   - Proper screen focus.
   - Correct horizontal and vertical linearity.
   - Correct horizontal and vertical position.

Perform checkout procedures

If you replaced any part, follow the appropriate instructions as listed for that part.

- [ ] Check date and time on the network after maintenance of this current device. See Pre-configuration instructions on page 6-2.
- [ ] Verify that the Remote Service agent is enabled. See Enable or disable the Remote Service Agent on page 6-18.
- [ ] Check the laser printer connectivity. See Check status of installed printers on page 7-3.
- [ ] Check the digital writer connectivity. See Check status of installed printers on page 7-3.
- [ ] Check operation of the secondary display on page 7-4 (if applicable).
- [ ] Check the status of installed licenses on page 7-4.
- [ ] Verify settings with Check Centrals command on page 7-5.
- [ ] Check operation of audible alarm tones on page 7-6.
☐ Check access to all other care units on page 7-6.
☐ Check the operation of the Citrix application viewed at the CIC Pro center on page 7-7 (Hospital responsibility).
☐ Check the hospital intranet browser functionality on page 7-7 (Hospital responsibility).
☐ Check the status of locked beds on page 7-7.
☐ Check the language settings on page 7-7 (applicable for all non-English applications only).
☐ Check the pressures unit-of-measure on page 7-7 (for Chinese applications only).
☐ Check MultiKM (Multimouse) operation on page 7-8.
☐ Check current system settings on page 7-8.
☐ Check full disclosure license type for all admitted in-unit beds on page 7-9.
☐ Check full disclosure report printing on page 7-9.
☐ Check for hard drive and solid state flash drive errors. See Check read and write integrity of hard drive and solid state flash drive on page 7-10.
☐ Check USB devices on page 7-11.
☐ Check internal hardware temperature and voltage status on page 7-12.
☐ Check COMM ports on page 7-13.
☐ Check BIOS information on page 7-13.
☐ Check drive operation information (Flash drive and hard drive) on page 7-14.
☐ Check audio component operation on page 7-16.
☐ Check speaker status on page 7-17.
☐ Check processor fan status on page 7-19.
☐ Check video function and status of video card and drivers on page 7-19.
☐ Check integrity of system files on page 7-20.
☐ Check asset information on page 7-20.
☐ Check system resources. See Environment Monitor messages on page 8-19.
☐ Check operation of the Watchdog countdown function on page 7-18.

System resource indicator

Overview

A system resource indicator is provided in the CIC Pro center toolbar, next to the clock at the bottom of the screen. This indicator shows the current usage of key system resources. As these resources change, the system will provide a real-time indicator as to the “health” of the system. CIC Pro center resource indicator icon is displayed in different colors: green, yellow, and red.

There are three levels of text messages that the user can see.
Preventive maintenance

- When a mouse/cursor is placed over the CIC Pro center resource indicator icon
- When CIC Pro center resource indicator icon is double clicked
- Automatically, when the key system resources are running low, the Environment Monitoring Service notification is received

Resource indicator messages when hovering over icon

<table>
<thead>
<tr>
<th>Icon color</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>System Resources: Normal</td>
</tr>
<tr>
<td>Yellow</td>
<td>System Resources: Advisory</td>
</tr>
<tr>
<td>Red</td>
<td>System Resources: Low</td>
</tr>
</tbody>
</table>

Resource indicator messages when icon is double-clicked

<table>
<thead>
<tr>
<th>Icon color</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>This CIC is operating within normal software parameters and no Preventive Maintenance action is currently required. [X]</td>
</tr>
<tr>
<td>Yellow</td>
<td>System resources are running low. Contact GE Service or the biomedical engineering department at your facility as a Preventive Maintenance action is advised. [X]</td>
</tr>
<tr>
<td>Red</td>
<td>Warning! Available system resources are running low. A Preventive Maintenance action is required. [X]</td>
</tr>
</tbody>
</table>

NOTE

The [X] indicates the number of days since the CIC Pro center was last rebooted

Resource indicator messages from Environment Monitoring Service

<table>
<thead>
<tr>
<th>Icon color</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No message is displayed.</td>
</tr>
</tbody>
</table>
Preventive maintenance

The system resource indicator should be checked periodically, and appropriate action should be taken when needed.

Depending upon the color of the CIC Pro center system resource indicator, different actions are required:

<table>
<thead>
<tr>
<th>Icon color</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>Warning! Available system resources are running low. A Preventive Maintenance action is required.</td>
</tr>
<tr>
<td>Red</td>
<td>Warning! Available system resources are running low. System restart is required to correct the problem. Patients will not be monitored at this Central while the System is restarting. If the system is not restarted now, it will restart automatically in approximately XX minutes.</td>
</tr>
</tbody>
</table>

NOTE
Where “XX” represents the number in minutes ranging from 0 to 60.

### System resource restart procedure

When you are prompted to restart, always perform the safe shutdown procedure as described.

1. From the multi-patient viewer, select **Setup CIC > Service Password**.
2. Type **mms_com** and then press **Enter**.
3. At the `c:\Program Files\Marquette\CIC\<version#>` prompt, type **stop** and press **Enter**.
4. From the Windows taskbar, select **Start > Shut Down > Shut Down > OK**.

5. When the message **It is now safe to turn off your computer** displays, turn off the CIC Pro center power switch.

6. Wait for 5 seconds.

7. Turn on CIC Pro center power switch.

8. Allow the CIC Pro center application to start-up completely.

9. Complete the procedure as described in **Access current log files on page 8-21**

**Access log files**

When you contact GE Service, you may have to provide required log file information. See Log files on page 8-20.
11 Reload software
Reload software

Purpose

If the CIC Pro center experiences intermittent problems, or the flash drive or hard drive is replaced, you may need to re-image either the hard drive or flash drive. Refer to the following table for instructions:

<table>
<thead>
<tr>
<th>If this FRU is replaced</th>
<th>Follow this procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard drive</td>
<td>Re-image the hard drive. Follow the Reload CIC Pro center software on page 11-5.</td>
</tr>
<tr>
<td>Flash drive (solid-state drive)</td>
<td>Re-image the Flash drive. Follow the Reload CIC Pro center software on page 11-5.</td>
</tr>
<tr>
<td>CPU PCB (mother board)</td>
<td>Do not re-image the Flash drive or hard drive after replacing the CPU PCB.</td>
</tr>
</tbody>
</table>

Process overview

This section describes the procedures required to re-image the flash or hard drive:

☐ Gather required equipment and tools on page 11-2.
☐ Create a CIC Pro center image restore USB memory stick on page 11-2
☐ Reload CIC Pro center software on page 11-5.

Gather required equipment and tools

- Service PC (desktop or laptop computer) equipped with a DVD drive, and running Windows NT, 2000, or XP.
- This manual.
- The software upgrade and software re-image files are burned onto one DVD. Use the DVD supplied with the MP100 CIC v5.1.1 Software Kit.
- USB memory stick with a minimum of 1 GB memory.

Create a CIC Pro center image restore USB memory stick

1. Insert the USB memory stick into a vacant USB port on the service PC.
2. Insert the DVD containing the GE Software Distribution Utility into the service PC’s DVD drive.
3. On the GE Software Distribution Utility screen, click List USB Drive(s).
The utility displays a message informing you how many USB drives are connected to the service PC.

4. Select the appropriate USB drive (usually drive F) from the drop-down list.

   **NOTE**

   This procedure erases any existing data on the USB memory stick. If more than one USB memory stick is identified, be sure to select the correct one.

5. Click **Make USB Stick**.

6. Select **OK** to confirm that you wish to continue the operation.

   The reload utility displays the progress of the operation.
NOTE

In case the reload utility encounters an error (e.g., the USB memory stick does not contain sufficient memory), try a different USB memory stick with at least 1 GB of memory, and repeat steps 1 through 6.

NOTE

Depending on the original status of the USB memory stick, at 99% on the progress indicator, the reload process may appear to be idle. The flashing LED on the USB memory stick indicates that the program is still processing.

If the USB memory stick is not equipped with an LED, wait for approximately 5 minutes after the progress indicator shows that the process is 99% complete.

7. Wait for a message indicating that the operation is complete.

8. Remove the USB memory stick from the service PC.

NOTE

The reload process also prepares the USB memory stick for safe removal from the service PC. It is not necessary to perform an extra operation to safely eject the USB memory stick.


10. Remove the DVD from the service PC.
Reload CIC Pro center software

1. Perform safe shutdown of the CIC Pro center on page 8-31.

   NOTE
   If platform software is being reloaded because of catastrophic failure or replacement of the flash (solid-state) drive, then it will not be possible to perform this step. Therefore, it can be skipped.

2. Disconnect the CIC Pro center from the CARESCAPE Network IX and MC networks before you begin the reload process. Otherwise, the CIC Pro center will continuously reboot.

3. If you have not already done so, Create a CIC Pro center image restore USB memory stick on page 11-2.

4. Insert the image restore USB memory stick into a vacant USB port on the CIC Pro center.

5. Power on the CIC Pro center. The system will reboot from the USB memory stick and the GE Healthcare screen will be displayed.

   NOTE
   If the system does not boot from the USB memory stick, refer to Reload process troubleshooting on page 11-8.

6. Select the appropriate option from the menu options that are displayed:
   
   ■ 1. Restore MP100 CIC image and clear and initialize HDD
      NOTE
      This option will restore the CIC image on the Flash drive and will clear and initialize the hard drive.

   ■ 2. Quit
      NOTE
      This option will cancel the reload process and the DOS prompt will be displayed.

7. If you selected option 1 in step 6, at the Existing data will be erased, are you sure you want to continue [Y,N]? prompt, select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Proceed with the image restore. The checks for platform type and drive connections will be performed.</td>
</tr>
<tr>
<td></td>
<td>1. A check for platform type will be performed.</td>
</tr>
<tr>
<td></td>
<td>Platform type is determined by the product code. Valid codes are SDY and SDZ.</td>
</tr>
<tr>
<td></td>
<td>2. If the platform check is successful, the image restore will proceed. Otherwise, the image restore process is cancelled.</td>
</tr>
<tr>
<td>No</td>
<td>Prevent the image restore from taking place</td>
</tr>
</tbody>
</table>
The reload process will run twice when option 1 is selected from the menu; once for the flash (solid-state) drive and once for the hard disk drive.

The following messages will be displayed upon a successful restore:

- **CIC image has been restored**
- **HDD is cleaned and initialized**
- **Remove the USB stick then reboot the system**

8. Remove the USB memory stick.

**NOTE**

- If a USB memory stick that contains the CIC Pro center software image is not removed from the CIC Pro center, step 6 is repeated. If this occurs, select option 2 to quit.
- If a USB memory stick that contains licenses or data other than the CIC Pro center restore image, then **Operating system missing** will be displayed.

9. Power down and power up the CIC Pro center using the power switch.

**NOTE**

Upon first boot, the screen will be blank for a few minutes, and then the following warning message will be displayed:

**Setup is in progress, do not close this window.**

**System will reboot automatically in approximately 2 minutes.**

10. Verify that the CIC Pro center is defaulted to the following IP addresses:

   a. If you have not already logged in to Webmin, [Log on to the Webmin service interface on page 4-7](#).

   b. Click **Configuration > Network**.

<table>
<thead>
<tr>
<th>Network</th>
<th>Field</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IX</td>
<td>IP address</td>
<td>172.18.1.1</td>
</tr>
<tr>
<td></td>
<td>Netmask</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td></td>
<td>Default gateway</td>
<td>172.18.254.254</td>
</tr>
<tr>
<td>MC</td>
<td>IP address</td>
<td>172.16.1.1</td>
</tr>
<tr>
<td></td>
<td>Netmask</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td></td>
<td>Default gateway</td>
<td>&lt;none&gt;</td>
</tr>
</tbody>
</table>

11. Configure the system as necessary as described in [Configuration on page 6-1](#).

**NOTE**

If the System Resource Indicator turns yellow or red during configuration, refer to [Environment Monitor messages on page 8-19](#).
Complete checkout procedures

Confirm images restored to correct drives

1. Log in as Administrator. See Log on to the CIC Pro center as Administrator on page 4-3.
2. Right-click My Computer icon and select Manage.
3. Navigate to Storage > Disk Management.

4. Compare drive capacities as follows:
   - Disk 0 shows four partitions: C, D, E F. Disk 0 also has a smaller capacity than Disk 1.
   - Disk 1 shows one partition: G and has a larger capacity than Disk 0.

   **NOTE**
   The smaller drive contains all the software and the larger drive contains only full disclosure data.

Complete FRU checkout procedures

Refer to the following table for the applicable checkout procedure.

<table>
<thead>
<tr>
<th>If this FRU is replaced</th>
<th>Complete the applicable checkout procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard drive</td>
<td>See page 9-17.</td>
</tr>
<tr>
<td>Flash drive (solid-state drive)</td>
<td>See page 6-89.</td>
</tr>
<tr>
<td>CPU PCB (mother board)</td>
<td>See page 9-14.</td>
</tr>
</tbody>
</table>
**Check proper operation**

To verify proper operation in the patient care and networking environments, complete all of the checkout procedures identified in Complete configuration checkout procedures on page 6-89.

**Reload process troubleshooting**

If the system doesn’t boot from the USB stick, then there could be one or more of the following problems.

**Incorrect boot order**

The correct boot order is:

- USB-HDD
- HDD-2
- IBA GE Slot 010

The correct boot order can be set by completing the load optimized defaults procedure as follows:

**NOTE**

Correcting the boot order is a password protected process. The password is 8765309.

1. Press Ctrl + Alt + Delete to restart the system. Watch for the processor type to appear and IMMEDIATELY press Delete to enter the BIOS setup utility.
2. Select Load Optimized Defaults by using the up/down arrow keys to and press Enter.
3. Type Y and press Enter at the Load Optimized Defaults (Y/N)? prompt.
4. Press F10 to save the settings.
5. Type Y and press Enter at the Save to CMOS and EXIT (Y/N)? prompt.
6. Allow the computer to automatically start up.

**Software image on USB stick does not match hardware**

Errors such as Platform type test failed, image cannot be restored, Operating system not found or unknown platform image indicate that the software image on the USB stick does not match the correct hardware. In this case, the USB stick may contain the wrong image files, it may not contain any image at all, or it may have been improperly created. If needed, repeat Create a CIC Pro center image restore USB memory stick on page 11-2.
12 Upgrade software
Overview

WARNING
LOSS OF MONITORING — This activation procedure requires you to reboot the CIC Pro center. Rebooting a CIC Pro center stops active patient monitoring. When a care unit has only one working CIC Pro center, notify the site’s biomedical department to provide alternate bedside patient monitoring. See Establish alternate monitoring methods on page 12-3.

NOTE
- This procedure is intended for use by qualified service personnel on MP100 Series platform CIC Pro centers running software version 5.1 or later. It is intended for upgrading CIC Pro center clinical application or service application software packages.
- There are different types of software package files you may be activating on a CIC Pro center. Some are simply software patches that enhance the software processing; others add features or functions. You may be required to configure settings related to any added software features or functions. See the What’s In This Release document for information about added features or functions.

NOTE
All CIC Pro center devices in the MultiKM group have to be of the same version.
- In any given CAREScape Network, many Multimouse groups can co-exist as long as each individual group devices are the same CIC Pro center versions. Example: all CIC v5.0.x in one group and all CIC v5.1.x in another group.
- If a CIC Pro center is swapped from an existing MultiKM group, ensure that the new CIC Pro center is the same version as the other CIC Pro centers in the Multimouse group.

You can upgrade CIC Pro center clinical application or service application software by installing software package files from a service PC via CD ROM. Both the service PC and the MP100 Series platform CIC Pro centers must be connected to the CAREScape Network IX network.

The software installation process occurs in the background and does not impact the active monitoring of patients by the target CIC Pro centers. The software package files remain inactive on the target CIC Pro centers until you activate them.

The activation process includes using the local Webmin service interface at each of the target CIC Pro centers. Then, after a manual activation the CIC Pro center runs the activated software.

This chapter describes the procedures required to upgrade clinical or service application software packages on an CIC Pro center:
- Establish alternate monitoring methods on page 12-3.
- Gather required equipment and tools on page 12-3.
Upgrade software

- Prepare the CIC Pro center on page 12-3.
- Prepare the service PC on page 12-4.
- Install the software on the target CIC Pro centers on page 12-6.
- Activate the software packages on page 12-8.
- Complete the checkout procedures on page 12-9.

Establish alternate monitoring methods

When a care unit has two or more working CIC Pro centers, you can move monitored patients from one CIC Pro center to another system if the CIC Pro center has empty, unlocked patient slots available.

Gather required equipment and tools

The following equipment is required to upgrade CIC Pro center software:

- Service PC (desktop or laptop computer) equipped with an Ethernet network card, and running Windows NT, 2000, or XP. This PC functions as the software transfer server.
- Ethernet crossover cable.
- This manual. See Configuration on page 6-1 and Complete configuration checkout procedures on page 6-89.
- The software upgrade and software re-image files are burned onto one DVD. Use the DVD supplied with the MP100 CIC v5.1.1 Software Kit.

Prepare the CIC Pro center

The CIC Pro center must be running and be connected to the CARESCAPE Network IX network.

**NOTE**

- The software installation process does not require the CIC Pro center to be disconnected from the CARESCAPE Network IX or MC networks. Do not stop the active monitoring of patients via the CIC Pro center. The software upgrade files remain inactive on the target CIC Pro centers until you are ready to activate them. See Install the software on the target CIC Pro centers on page 12-6.
- To activate the software package files on a target CIC Pro center, you must use the local Webmin service interface tool to activate the software. The CIC Pro center automatically reboots and begins to run the updated software. Rebooting a CIC Pro center stops active patient monitoring. You will need to plan for and establish alternate patient monitoring while you are activating the software upgrade files on the target CIC Pro centers. See Activate the software packages on page 12-8.
Prepere the service PC

This section describes the procedures required to prepare the service PC for installing software packages to networked CIC Pro centers:

- Connect the service PC to the CARESCAPE Network IX network on page 12-4.
- Set up the service PC’s network properties on page 4-8.
- Start the software transfer utility on page 12-4.
- Enter the CARESCAPE Network IX network addresses of CIC Pro centers to be updated on page 12-5.

Connect the service PC to the CARESCAPE Network IX network

WARNING
LOSS OF ALARMS — When using a service PC to install or reload software onto the CIC Pro center, do not connect the Ethernet cable from the service PC to the CIC Pro center’s CARESCAPE Network MC network port. You must use the CARESCAPE Network IX network to install or reload software.

- Connect an Ethernet cable from the service PC’s Ethernet port to the facility’s CARESCAPE Network IX network.

Start the software transfer utility

1. Insert the DVD containing the GE Software Distribution Utility into the service PC’s DVD drive.
2. Click *Run S/W Export Utility*.

Enter the CARESCAPE Network IX network addresses of CIC Pro centers to be updated

Complete the following procedure to manually type in the CIC Pro center CARESCAPE Network IX network addresses or automatically upload the CIC Pro center CARESCAPE Network IX network addresses from a `.txt` file:

1. To manually type the IP addresses of the CIC Pro centers you want to install the software packages to, complete the following steps:
   a. Under *Add Target IP Addresses*, type the IP address of a CIC Pro center you want to install the software packages on.
   b. Click (down arrow) to add this IP Address to the displayed list.
   c. Repeat step a and step b for each additional CIC Pro center you want to install the software packages on.

2. To automatically upload a `.txt` file containing the list of CIC Pro center IP addresses you want to install the software packages on, complete the following steps:
   a. Open the Windows *Notepad* application.
   b. Type one IP address per line of type. To add a brief descriptor (e.g., *CIC1*), enter a space after the IP address and type the descriptor. See the following example:
c. Select File > Save. Specify the destination and file name of this .txt file so you can easily navigate to it.

d. From the GE Healthcare Software Transfer Utility window, select File > Import IP File. Navigate to the .txt file containing the IP addresses. The IP addresses should display in the Add Target IP Addresses list.

3. Verify these are the CIC Pro centers you want updated.

**NOTE**

All IP addresses displayed in the GE Healthcare Software Transfer Utility > Add Target IP Address list will have the selected software packages installed on them. Verify the list of target IP addresses only contains the CIC Pro centers you want updated.

4. To remove an IP address from the displayed list, select the IP address and click (up arrow).

### Install the software on the target CIC Pro centers

Once the GE Healthcare Software Transfer Utility > Add Target IP Address list only displays the IP addresses of the CIC Pro centers you want to update, you are ready to start installing the software packages.

Complete the following procedure to install your selected software packages on the target CIC Pro centers:

1. Under Select Software Packages, choose the software packages you want to install on the target CIC Pro centers.

   **NOTE**

   Ctrl + click to select multiple software packages.

2. Select Transfer. Transfer status information displays in the Transfer Status window at the bottom of the GE Healthcare Software Transfer Utility window.
NOTE

- If you selected more than one software package to be installed on the targeted CIC Pro centers, each package is installed in sequential order.
- A software package can only be installed on a limited number of target devices at the same time. As a result, the software install may occur in sequential groupings.

3. To cancel a software install, select **Cancel**.

**NOTE**

Selecting **Cancel** only cancels the installation of the Queued software packages identified in the **Transfer Status** window. Once the installation of a software package has started, you cannot cancel it.

4. To save the list of displayed IP address in a .txt file format, select **File > Export IP File**. Specify the destination and file name of this .txt file.

5. Verify the status of all software packages indicate **Success**.

6. Select **Exit**.
Activate the software packages

**WARNING**
LOSS OF MONITORING — This procedure requires you to reboot the CIC Pro center. Rebooting a CIC Pro center stops active patient monitoring. When a care unit has only one working CIC Pro center, notify the site’s biomedical department to provide alternate bedside patient monitoring. See Establish alternate monitoring methods on page 12-3.

Use the local Webmin *Software Management* module interface to activate selected software packages.

**NOTE**
If the activation process fails, you must re-image the CIC Pro center using the re-image CDs included in the software kit you purchased.

1. If you have not already logged onto Webmin, Log on to the direct access (local) Webmin service interface on page 4-7.
2. Click *Configuration > Software Management*. The *Software Management* window displays.

3. Select the radio button next to the software packages (clinical application or service application) you need to activate.
4. Make sure that you read the following instructions before proceeding to the next step.
5. Select *Activate Software*.
6. From the *Legal Statement* window, select *Yes*. The CIC Pro center activates the selected software and automatically reboots.
CAUTION
If a USB memory stick other than the stick containing the reload image is plugged into the CIC Pro center, you need to remove it prior to rebooting. Otherwise, the message *Operating system missing* will be displayed.

**Complete the checkout procedures**

**NOTE**

After upgrading the CIC Pro center software from v5.0.x to CIC v5.1.x, the existing Multimouse configurations are lost. Before proceeding to checkout, you must re-configure Multimouse on the CIC Pro center and ensure that the Multimouse functionality regained. See Perform MultiKM (Multimouse) setup on page 6-78.

After activating the installed software and before using the CIC Pro center to monitor patients, you must verify proper operation of this device in the patient care and networking environments.

To verify proper operation in the patient care and networking environments, complete all of the checkout procedures identified in Complete configuration checkout procedures on page 6-89.
Upgrade software
A  Electromagnetic compatibility
Electromagnetic compatibility (EMC)

Changes or modifications to this system not expressly approved by GE could cause EMC issues with this or other equipment. This system is designed and tested to comply with applicable regulation regarding EMC and needs to be installed and put into service according to the EMC information stated in this appendix.

CAUTION
EMC — Magnetic and electrical fields are capable of interfering with the proper performance of the device. For this reason make sure that all external devices operated in the vicinity of the monitor comply with the relevant EMC requirements. X-ray equipment or MRI devices are a possible source of interference as they may emit higher levels of electromagnetic radiation.

CAUTION
Use of portable phones or other radio frequency (RF) emitting equipment near the system may cause unexpected or adverse operation.

CAUTION
The equipment or system should not be used adjacent to, or stacked with, other equipment. If adjacent or stacked use is necessary, the equipment or system should be tested to verify normal operation in the configuration in which it is being used.

Guidance and manufacturer’s declaration

Electromagnetic emissions

The CIC Pro center is intended for use in the electromagnetic environment specified below. It is the responsibility of the customer or user to assure that the CIC Pro center is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF Emissions (radiated)</td>
<td>Group 1</td>
<td>The device uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>EN 55011</td>
<td>Class A</td>
<td></td>
</tr>
</tbody>
</table>
Electromagnetic compatibility

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF Emissions (conductive) EN 55011</td>
<td>Group 1 Class A</td>
<td></td>
</tr>
<tr>
<td>Harmonic Emissions IEC 61000-3-2</td>
<td>Complies</td>
<td></td>
</tr>
<tr>
<td>Voltage Fluctuations/ Flicker Emissions IEC 61000-3-3</td>
<td>Complies</td>
<td></td>
</tr>
</tbody>
</table>

CAUTION
The equipment is suitable for use in all establishments other than domestic and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.

Electromagnetic immunity

The CIC Pro center is intended for use in the electromagnetic environment specified below. It is the responsibility of the customer or user to assure that the CIC Pro center is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
</table>
| Electrostatic Discharge (ESD) IEC 61000-4-2 | ± 6 kV contact ± 8 kV air | ± 6 kV contact ± 8 kV air | Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.
| Electrical Fast Transient/ Burst IEC 61000-4-4 | ± 2 kV for power supply lines ± 1 kV for input/output lines | ± 2 kV for power supply lines ± 1 kV for input/output lines | Mains power should be that of a typical commercial or hospital environment.
| Surge IEC 61000-4-5 | ± 1 kV differential mode ± 2 kV common mode | ± 1 kV differential mode ± 2 kV common mode | Mains power should be that of a typical commercial or hospital environment.
| Voltage dips, short interruptions and voltage variations on power supply input lines IEC 61000-4-11 | <5% $U_t$ (>95% dip in $U_t$) for 0.5 cycles <40% $U_t$ (>60% dip in $U_t$) for 5 cycles <70% $U_t$ (>30% dip in $U_t$) for 25 cycles <5% $U_t$ (>95% dip in $U_t$) for 5 s | <5% $U_t$ (>95% dip in $U_t$) for 0.5 cycles <40% $U_t$ (>60% dip in $U_t$) for 5 cycles <70% $U_t$ (>30% dip in $U_t$) for 25 cycles <5% $U_t$ (>95% dip in $U_t$) for 5 s | Mains power should be that of a typical commercial or hospital environment. If the user of the equipment requires continued operation during power mains interruptions, it is recommended that the equipment be powered from an uninterruptable power supply or a battery.
| Power Frequency (50/60 Hz) Magnetic Field IEC 61000-4-8 | 3 A/m | 3 A/m | Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment.

NOTE
$U_t$ is the AC mains voltage prior to application of the test level.
## Electromagnetic compatibility

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF</td>
<td>IEC 61000-4-6</td>
<td>3 V rms</td>
<td>Portable and mobile RF communications equipment should not be used closer to any part of the equipment, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.</td>
</tr>
<tr>
<td>Radiated RF</td>
<td>IEC 61000-4-3</td>
<td>3 V/m</td>
<td>Recommended separation distance</td>
</tr>
<tr>
<td></td>
<td>3 V rms</td>
<td>3 V rms</td>
<td>$d = 1.2 \sqrt{P}$</td>
</tr>
<tr>
<td></td>
<td>3 V rms</td>
<td>3 V rms</td>
<td>$d = 1.2 \sqrt{P}$ for 80 MHz to 800 MHz</td>
</tr>
<tr>
<td></td>
<td>3 V rms</td>
<td>3 V rms</td>
<td>$d = 2.3 \sqrt{P}$ for 800 MHz to 2.5 GHz</td>
</tr>
<tr>
<td></td>
<td>3 V/m</td>
<td>3 V/m</td>
<td>where $P$ is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer, and $d$ is the recommended separation distance in meters (m).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey(^a), should be less than the compliance level in each frequency range(^b).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Interference may occur in the vicinity of equipment marked with the following symbol:</td>
</tr>
</tbody>
</table>

### Note 1
At 80 MHz and 800 MHz, the higher frequency range applies.

### Note 2
These guidelines may not apply in all situations. Electromagnetic propagation is affected by reflection from structures, objects, and people.

\(^a\)Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radio, AM and FM radio broadcast, and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the equipment is used exceeds the applicable RF compliance level above, the equipment should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the equipment.

\(^b\)Over the frequency range 150 KHz to 80 MHz, field strengths should be less than 3 V/m.
Recommended separation distances

The following table provides the recommended separation distances (in meters) between portable and mobile RF communications equipment and the CIC Pro center.

The CIC Pro center is intended for use in the electromagnetic environment on which radiated RF disturbances are controlled. The customer or the user of the CIC Pro center can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the CIC Pro center as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter in watts</th>
<th>150 kHz to 80 MHz$^a$</th>
<th>80 MHz to 800 MHz$^a$</th>
<th>800 MHz to 2.5 GHz$^a$</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$d = 1.2 \sqrt{P}$</td>
<td>$d = 1.2 \sqrt{P}$</td>
<td>$d = 2.3 \sqrt{P}$</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
<td>0.12</td>
<td>0.23</td>
</tr>
<tr>
<td>0.1</td>
<td>0.38</td>
<td>0.38</td>
<td>0.73</td>
</tr>
<tr>
<td>1</td>
<td>1.2</td>
<td>1.2</td>
<td>2.3</td>
</tr>
<tr>
<td>10</td>
<td>3.8</td>
<td>3.8</td>
<td>7.3</td>
</tr>
<tr>
<td>100</td>
<td>12</td>
<td>12</td>
<td>23</td>
</tr>
</tbody>
</table>

$^a$At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

For transmitters rated at a maximum output power not listed above, the recommended separation distance [d] in meters (m) can be estimated using the equitation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

**NOTE**

These guidelines may not apply in all instances. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
Compliant cables and accessories

**CAUTION**
The use of accessories, transducers and cables other than those specified may result in increased emissions or decreased immunity performance of the equipment or system.

The table below lists cables, transducers, and other applicable accessories with which GE claims EMC compliance.

**NOTE**
Any supplied accessories that do not affect EMC compliance are not included.

<table>
<thead>
<tr>
<th>Part number</th>
<th>Description</th>
<th>Maximum lengths</th>
</tr>
</thead>
<tbody>
<tr>
<td>80274-006</td>
<td>AC Power Cord</td>
<td>1.8 m / 6 ft</td>
</tr>
<tr>
<td>201792-001</td>
<td>DVI-D to DVI-D Cable</td>
<td>1.8 m / 6 ft</td>
</tr>
<tr>
<td>418331-002</td>
<td>PRN50-M printer</td>
<td>N/A</td>
</tr>
<tr>
<td>418335-00x</td>
<td>RJ45 Category 5 Cable</td>
<td>N/A</td>
</tr>
<tr>
<td>418708-001</td>
<td>Key Pad</td>
<td>N/A</td>
</tr>
<tr>
<td>2001323-001</td>
<td>Speakers</td>
<td>N/A</td>
</tr>
<tr>
<td>2006733-001</td>
<td>Serial Cable</td>
<td>1.8 m / 6 ft</td>
</tr>
<tr>
<td>2016193-001</td>
<td>USB Keyboard</td>
<td>N/A</td>
</tr>
<tr>
<td>2019795-001</td>
<td>USB Cable</td>
<td>1.8 m / 6 ft</td>
</tr>
<tr>
<td>2020737-001</td>
<td>NEC Display 20” LCD 20080UX+</td>
<td>N/A</td>
</tr>
<tr>
<td>2022144-002</td>
<td>USB Mouse</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Backup and restore - backed up data modules
Data module detail

The following table lists summary detail information associated with data modules listed as Available Tools in the Backup-Restore CIC Configuration window.

**NOTE**

Items marked with * are automatically updated by other CIC Pro centers running in a care unit.

<table>
<thead>
<tr>
<th>Telemetry Alarm Control Defaults</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Parameter Limits</em></td>
<td>Limits.def/Limits.mei</td>
<td></td>
</tr>
<tr>
<td><em>Parameter Alarm Levels</em></td>
<td>Param.def/Param.mei</td>
<td></td>
</tr>
<tr>
<td><em>Arrhythmia Alarm Levels</em></td>
<td>Arrhy.def/Arrhy.mei</td>
<td></td>
</tr>
<tr>
<td><em>System Alarm Levels</em></td>
<td>System.def/System.mei</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Full Disclosure Defaults</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Report Duration</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Report Hole Location</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Include Graybar</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Include Arrhythmia Annotations</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Include Heart rate</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Line Time</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Strip Duration</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Strip Hole Location</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Full Disclosure License</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Full Disclosure Offline Storage</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Start Data Storage</em></td>
<td>NewTelem.def</td>
<td></td>
</tr>
<tr>
<td><em>Bedlist</em></td>
<td>Fd.all</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display Configuration</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Config.dat</td>
<td></td>
</tr>
<tr>
<td>Rows</td>
<td>Config.dat</td>
<td></td>
</tr>
<tr>
<td><em>Disable Auto Display button</em></td>
<td>Config.dat</td>
<td></td>
</tr>
<tr>
<td>Maximize Waveform length</td>
<td>Config.dat</td>
<td></td>
</tr>
<tr>
<td>Maximize No. of Waveforms</td>
<td>Config.dat</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Current Telemetry Listings</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Telemetry Bed List</em></td>
<td>Telebeds.all</td>
<td></td>
</tr>
<tr>
<td><em>Hardwire Bed List</em></td>
<td>Hardwire.all</td>
<td></td>
</tr>
<tr>
<td><em>Transmitter List</em></td>
<td>Ttx.all</td>
<td></td>
</tr>
</tbody>
</table>
## CIC Defaults

<table>
<thead>
<tr>
<th>Setting</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Name</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Unit Name</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ECG1WaveForm</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Waveform2</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Waveform3</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Waveform4</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Laser Printer</td>
<td>Config.dat</td>
</tr>
<tr>
<td>DDW Printer</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Full Disclosure Printer</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Mirror Central Display</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Alarm Volume</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Browser Enabled</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Browser Status</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetECG0</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetECG1</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetECG2</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetECG3</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetECG4</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetECG5</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetECG6</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetART</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetPA</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetFEM</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetCVP</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetRA</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetLA</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetICP</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetSP</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetUAC</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetUVC</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetRESP</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetSPO2</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorSetCO2</td>
<td>Config.dat</td>
</tr>
<tr>
<td>ColorOption</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Central Name</td>
<td>Config.dat</td>
</tr>
</tbody>
</table>
### Telemetry Unit Defaults

<table>
<thead>
<tr>
<th>Feature</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Set Manual</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Graph Setup Alarm</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Graph Setup Print Window</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Graph Setup ECG1*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Graph Setup Waveform2*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Graph Setup Waveform3*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Graph Setup Waveform4*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Transmitter Graph*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Alarm Graph*</td>
<td>NewTelem.def</td>
</tr>
<tr>
<td>Nurse Call Graph*</td>
<td>NewTelem.def</td>
</tr>
<tr>
<td>Display Lead*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Arrhythmia*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Lead Analysis*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>ST Analysis*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Va Lead*</td>
<td>NewTelem.def</td>
</tr>
<tr>
<td>Vb Lead*</td>
<td>NewTelem.def</td>
</tr>
<tr>
<td>Detect Pace*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Patient Age*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Transmitter Alarm Pause*</td>
<td>Telem.def</td>
</tr>
<tr>
<td>Alarm Pause Breakthrough*</td>
<td>NewTelem.def</td>
</tr>
<tr>
<td>PDT*</td>
<td>NewTelem.def</td>
</tr>
<tr>
<td>Transmitter Nurse Call*</td>
<td>NewTelem.def</td>
</tr>
</tbody>
</table>

### Bed Slot Assignment

<table>
<thead>
<tr>
<th>Feature</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Format</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Beds Configured</td>
<td>Config.dat</td>
</tr>
</tbody>
</table>

### Slot Information (From Slot 0 – Slot 32)

<table>
<thead>
<tr>
<th>Feature</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row, Column and Bed Name</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Lead_or_site, position, scroll_speed</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Colors</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Bed Assignment</td>
<td>Config.dat</td>
</tr>
<tr>
<td>Lock Status</td>
<td>Config.dat</td>
</tr>
</tbody>
</table>
C  Device compatibility
CIC Pro center v5.1.x compatibility

The following list of devices are compatible with the CIC Pro center v5.1.x. Contact GE if you want to connect a device that is either not listed or compatible but has a software version not listed. This list is subject to change without notice.

Central stations

<table>
<thead>
<tr>
<th>Devices</th>
<th>Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-Unit</td>
<td>4.0.7, 4.0.8, 4.1.1, 4.1.1-1, 5.0.3, 5.0.6, 5.0.7, 5.0.8, 5.1.x</td>
</tr>
<tr>
<td>Out-of-Unit</td>
<td>1.5, 2.3, 2.4, 2.4.1, 3.0.0, 3.0.1, 3.0.2, 3.1.0, 4.0.3, 4.0.6, 4.0.7, 4.0.8, 4.1.1, 4.1.1-1, 5.0.3, 5.0.6, 5.0.7, 5.0.8, 5.1.x</td>
</tr>
<tr>
<td>Full disclosure data transfer</td>
<td>4.0.3, 4.0.6, 4.0.7, 4.1.1, 4.1.1-1, 5.0.3, 5.0.6, 5.0.7, 5.0.8, 5.1.x</td>
</tr>
<tr>
<td>Unity iCentral</td>
<td>LNET05 4.1, LNET05 4.3</td>
</tr>
</tbody>
</table>

Telemetry devices

<table>
<thead>
<tr>
<th>Devices</th>
<th>Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApexPro software</td>
<td>3.9, 4.0</td>
</tr>
<tr>
<td>ApexPro transmitters/ transceivers</td>
<td>PT series (NEC) transmitter (PT2110, PT2210, PT2310), ApexPro FH transceiver, ApexPro transmitter, ApexPro CH transmitter, CARESCAPE Telemetry T14 transmitter</td>
</tr>
<tr>
<td>CDT LAN system</td>
<td>6D</td>
</tr>
<tr>
<td>CDT LAN transmitters</td>
<td>Apex S</td>
</tr>
</tbody>
</table>

Bedside monitors

<table>
<thead>
<tr>
<th>Devices</th>
<th>Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DASH 3000/4000/5000</td>
<td>2B, 2C, 3B, 3C, 3D, 4B, 4C, 5.1, 5.2, 5.3, 6.2, 6.3, 6.4, 6.5, 6.6, 6.7</td>
</tr>
<tr>
<td>Eagle 3000</td>
<td>3A, 3B, 4A, 4C</td>
</tr>
<tr>
<td>Eagle 4000</td>
<td>5B, 6A, 6B, 6C, 6D, 6F, 6G</td>
</tr>
<tr>
<td>Solar 7000/8000</td>
<td>3C, 4B, 4C (Special), 5B, 5D, 5E, 6A, 7B, 7C</td>
</tr>
<tr>
<td>Solar 8000M</td>
<td>1A, 1B, 1C, 2A, 3D, 4D, 4E, 4F, 5.2, 5.3</td>
</tr>
<tr>
<td>Solar 8000i</td>
<td>4E, 4F, 5.2</td>
</tr>
<tr>
<td>Solar 9500</td>
<td>S9500-2A(S95), S9500-2B(S95), S9500-2C(S95), S9500-2D(S95), S9500-3C, S9500-4A, S9500-4B, S9500-4C</td>
</tr>
</tbody>
</table>
Device compatibility

Critikon Pro 100/400

<table>
<thead>
<tr>
<th>Devices</th>
<th>Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system does not directly connect to the Critikon Pro 100/400. Critikon Pro 100/400 is only supported via the ApexPro device. Therefore, versions of the Critikon Pro 100/400 are not specified as the compatibility is to the ApexPro and not to the Critikon Pro 100/400 device.</td>
<td></td>
</tr>
</tbody>
</table>

Critikon Pro 1000

<table>
<thead>
<tr>
<th>Devices</th>
<th>Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>V2 HW, RAH SW, V3 HW, RAA SW</td>
<td></td>
</tr>
</tbody>
</table>

Unity Network ID

<table>
<thead>
<tr>
<th>Devices</th>
<th>Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1A, 3B, 4A, 4B</td>
<td></td>
</tr>
</tbody>
</table>

Other GE systems

<table>
<thead>
<tr>
<th>Devices</th>
<th>Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unity Network PatientViewer system</td>
<td>1.0</td>
</tr>
<tr>
<td>Unity Network Patient Data Server (PDS)</td>
<td>1.0.3, 1.0.6</td>
</tr>
<tr>
<td>StatView/Impact pager system administrator function</td>
<td>6.10.030, 7</td>
</tr>
<tr>
<td>MUSEWeb</td>
<td>Compatibly when using the CIC Browser for MUSE versions 5C.06, 5C.10, 5D.02, 5D.06, 5E, 7.0</td>
</tr>
<tr>
<td>MUSE server</td>
<td>Retrieval of ADT information: 5C.06, 5C.10, 5D.02, 5D.06, 5E</td>
</tr>
<tr>
<td>Aware Gateway</td>
<td>1.1, 1.2, 1.3, 1.4</td>
</tr>
<tr>
<td>Mobile Viewer</td>
<td>L-WEB05-5.0 (V2), L-WEB05-5.1 (V2)</td>
</tr>
</tbody>
</table>
www.gehealthcare.com